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About This Guide

This Novell® GroupWise® 6.5 Installation Guide helps you install a new GroupWise system or 
update an existing GroupWise 5.x/6 system. The guide is intended for network administrators who 
install and administer GroupWise and is divided into the following sections:

“Installation” on page 13

“Update” on page 177

“Appendixes” on page 237

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 6.5 
documentation Web site (http://www.novell.com/documentation/gw65):

Administration Guide

Multi-System Administration Guide 

Interoperability Guide

Troubleshooting Guides

GroupWise Client User Guides

Documentation Updates

For the most recent version of the GroupWise 6.5 Installation Guide, visit the Novell GroupWise 
6.5 Web site (http://www.novell.com/documentation/gw65).

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux*, should use forward slashes as required by your software.

When a startup switch can be written with a forward slash for some platforms or a double hyphen 
for other platforms, the startup switch is presented with a forward slash. Users of platforms that 
require a double hyphen, such as Linux, should use double hyphens as required by your software.
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User Comments

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.
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1 What Is GroupWise?

Novell® GroupWise® is an enterprise collaboration system that provides secure e-mail, 
calendaring, scheduling, and instant messaging. GroupWise also includes task management, 
contact management, document management, and other productivity tools. GroupWise can be 
used on your desktop on Linux*, Windows*, or Macintosh*; in a Web browser anywhere you have 
an Internet connection; and even on wireless devices. Your GroupWise system can be set up on 
NetWare®, Linux, Windows, or any combination of these operating systems.

The following sections include more details about what GroupWise provides and what you need 
to do to set up GroupWise to best meet your needs.

“What GroupWise Provides” on page 15

“What You Need to Do” on page 17

What GroupWise Provides
GroupWise provides communication and collaboration services that are secure, highly available, 
and easily accessible, as explained in the following sections:

“Essential Communication and Collaboration Services” on page 15

“Available Anytime” on page 16

“Accessible Anywhere” on page 16

“Always Secure” on page 16

Essential Communication and Collaboration Services
GroupWise provides a variety of tools to enable users to work together and work smarter.

Messaging: Send and receive mail messages, phone messages, and reminder notes. A mail 
message is for general correspondence. A phone message is designed for those who take 
phone messages for others. A reminder note includes a start date and, when accepted by the 
recipient, is posted to the recipient’s Calendar.

Instant Messaging: Communicate in real time with other GroupWise users through 
GroupWise Messenger. GroupWise Messenger lets you know when other users are online, 
busy, or away from their desks. It also allows you to save conversations.

Scheduling: Schedule both appointments and tasks. When you schedule an appointment, you 
can search other users’ Calendars to find free times for the appointment. When you schedule 
a task, you can assign a priority and due date to the task. If the recipient accepts an 
appointment or task, it is automatically added to his or her Calendar. 

Calendaring: View and manage your appointments, tasks, and reminder notes in a Calendar 
view.
What Is GroupWise? 15
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Task Management: Accept or decline the tasks you are sent, and track accepted tasks 
through to completion. You can also turn any message into a task by adding it to your 
Checklist folder.

Contact Management: Manage information for your contacts, groups, resources, and 
organizations, including being able to view, update, delete, and add information to the 
contacts in your address book. In addition, you can view a history of messages sent to and 
received from individual contacts. 

Document Management: Store documents in GroupWise libraries. In a library, documents 
are compressed to save disk space and encrypted to maintain security. With document 
management, you can check in, check out, share, and version documents.

Available Anytime
GroupWise ensures that your essential communication tools are always available: 

Caching: The GroupWise Windows and Cross-Platform clients include a Caching mode that 
allows you to cache GroupWise information to your local drive and continue to work even 
when you aren’t logged into your network mailbox. 

LDAP Pooling: If you are using LDAP authentication for GroupWise mailbox 
authentication, LDAP pooling ensures that there is always an LDAP server through which 
authentication can be performed.

Clustering: To ensure that GroupWise data is always available and GroupWise components 
are always running, you can install GroupWise into a Novell Cluster ServicesTM environment 
or a Microsoft* Clustering Services environment. 

Accessible Anywhere
GroupWise lets you communicate and collaborate with other people using the device that is most 
convenient:

Personal Computers: To access your mailbox, you can run the GroupWise Windows client 
on any workstation that uses Windows 98 or higher. On Linux and Macintosh workstations, 
you can run the GroupWise Cross-Platform client.

Web Browsers and Wireless Devices: With GroupWise WebAccess installed, you can also 
access your mailbox through a Web browser, a cellular phone, or wireless PDAs (personal 
digital assistants) such as PalmPilot* and Pocket PC*. The GroupWise WebAccess client 
formats information to best accommodate the type of device on which it is being displayed.

Other E-Mail Clients: GroupWise enables you to access your mailbox with any POP3 and 
IMAP4 e-mail clients. 

Always Secure
GroupWise provides extensive security measures to protect your information.

Encryption: To protect your information as it is stored in the various GroupWise databases 
and moved across the network, GroupWise encrypts the information. Each piece of 
information is encrypted differently through the use of randomly-generated encryption keys.

Open Security Standards: To further ensure that your information is secure while moving 
across your internal network or across the Internet, GroupWise supports open security 
standards such as Secure Socket Layer (SSL), Secure Multipurpose Internet Mail Extension 
(S/MIME), Public Key Infrastructure (PKI), and Transport Layer Security (TSL). 
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Spam Protection: To protect you from seeing unwanted messages, the GroupWise Windows 
client includes a Junk Mail Handling feature that lets you control unwanted Internet e-mail 
messages. In addition, you can configure the Internet Agent (the GroupWise component 
responsible for sending and receiving Internet e-mail messages) to reject messages from 
known open relay hosts and spam hosts. GroupWise also works with partner products that 
provide additional anti-spam solutions.

Virus Protection: GroupWise works with partner products to provide solutions that detect 
and eliminate viruses.

For information about additional security solutions available for GroupWise through GroupWise 
partners, see the GroupWise Partners Web site (http://www.novell.com/products/groupwise/
partners).

What You Need to Do
GroupWise includes multiple components that you need to install to realize the full benefits of 
GroupWise. However, some components might not be necessary depending on your needs. The 
following table outlines the components, what they provide, and where to find instructions for 
installing them. 

In addition to the sections referenced in the above table, this Installation Guide includes the 
following two sections:

Chapter 7, “Installing GroupWise Agents,” on page 155

Chapter 8, “Installing the GroupWise Windows and Cross-Platform Clients,” on page 177

The information in these sections is provided as a reference for installing additional GroupWise 
agents and GroupWise clients after you’ve created your basic GroupWise system.

Component What it does Go to

Administration, Agents, 
and Client (Windows or 
Cross-Platform)

Necessary for a basic 
GroupWise system. These 
components are required and 
must be installed before any 
other components.

Chapter 3, “Installing a Basic GroupWise 
System,” on page 23

Internet Agent Provides Internet e-mail 
communication, POP3/IMAP4 
client access, and paging 
services.

Chapter 4, “Installing the GroupWise 
Internet Agent,” on page 77

WebAccess Provides access to mailboxes 
through a Web browser or 
wireless device.

Chapter 5, “Installing GroupWise 
WebAccess,” on page 99

Monitor Provides administrative 
monitoring of the GroupWise 
agents.

Chapter 6, “Installing GroupWise 
Monitor,” on page 135

Messenger Provides instant messaging. Novell GroupWise Messenger 
Installation Guide 
(NovellMessengerInstallationGuide.pdf) 
in the \server\docs\en directory on the 
Novell GroupWise Messenger CD
What Is GroupWise? 17
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2 GroupWise System Requirements

You, as a GroupWise administrator, must ensure that your system meets GroupWise system 
requirements, so that your GroupWise system can be set up successfully. After your GroupWise 
system is set up, you must ensure that users’ workstations meet GroupWise client requirements, 
so that users can run the GroupWise clients successfully.

“GroupWise Administration Requirements” on page 19

“GroupWise Client Requirements” on page 20

GroupWise Administration Requirements
32-bit/x86 processor

Any of the following server operating systems for the GroupWise agents (Post Office Agent, 
Message Transfer Agent, Internet Agent, WebAccess Agent, Monitor Agent):

NetWare® 4.2, NetWare 5.1, or NetWare 6.x, plus the latest Support Pack for your 
version of NetWare
NOTE: Domains and post offices can be located on NetWare 3.12 servers, although the agents 
cannot run there. The Monitor Agent is not available for NetWare.

SUSE® Linux Standard Server 8, SUSE Linux Enterprise Server 8, SUSE Linux 
Enterprise Server 9, Red Hat* Enterprise Linux 3 ES, or Red Hat Enterprise Linux AS

The X Window System is required by the GUI Installation Advisor and Setup Advisor 
that step you through the process of creating a new GroupWise system. A text-based 
Installation Advisor is also available. The X Window System and OpenMotif* are 
required by the GUI GroupWise agent consoles. The agents can also run as daemons 
without user interfaces.

Windows NT* Server, Windows 2000 Server, or Windows 2003 Server, plus the latest 
Service Pack for your version of Windows

NDS® or eDirectoryTM (any version on any platform; however, if you want to use LDAP with 
GroupWise, eDirectory 8.5 or later is required.)

GroupWise 6.5 for Linux includes eDirectory 8.7.3 for Solaris*, Linux, and AIX*. However, 
eDirectory 8.7.3 is not supported on Red Hat Enterprise Linux 3 ES or AS. An eDirectory 
update supporting Red Hat Enterprise Linux 3 ES or AS will be available soon.

ConsoleOne® 

Version 1.3.6 or later for Linux

ConsoleOne on Linux requires Java Virtual Machine (JVM*) 1.4.1 or later, plus the X 
Window System*, version X11R6 or later

Version 1.3.4 or later for Windows
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Adequate server disk space:

Software distribution directory: 500 MB for all GroupWise components

Domain directory: 10 MB (minimum)

Post office directory: 2 MB per user (minimum); 10 MB or more per user (recommended)

MTA/POA installation: approximately 25 MB (varies by platform)

Internet Agent installation: approximately 37 MB (varies by platform)

WebAccess installation: approximately 215 MB (111 MB shared with Monitor; varies by 
platform)

Monitor installation: approximately 140 MB (111 MB shared with WebAccess; varies by 
platform)

Internet connectivity for the Internet Agent

Internet connection over a leased line or a standard telephone line

Internet domain name for your company

DNS server access or relay host access

Any of the following Web servers for WebAccess and Monitor:

NetWare 4.2/5.1 (latest Support Pack required): NetWare Enterprise Web Server

NetWare 6.x: Netscape* Enterprise Web Server; Apache Web Server

NetWare 6.5 (GroupWise 6.5 Support Pack 1 or later required): Apache 2

Linux: Apache 2 

Windows NT (latest Service Pack required): Microsoft Internet Information Server 4.0; 
Netscape Enterprise Server* 3.6 or later

Windows 2000: Microsoft Internet Information Server 5 or later

UNIX* Solaris: Apache Web Server 1.3.3 or later

Any of the following Web browsers for the agent Web consoles:

Linux: Mozilla 1.4 or later and comparable Mozilla-based browsers

Windows: Microsoft Internet Explorer 4.0 or later; Netscape Navigator* 4.0 or later

Macintosh: Safari* 1.0 or later, Microsoft Internet Explorer 4.5 or later; Netscape 
Navigator 4.51 or later

UNIX: Netscape 4.0 or later; Microsoft Internet Explorer 4.0 or later

GroupWise Client Requirements
Any of the following desktop operating systems for the GroupWise Windows client

Windows 98 on a Pentium* 133 or higher with at least 48 MB of RAM

Windows NT on a Pentium 133 or higher with at least 64 MB of RAM

Windows 2000 on a Pentium 200 or higher with at least 128 MB of RAM

Windows XP on a Pentium 300 or higher with at least 128 MB of RAM

Plus 60 MB of free disk space on each user’s workstation to install the Windows client

Any of the following desktop operating systems for the GroupWise Cross-Platform client:
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SUSE Linux Desktop, SUSE Linux 8.2, or SUSE Linux 9 Professional, plus the KDE 
desktop or the GNOME desktop

Red Hat 9 or Red Hat Enterprise 3 WS, plus the GNOME desktop

Macintosh OS 10.3 (Panther)

Plus Java Virtual Machine (JVM) 1.4.2 or later

Plus 40 MB of free disk space on each user’s workstation to install the Cross-Platform 
client

Any of the following Web browsers for the WebAccess client:

Windows: Microsoft Internet Explorer 4.0 or later; Netscape Navigator 4.0 or later

Linux: Mozilla 1.4 or later and comparable Mozilla-based browsers

Macintosh: Safari 1.0 or later, Microsoft Internet Explorer 4.5 or later; Netscape 
Navigator 4.51 or later

UNIX: Netscape 4.0 or later; Microsoft Internet Explorer 4.0 or later

Any of the following wireless devices for the WebAccess client:

Any wireless device that supports the Wireless Access Protocol (WAP) and has a 
microbrowser that uses Handheld Device Markup Language (HDML) 3.0 or above or 
Wireless Markup Language (WML) 1.1 or above

A Palm OS* device with any Palm OS version that supports Web Clipping Applications 
(PQAs)

A Windows CE device with any Windows CE version
GroupWise System Requirements 21
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3 Installing a Basic GroupWise System

Every Novell® GroupWise® system, whether it services five users or 50,000 users, starts as a basic 
GroupWise system. The following sections present the background information and installation 
instructions you need to successfully implement your basic GroupWise system. 

“Basic System Overview” on page 23

“Planning Your Basic GroupWise System” on page 24

“Setting Up a Basic GroupWise System” on page 43

“What’s Next” on page 68

“Basic GroupWise System Worksheet” on page 70
NOTE: If you plan to install GroupWise in a clustered server environment provided by Novell Cluster 
ServicesTM or Microsoft Clustering Services, see the GroupWise 6.5 Interoperability Guide for additional 
information.

Basic System Overview
A basic GroupWise system consists of a single domain with one post office, a document library, 
and one or more users, as shown below.

Each GroupWise user has a mailbox in the post office; users run the GroupWise client (Windows, 
Cross-Platform, or WebAccess) to access their mailboxes and to send and receive mail.

The GroupWise Post Office Agent (POA) delivers messages between users’ mailboxes in a post 
office, and the GroupWise Message Transfer Agent (MTA) routes messages between post offices 
(if there is more than one post office in the domain) and between domains (if there is more than 
one domain in the system). 

After you finish setting up your basic GroupWise system, you can review “What’s Next” on 
page 68 to learn how you can expand your system.

Domain

Post Office 
with Library

Message
Transfer
Agent

Post Office
Agent

GroupWise
Client
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Planning Your Basic GroupWise System
GroupWise includes an Installation Advisor to help you install the GroupWise files to the 
appropriate locations and a Setup Advisor to help you create and configure your GroupWise 
system. Both Advisors provide information to guide you through the process.

If you are comfortable with your knowledge of GroupWise, you can skip this planning section and 
continue with “Setting Up a Basic GroupWise System” on page 43. Otherwise, you should review 
the following sections while filling out the “Basic GroupWise System Worksheet” on page 70. 
The worksheet lists all the information you are prompted for as you run the Advisors.

“Determining Installation Locations” on page 24

“Planning Your Domain” on page 28

“Planning Your Post Office” on page 33

“Planning Your GroupWise Agents” on page 36

To help with the above tasks, you can review “Sample GroupWise Configurations” on page 40. 
The GroupWise 6.5 Best Practices Guide (http://www.novell.com/coolsolutions/gwmag/features/
a_gw65_best_practices_guide_gw.html) can also be of assistance.

Determining Installation Locations
The Installation Advisor prompts you for information about the Novell eDirectory tree where you 
plan to create GroupWise objects and the network server locations where you plan to create 
GroupWise directories and install files. The following sections prepare you to supply the required 
information.

“Novell eDirectory” on page 24

“ConsoleOne” on page 25

“GroupWise Software Distribution Directory” on page 26

“GroupWise Languages” on page 27

Novell eDirectory

GroupWise is administered through eDirectory, the directory service provided by Novell. All 
components, such as domains, post offices, libraries, and agents, as well as all users’ GroupWise 
accounts, are configured through objects in eDirectory. You need to make sure that you have 
eDirectory installed in your environment. eDirectory can be installed on NetWare, Linux, or 
Windows.

GroupWise supports all versions of NDS and eDirectory; however, Novell eDirectory 8.5 and later 
provide some very specific LDAP-related capabilities for GroupWise that are not available if you 
are using earlier versions of eDirectory or NDS:

Users can authenticate to GroupWise through an LDAP directory that does not have the 
LDAP mail attribute (e-mail address) filled in.

When using LDAP authentication, if a user is denied access to GroupWise, a message 
indicates the nature of the problem: account disabled, grace logins expired, directory services 
intruder lockout in effect, and so on.

The GroupWise client can retrieve S/MIME public keys from LDAP directories when users 
receive encrypted messages.
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If you want GroupWise to have these specific LDAP-related capabilities, you must update to 
eDirectory 8.5 or above.

GroupWise 6.5 for Linux includes the Novell eDirectory CD to assist those who do not already 
have eDirectory installed and want to install it on Linux. Follow the instructions in the Novell 
eDirectory Installation Guide (http://www.novell.com/documentation/edir873/index.html) to 
install eDirectory and ConsoleOne before proceeding to install your basic GroupWise system.

Extending the eDirectory Tree’s Schema

The Installation Advisor must extend the schema of the eDirectory tree where you plan to create 
your GroupWise system. Because all objects for a single GroupWise domain must reside in the 
same eDirectory tree, installing a basic system (one domain) requires you to extend one tree only.

Making Sure Users Exist in eDirectory

You must make sure all users who will use GroupWise exist in eDirectory. GroupWise accounts 
can only be assigned to eDirectory User objects and GroupWise External Entity objects.

GroupWise external entities represent non-eDirectory users and are added to eDirectory for the 
sole purpose of assigning GroupWise accounts to these users. GroupWise external entities require 
GroupWise licenses but not eDirectory licenses. You can add GroupWise external entities only 
after you have installed GroupWise. Instructions for adding GroupWise external entities are 
provided in “Assigning GroupWise Accounts to Users” on page 178.

ConsoleOne

GroupWise administration is performed through ConsoleOne, version 1.3.4 or later. When you 
install GroupWise, the GroupWise Administrator snap-in files are copied into an existing 
ConsoleOne installation. The GroupWise Administrator snap-in files extend the functionality of 
ConsoleOne to let you administer GroupWise. ConsoleOne considerations differ by platform:

NetWare and Windows: For a GroupWise system on NetWare or Windows, you need to 
decide which ConsoleOne location you want use to administer GroupWise. This can be a 
ConsoleOne location on a network server, or it can be on a local workstation. If you plan to 
use ConsoleOne on a local workstation, you need to perform the GroupWise installation from 
that workstation. For your convenience, ConsoleOne, version 1.3.4, is included on the 
GroupWise 6.5 Administrator CD. The Installation Advisor lets you install ConsoleOne if 
necessary. You can also use the Installation Advisor at a later time to install ConsoleOne and 
the GroupWise Administrator snap-in files to additional locations.
NOTE: For a GroupWise system on NetWare, you cannot run ConsoleOne to administer GroupWise at 
the NetWare server console. The GroupWise Administrator snap-ins to ConsoleOne do not run in that 
environment.

Linux: For a GroupWise system on Linux, ConsoleOne must already be installed before you 
set up your GroupWise system. GroupWise 6.5 for Linux includes eDirectory 8.7.3 for 
Solaris, Linux, and AIX, from which you can install ConsoleOne. ConsoleOne is installed to 
/usr/ConsoleOne. Make sure that ConsoleOne is installed on the Linux server where you plan 
to create your basic GroupWise system. 

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 1: eDirectory Tree, specify the eDirectory tree where you plan to create the GroupWise 
objects. 
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GroupWise Software Distribution Directory

During installation, you are prompted to create a GroupWise software distribution directory on a 
network server and then copy selected GroupWise software components to the directory. 

You should consider the following when deciding where to create the software distribution 
directory:

“User Access to the Directory” on page 26

“Disk Space Required for the Software” on page 26

User Access to the Directory

User access considerations depend on which GroupWise client users are running:

Windows Client: Users can install the GroupWise Windows client through a TCP/IP or 
mapped connection to the software distribution directory. If you want users to install via a 
mapped connection, you should create the software distribution directory on a server where 
you can provide appropriate user access.

When users install the GroupWise Windows client, they can choose to copy it to a local drive 
or they can run it from the software distribution directory. If you want users to be able to run 
the GroupWise client from the software distribution directory, they must have a permanent 
drive mapping to the directory.

Cross-Platform Client: Users can install the GroupWise Cross-Platform client from the 
GroupWise 6.5 for Linux Cross-Platform Client CD or from the software distribution 
directory, which requires user access to the file system where the software distribution 
directory is located. However, Cross-Platform client users cannot run the client from the 
software distribution directory. They must install it locally.

WebAccess Client: The GroupWise WebAccess client does not require that users install any 
GroupWise software on their workstations. 

Disk Space Required for the Software

The disk space required for the directory depends on which software components you copy to the 
directory. The maximum disk space required to store all the GroupWise software components for 
one language is approximately 500 MB. For a breakdown by component, see “GroupWise System 
Requirements” on page 19.

We recommend that you copy at least the GroupWise client files to the directory. This enables 
users to install the GroupWise client from the distribution directory. Otherwise, you need to mount 
the GroupWise 6.5 Client CD or GroupWise 6.5 for Linux Cross-Platform Client CD as a network 
volume or file system, or distribute the CD to individual users. 

If you are going to update the Windows client using AutoUpdate over an IP connection, you should 
also copy the setupip directory from the GroupWise 6.5 Client CD to the distribution directory. If 
you are going to update the Cross-Platform client using Red CarpetTM, see “Client” in the 
GroupWise 6.5 Administration Guide.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 3: ConsoleOne Path, specify the path for the ConsoleOne location you want to use to 
administer GroupWise. 
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All GroupWise software other than the client is used for administrative purposes only; if disk space 
is an issue and you don’t mind accessing the GroupWise 6.5 Administrator CD or GroupWise 6.5 
for Linux Administrator CD when you need to install one of the software components, you might 
want to leave the administrative software on the CD. 

The Installation Advisor lets you create one software distribution directory. After you’ve set up 
your basic GroupWise system, you can create additional software distribution directories if 
needed. 

For example, if not all users can access a single software distribution directory to run the 
GroupWise Windows client Setup program, you can create an additional software distribution 
directory on a server they can access. For information about creating additional software 
distribution directories, see “Software Directory Management” in “System” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

GroupWise Languages

The GroupWise 6.5 CDs contain multiple languages, so you need to decide which languages you 
want to install. Your choice affects the following programs:

GroupWise Administrator snap-ins for ConsoleOne

GroupWise agents

GroupWise client (Windows, Cross-Platform, or WebAccess)

For example, if you install English-US and German, you can run GroupWise Administrator and 
the agents in either language. By default, GroupWise Administrator runs in the language in which 
you are running ConsoleOne. Your users then have the choice of using either the English-US client 
or the German client.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 6.5 
Administration Guide.

Planning Your Domain
The domain functions as the main administration unit for the GroupWise system. When you 
configure GroupWise information in eDirectory, it is also stored in the GroupWise domain 
database. From the domain database, the GroupWise agents distribute the information to each post 
office database. Users then get the information, such as user addresses, from the post office 
database.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 4: Software Distribution Directory, specify the path for the software distribution directory.

Under Item 5: Software Selection, select the software components you want copied to the software 
distribution directory.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 2: Languages to Install, specify the languages you want to install. The GroupWise 
Administrator languages are copied to the ConsoleOne location. The GroupWise agent and client 
languages are copied to the software distribution directory.
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In a multiple-post-office system, the domain also organizes post offices into a logical grouping for 
addressing and routing purposes, and enables you to scale your GroupWise system to meet your 
current and future needs.

As you create your basic GroupWise system, the Setup Advisor prompts you for information about 
the domain. The following sections prepare you to supply the required information.

“System and Domain Names” on page 28

“Domain Directory” on page 29

“Domain Context” on page 29

“Domain Language” on page 32

“Domain Time Zone” on page 32

System and Domain Names

The domain requires a unique name. The name is used as the Domain object’s name in eDirectory. 
It is also used for addressing and routing purposes within GroupWise, and can appear in the 
GroupWise Address Book. The domain name can reflect a location, company name or branch 
name, or some other element that makes sense for your organization. For example, you might want 
the domain name to be the location (such as Provo) while the post office name is one of the 
company’s departments (such as Research). Name your domain carefully. After it is created, the 
name cannot be changed.

You must also provide a name for your GroupWise system. The system name is used when 
connecting to other GroupWise systems; for this reason, it must be different than any other 
GroupWise system with which you might want to connect. The system name can be your company 
name (for example, Novell), GroupWise, or anything else that fits the naming scheme you want to 
use. The system name is displayed only in ConsoleOne. You cannot change the name after your 
system is created.

System and domain names can consist of one or more words. Use underscores (_) rather than 
spaces as separators between words to facilitate addressing across the Internet. Do not use any of 
the characters listed below in system and domain names: 

ASCII characters 0-13 Comma ,

Asterisk * Double quote "

At sign @ Extended characters

Braces { } Period .

Colon : Parentheses ( )

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 6: System Name, specify the system name.

Under Item 7: Domain Name, specify the domain name.
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Domain Directory

The domain requires a directory structure in which to store database files and temporary files that 
are created during message routing. As you choose a location for the domain directory, consider 
the following: 

Security: GroupWise users never need access to the domain directory, so you should create 
it in a location that you can easily secure.

Server Platform and Version: The domain directory can be located on the following 
platforms:

NetWare 3.12, 4.2, 5.x, or 6.x

SUSE® Standard Server 8 or Enterprise Server 8

Red Hat Enterprise Linux 3 ES or AS

Windows NT Server or Windows 2000 Server

MTA Access: The MTA requires access to the domain directory. Therefore, you might want 
to consider the server type (NetWare, Linux, or Windows) and location of the MTA before 
deciding on a domain directory. For information about the MTA, see “Planning Your 
GroupWise Agents” on page 36. For examples of possible domain directory locations and 
MTA configurations, see “Sample GroupWise Configurations” on page 40. 

Disk Space Requirements: The domain directory requires approximately 10 MB of free disk 
space. This requirement could increase to around 30 MB as your GroupWise system grows.

Directory Name: You should specify an empty directory for the domain. If you want, the 
directory can reflect the domain name you chose. Use the following platform-specific 
conventions:

On NetWare, use a maximum of 8 characters in the directory name.

On Linux, use only lowercase characters in the directory name.

Choose the name and path carefully. After the directory is created, it is difficult to rename. If the 
directory you specify does not exist, it is created during installation.

Domain Context

You can create the Domain object in any context in your eDirectory tree. The only requirement is 
that it be in the same tree as the other objects associated with the domain (Post Office object, User 
objects, and so forth).

The following sections provide examples of where you might place your Domain object. Because 
it is helpful to discuss the Domain object’s context in relationship to the Post Office object’s 
context, the examples also include context information for the Post Office object.

“Objects in the Same Container as Users' Organizational Units” on page 30

“Objects Mirror eDirectory Organization” on page 30

“Objects Mirror Network Server Organization” on page 31

“Objects in a Dedicated Container” on page 31

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 8: Domain Directory, specify the full path for the domain directory.
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Objects in the Same Container as Users' Organizational Units

In the following example, the Domain object (Provo) and Post Office object (Research) reside in 
the same container (Provo) as the organizational units (Accounting, Manufacturing, R&D, and 
Sales) that contain the users. This allows you to associate the domain with a single organization 
and associate one post office with all users within the organization.

Objects Mirror eDirectory Organization

The following example is similar to the previous example, except that a separate post office is 
created for each organizational unit that contains users. The Domain object (Provo) resides in the 
organization (Provo) and the Post Office objects reside in the same organizational units 
(Accounting, Manufacturing, R&D, and Sales) as the users.

As in the previous example, this organizational structure allows you to quickly associate users with 
their post offices. In addition, if you have thousands of users split between the different 
organizational units, this method allows you to create multiple post offices with a smaller number 
of users on each post office.

Objects Mirror Network Server Organization

Because the domain and post office have directory structures on network servers, you could also 
choose to place the Domain and Post Office objects in the same context as the servers where the 
directories will reside, as shown in the following example.
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Objects in a Dedicated Container

If, rather than mirroring your eDirectory or server organization, you would prefer to keep all your 
GroupWise objects together, you could create a container, such as GroupWise, and place all 
GroupWise objects in that container, as shown below. Administratively, this type of organizational 
structure makes it easier to restrict a GroupWise administrator’s object and property rights to 
GroupWise objects only. For information about GroupWise administrator rights, see “GroupWise 
Administrator Rights” in “Security” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 9: Domain Context, specify the context where you want to create the Domain object. If the 
context does not already exist in your eDirectory tree, create the context now.
Installing a Basic GroupWise System 31

http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65


    Novell Confidential                                                                                            Manual (99a)  21 December 2004
The GroupWise View in ConsoleOne

ConsoleOne includes a GroupWise View, shown below.

The GroupWise View filters out all non-GroupWise objects and shows how GroupWise objects 
relate to each other. For example, in the left pane, notice the Post Office object (Research) is 
subordinate to the Domain object (Provo). You can select an object in the left pane and display its 
associated objects (User, Resource, and so forth) in the right pane.

The GroupWise View is particularly useful if your GroupWise objects are placed in different 
contexts in the eDirectory tree. Rather than searching for GroupWise objects throughout the tree, 
you can administer the objects from the GroupWise View.

Some GroupWise administrative functions can only be done while in the GroupWise View. This 
includes such tasks as defining users from other GroupWise systems so that they appear in your 
system's Address Book.

Domain Language

The domain language determines how times, dates, and numbers are displayed in the GroupWise 
clients and affects the sorting order for items in the GroupWise Address Book. 

For more information, see “Multilingual GroupWise Systems” in the GroupWise 6.5 
Administration Guide.

Domain Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise 
adjusts the message's time so that it is correct for the recipient's time zone. For example, if a user 
in New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific 
Time) for a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los 
Angeles user’s calendar at 1:00 p.m. Pacific Time.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 10: Domain Language, specify the language for the domain. The domain language 
becomes the default language for the domain’s post offices. 

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 11: Domain Time Zone, specify the time zone for the domain. The domain time zone 
becomes the default time zone for the domain’s post offices. 
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Planning Your Post Office
The post office contains users’ mailboxes. Like a domain, a post office requires a name, has a 
directory structure and an eDirectory object, and can be configured to support different languages 
and time zones. The following sections prepare you to supply the Setup Advisor with the required 
information.

“Post Office Name” on page 33

“Post Office Directory” on page 33

“Post Office Context” on page 34

“Post Office Language” on page 35

“Post Office Time Zone” on page 35

“Post Office Users” on page 35

Post Office Name

The post office, like the domain, requires a unique name. The name is used as the Post Office 
object’s name in eDirectory. It is also used for addressing and routing purposes within GroupWise, 
and can appear in the GroupWise Address Book. The post office name can reflect any element that 
makes sense for your organization. For example, you might want the domain name to be the 
location (such as Provo) while the post office name is one of the company’s departments (such as 
Research). Name your post office carefully. After it is created, the name cannot be changed.

Post office names must be one word. The same characters that are invalid in system and domain 
names are also invalid in post office names (see “System and Domain Names” on page 28). 

Post Office Directory

The post office requires a directory structure in which to store database files and temporary files 
that are created during message routing. As you choose a location for the post office directory, 
consider the following:

Security: The GroupWise Windows and Cross-Platform clients access the post office through 
a client/server (TCP/IP) connection to the GroupWise Post Office Agent (POA). The 
GroupWise WebAccess client uses an HTTP connection. Therefore, GroupWise users never 
need access to the post office directory, so you should create the directory in a location that 
you can easily secure.

Server Platform and Version: The post office directory can be located on the following 
platforms:

NetWare 3.12, 4.2, 5.x, or 6.x

However, the GroupWise agents cannot run on NetWare 3.12. They require NetWare 4.2 
or higher.

SUSE Standard Server 8 or Enterprise Server 8

Red Hat Enterprise Linux 3 ES or AS

Windows NT Server or Windows 2000 Server

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 12: Post Office Name, specify the name you’ve selected.
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POA Access: The POA requires access to the post office directory. Therefore, you might 
want to consider the server type (NetWare, Linux, or Windows) and location of the POA 
before deciding on a post office directory. For information about the POA, see “Planning 
Your GroupWise Agents” on page 36. For examples of possible post office directory 
locations and POA configurations, see “Sample GroupWise Configurations” on page 40. 

Disk Space Requirements: The post office directory holds users’ messages and attachments, 
so you should plan a minimum of 2 MB per user. 10 MB or more per user is recommended. 
Although actual messages are relatively small, message attachments (documents, 
spreadsheets, graphic files, and so forth) can greatly increase the amount of disk space used.

Using ConsoleOne, you can restrict the amount of disk space users are allowed for their 
mailboxes. When you know the number of users and the amount of disk space allocated to 
each user, you can more accurately determine the amount of disk space required.

You can reduce the amount of disk space required for the post office by forcing users to run 
the GroupWise Windows and Cross-Platform clients in Caching mode rather than Online 
mode. In Online mode, messages are stored in the post office. In Caching mode, messages are 
stored on users’ local drives.

In addition to users’ messages and attachments, the post office directory also contains a 
document library. You should take into account the disk space you want to provide for storing 
documents. 

Directory Names: You should specify an empty directory for the post office. If you want, the 
directory can reflect the post office name you chose. Use the following platform-specific 
conventions:

On NetWare, use a maximum of 8 characters in the directory name.

On Linux, use only lowercase characters in the directory name.

Choose the name and path carefully. After the directory is created, it is difficult to rename. If the 
directory you specify does not exist, it is created during installation.

Post Office Context

Like the Domain object, you can create the Post Office object in any context in your eDirectory 
tree. The only requirement is that it be in the same tree as the Domain object and other objects 
associated with the domain (User objects and so forth). For configuration examples, see “Domain 
Context” on page 29.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 13: Post Office Directory, specify the full path for the post office directory.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 14: Post Office Context, specify the context where you want to create the Post Office 
object. If the context does not already exist in your eDirectory tree, create the context now.
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Post Office Language

The post office language determines how times, dates, and numbers are displayed in the 
GroupWise clients and affects the sorting order for items in the GroupWise Address Book. 

The post office assumes the same language as its domain unless you specify otherwise. For 
example, if you set the domain and post office language to English-US, all time, date, and numbers 
are formatted according to English-US standards, and the Address Book items are sorted according 
to English-US sort order rules. This is true even if some users on the post office are running non-
English GroupWise clients such as German or Japanese. Their client interface and Help files are 
in German or Japanese, but the time, date, and number formats and sort order are according to 
English-US standards.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 6.5 
Administration Guide.

Post Office Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise 
adjusts the message’s time so that it is correct for the recipient’s time zone. For example, if a user 
in New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific 
Time) for a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los 
Angeles user's calendar at 1:00 p.m. Pacific Time.

The post office assumes the same time zone as its domain unless you specify otherwise.

Post Office Users

You need to assign a GroupWise account to each eDirectory user who should have a mailbox in 
the post office. You can do this while creating your system, or you can do it afterwards. However, 
we recommend that you at least add yourself so you can test the system. 

If you are adding non-eDirectory users as GroupWise external entities, you must wait to add them 
to the post office until after you have finished the installation. Instructions for adding GroupWise 
external entities are provided in “Assigning GroupWise Accounts to Users” on page 178.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 15: Post Office Language, specify the language for the post office. 

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 16: Post Office Time Zone, specify the time zone where the post office is located.

BASIC GROUPWISE SYSTEM WORKSHEET

If desired, specify the context for each user under Item 20: Post Office Users. 

The Setup Advisor lets you select users from the eDirectory tree to add to the post office. You do not 
need to list all of the users at this time.
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Planning Your GroupWise Agents
The Message Transfer Agent (MTA) and Post Office Agent (POA) route messages through the 
GroupWise system. The MTA handles all message traffic between the domain and post office, 
while the POA handles all message traffic within the post office.

MTA: GroupWise requires one MTA per domain, which means that you need to install and run 
one MTA for your basic GroupWise system.

In addition to routing user messages between post offices and between domains, the MTA routes 
administration messages from the domain to the post office. For example, when a user is given a 
GroupWise account in eDirectory, the user is added to the GroupWise domain database. At the 
same time, the MTA routes an administration message from the domain to the post office so that 
the POA can add the user to the post office database. After the user is added to the post office 
database, the post office’s users can see the newly added user’s information in the GroupWise 
Address Book 

POA: GroupWise requires one POA per post office, which means that you need to install and run 
one POA for your basic GroupWise system.

The POA routes messages within the post office, updates the post office database when it receives 
administration messages from the MTA, and performs other maintenance tasks in the post office.

The following sections prepare you to supply the information required when installing the MTA 
and POA:

“Agent Platform” on page 36

“Agent Location” on page 36

“MTA Link to the Post Office” on page 38

“Windows Application vs. Windows Service (Windows Agents Only)” on page 38

“Web Console” on page 39

“Agent Language” on page 39

Agent Platform

The MTA and POA are available as NetWare NLMTM programs, Linux executables, and Windows 
executables.

In general, GroupWise is most efficient if you match the agent platform with the network operating 
system where the post office and domain are located. For example, if a domain and post office are 
located on a NetWare server, then you would install the NetWare agents for them. However, this 
is not required. For configuration examples, see “Sample GroupWise Configurations” on page 40.

Agent Location

The MTA requires direct access to the domain directory. The POA requires direct access to the 
post office directory.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 21: Agent Platform, specify the type of agents (NetWare, Linux, or Windows) you want to 
use.
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In general, we recommend that you install an agent on the same server as its directory. For 
example, you would install the MTA on the same server as the domain directory and the POA on 
the same server as the post office directory. This ensures that the agent always has access to its 
directory.

However, if necessary, you can install the agent on a different server from its directory. This 
requires the agent to have a direct link (mapped drive, UNC path, or file system mount) to its 
directory in order to function. The following diagram illustrates the direct links:

For the purpose of simplifying the setup of your basic system, you are required to install both the 
MTA and the POA to the same server. If, at a later time, you decide that you want to run one of 
the agents on a different server, see “Installing GroupWise Agents” on page 155.

Consider these platform-specific guidelines:

NetWare: When installing the NetWare agents, we recommend you use the sys:\system 
directory on the NetWare server. This simplifies the use of startup files and ensures that the 
agent NLM programs are in the server’s search path. If you use a different directory, you must 
add that directory to the server’s search path.

Linux: The Linux agents are automatically installed to the bin and lib subdirectories under /
opt/novell/groupwise/agents. On Linux, do not move the agent software to a different 
location.

Windows: The default installation directory is c:\grpwise. However, you can install the 
agents to any directory you want.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 22: Agent Installation Path, specify the installation path for the agents.
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Installing a Basic GroupWise System 37



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
MTA Link to the Post Office

To route user and administration messages to the post office, the MTA requires direct access or a 
direct link to the post office directory, or a TCP/IP connection with the post office’s POA. The 
following diagram illustrates the alternatives:

In general, we recommend that you use a TCP/IP connection between the MTA and the POA. 

Windows Application vs. Windows Service (Windows Agents Only)

You can run the Windows MTA and POA as normal applications or as services. When you run the 
agents as Windows services, they must run under a specific user account. The user account you 
use depends on where the domain and post office directories are located: 

When the domain and post office directories are located on the same server where you are 
installing the agents, the agents can run under the local system account. You can also display 
the agent console when the agent software, directories, and databases are local. 

When the domain and post office directories are located on a remote server, you must specify 
a user with rights to access the domain and post office directories. If the agents need to log in 
to a Windows server, provide a Windows username and password. If the agents need to log in 
to a NetWare server, provide an existing eDirectory username and password, or create a new 
account for the agents, as described in “Creating a NetWare Account for Agent Access 
(Optional)” on page 163.

As with all Windows services, you can start the agents manually or have them start automatically 
each time the Windows server restarts.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 17: Post Office Link, select whether the MTA will connect to the post office through a TCP/
IP link to the POA or a direct link to the post office directory.

Under Item 18: POA Network Address, specify the IP address or DNS hostname of the POA’s server. 
The GroupWise Windows and Cross-Platform clients, which access the POA through TCP/IP, need to 
know the address. If the MTA will have a TCP/IP connection to the POA, it will also use this address. 

If you plan to have the MTA use a TCP/IP connection to the POA, under Item 19: MTA Network 
Address, specify the IP address or DNS hostname of the MTA’s server.
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Web Console

The MTA and POA provide server consoles to let you monitor and configure the agents while at 
the agents’ servers. On NetWare, the MTA and POA consoles are always displayed. On Linux, 
they are displayed only if you start the agents with the --show switch on the command line. On 
Windows, they are displayed if you run the agents as applications but are not displayed if you run 
the agents as services.

When the MTA and POA consoles are not available, you can monitor and configure the agents 
through a Web browser. This feature, referred to as the agent Web console, lets you access the 
agents’ statistics and diagnostic information from any location where you are connected to the 
Internet and have access to a Web browser, either at a workstation or on a wireless device.

By default, the MTA Web console is enabled on port 7180 and the POA Web console is enabled 
on port 7181. In your browser, you access the agent Web consoles using the following URLs:

http://MTA_network_address:port
http://POA_network_address:port

where MTA_network_address and POA_network_address are the agents’ IP addresses or host 
names and port is the agent’s assigned HTTP port number.

Agent Language

If you have users with various language preferences, you can install the GroupWise agents in 
multiple languages. The language determines the agents’ interface language only. It does not affect 
messages processed by the agents.

By default, the agents start in the language selected for the domain. If that language has not been 
installed, the agents start in the language used by the operating system. If that language has not 
been installed, the agents start in English.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 6.5 
Administration Guide.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 24: Windows Agent Installation Options, select Install as Windows Services if you want to 
run the agents as Windows services.

If you want to run the agents as Windows services, under Item 25: Windows Services Information, 
record the account the agents will run under, and if necessary, the password for the account. Also 
select whether you want the service to start automatically or manually.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 18: POA Network Address, specify the POA’s HTTP port. The default port, 7181, should 
be used unless there is a port conflict.

Under Item 19: MTA Network Address, specify the MTA’s HTTP port. The default port, 7180, should 
be used unless there is a port conflict.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 23: Agent Language, list the languages you want to install for the agents.
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Sample GroupWise Configurations
Many different configurations are possible for your GroupWise system. The following diagrams 
illustrate some of the ways a basic GroupWise system (one domain and one post office) can be set 
up.

“NetWare 6.x Server” on page 40

“Linux Server” on page 40

“Windows 2000 Server” on page 41

“NetWare Server and Windows NT Server” on page 41

NetWare 6.x Server

The following diagram shows a basic GroupWise system set up on a single NetWare 6.x server.

Linux Server

The following diagram shows all GroupWise components on a Linux server.
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Windows 2000 Server

The following diagram shows all GroupWise components on a Windows 2000 server.

NetWare Server and Windows NT Server

The following diagram shows the domain, post office, and software distribution directory on a 
NetWare 5.1 server. The MTA and POA, located on a Windows NT server, use a UNC path to 
access the domain directory and post office directory on the NetWare 5.1 server.
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The following diagram shows the domain and MTA on a NetWare 6 server. The post office, 
software distribution directory, and POA are on a Windows NT server. The MTA communicates 
with the POA through TCP/IP.

NOTE: The above configuration has the MTA on one server and the POA on another. Because the basic 
GroupWise system setup requires you to install the MTA and POA on the same server, you would have to do 
additional setup to create a similar configuration.

Setting Up a Basic GroupWise System
Follow the setup instructions for the platform where you are creating your basic GroupWise 
system:

“Setting Up a Basic GroupWise System on NetWare or Windows” on page 43

“Setting Up a Basic GroupWise System on Linux” on page 59

Setting Up a Basic GroupWise System on NetWare or Windows
You should have already reviewed “Planning Your Basic GroupWise System” on page 24 and 
filled out the worksheet. 

The following sections step you through the GroupWise Installation Advisor and GroupWise 
Setup Advisor. The Installation Advisor installs the GroupWise software. It then launches the 
Setup Advisor to create your domain and post office, set up the GroupWise agents, and set up the 
GroupWise Windows client (if desired) on your local machine.

“Starting the GroupWise Installation Advisor on Windows” on page 44

“Installing the GroupWise Software” on page 46

“Providing System Information” on page 47

“Creating Your Basic GroupWise System” on page 48

“Installing and Starting the GroupWise Agents on NetWare or Windows” on page 49

“Setting Up and Running the GroupWise Windows Client on Your Local Machine” on 
page 58

“Installing the GroupWise Administrator Snap-Ins to Additional Windows Locations” on 
page 59
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Starting the GroupWise Installation Advisor on Windows

To start the GroupWise Installation Advisor:

1 At a Windows 98/NT/2000 workstation that has the Novell ClientTM installed, log in as an 
Admin equivalent to the eDirectory tree in which you are installing GroupWise.

The GroupWise Setup Advisor, which is launched by the Installation Advisor, requires the 
Novell Client in order to create GroupWise objects in eDirectory. If necessary, you can 
download the Novell Client from the Novell Product Downloads site (http://
download.novell.com).

2 Run setup.exe at the root of the GroupWise 6.5 Administrator CD to display the GroupWise 
Installation main page. 

3 Click Create or Update a GroupWise System, then click Yes to accept the license agreement 
and display the Welcome to GroupWise Install page.

4 Click Next until you reach the Administration Options page.
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5 Make sure that Create a New System or Update an Existing System is selected, then click Next 
to display the Select Tree page.

6 Continue with Installing the GroupWise Software.

Installing the GroupWise Software

The Installation Advisor extends the eDirectory schema for the selected tree and then installs 
GroupWise software to the ConsoleOne location and software distribution directory.

To extend the schema and install the software:

1 In the Select Tree page, select the tree whose schema you want to extend (worksheet item 1), 
click Next, then enter the information from your worksheet (item 2 through item 5) until you 
reach the Ready to Install page.
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2 Click Install, then follow the prompts until you reach the Determine Next Step page.

3 Click Creating a New GroupWise System, then click Next to display the Run ConsoleOne 
page.

4 Continue with Providing System Information.
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Providing System Information

The Installation Advisor launches ConsoleOne with the GroupWise Setup Advisor active. Use 
your worksheet to provide the Setup Advisor with the information it needs to create your 
GroupWise system.

1 On the Run ConsoleOne page, click Run to start ConsoleOne and the GroupWise Setup 
Advisor. The GroupWise Setup Progress: Collect System Information page is displayed.

2 Click Next, then enter the information from your worksheet (item 6 through item 20) until you 
reach the GroupWise Setup Progress: Create System page.

3 Click Next to display a summary of the information you entered.
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4 Continue with the Creating Your Basic GroupWise System.

Creating Your Basic GroupWise System

After you have verified that the information you entered is correct, you are ready for the Setup 
Advisor to create your system.

1 On the Summary page, click Next.

The Setup Advisor creates the GroupWise system using the information you provided, then 
displays the following page:

2 Click Next to display the GroupWise Setup Progress: Install Agent Software page.
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3 Continue with Installing and Starting the GroupWise Agents on NetWare or Windows.

Installing and Starting the GroupWise Agents on NetWare or Windows

At this point, the Setup Advisor has created eDirectory objects and network server directories for 
your GroupWise system. You now need to install and start the MTA and POA on your NetWare 
or Windows server.

1 On the GroupWise Setup Progress: Install Agent Software page, click Next to have the Setup 
Advisor launch the Agent Installation program and display the Select Platform page.

2 If you are installing the NetWare agents (worksheet item 21), continue with Installing and 
Starting the NetWare Agents.

or

If you are installing the Windows agents (worksheet item 21), skip to “Installing and Starting 
the Windows Agents” on page 53.

Installing and Starting the NetWare Agents

1 On the Select Platform page, select NetWare as the platform, then click Next to display the 
Installation Path page.
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2 Select the directory where you want to install the agents (worksheet item 22), then click Next 
to display the Language page. 

3 Select the languages you want to install (worksheet item 23), then click Next to display the 
Summary page.

4 Click Install to install the agents.
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The Installation Complete page appears when the files have been installed.

5 Select from the following options:

Update AUTOEXEC File: Select this option to reference the grpwise.ncf file from the 
server’s autoexec.ncf file so that the GroupWise agents are automatically loaded whenever the 
server is started.

Launch GroupWise Agents Now: Select this option to have the Installation Advisor start the 
GroupWise agents for you immediately. You should only do this if the MTA and POA are on 
the same server as the domain and post office directories. If you want the agents to run in 
protected mode, select Launch in Protected Mode.

6 Click Finish to return to the Setup Advisor. The GroupWise Setup Progress: Set Up Client 
Software page is displayed. 

7 If you have already started the GroupWise agents (because they are on the same server as the 
domain and post office directories), skip to “Setting Up and Running the GroupWise 
Windows Client on Your Local Machine” on page 58.

or

Continue with Step 8 below to configure the agents to access the server where their directories 
have been created.

8 Use a text editor to modify the agents’ startup files.
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The load command in the grpwise.ncf file includes a startup switch that points the agents to 
their startup files. The startup files include configuration information the agents need to 
function properly. When the MTA is not on the same server as the domain directory and post 
office directory, you need to edit the MTA startup file to include the MTA’s eDirectory 
distinguished name. When the POA is not on the same server as the post office, you need to 
edit the POA startup file to include the POA’s eDirectory distinguished name.

The startup files are located in the agent installation directory you specified in Step 2. The 
MTA startup file is named domain.mta, where domain is the first 8 letters of the domain name 
(for example, provo.mta). The POA startup file is named post_office.poa, where post_office 
is the first 8 letters of the post office name (for example, research.poa).

The /dn-distinguished_object_name startup switch is located in Section 1 of the startup file. 
Delete the semicolon (;) at the beginning of the line and replace the 
distinguished_object_name variable with the distinguished name of the MTA or POA. For 
example, if the MTA is for a domain named Provo that is located in a container named Novell, 
you would enter:

/dn-mta.provo.novell

9 At the server's console, enter grpwise.ncf to start the agents.

10 Now that you have the NetWare agents installed and running, skip to “Setting Up and 
Running the GroupWise Windows Client on Your Local Machine” on page 58.

Installing and Starting the Windows Agents

To install the Windows agents, you must run the Agent Installation program at the Windows server 
where you are installing the agents.

1 If you are already running the Agent Installation program at the Windows server where you 
are installing the agents, skip to Step 6.

or

Click Exit to close the Agent Installation program that was launched automatically by the 
Setup Advisor, go to the Windows server where you want to install the agents, then continue 
with Step 2 below.

2 Make sure you are logged in as an Admin equivalent and have network access to the software 
distribution directory (or GroupWise 6.5 Administrator CD), domain directory, and post 
office directory.

3 Start the Agent Installation program (install.exe in the agents subdirectory), then click Yes to 
accept the license agreement and display the Overview page.
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4 Click Next to display the Install/Uninstall page

5 Click Install, then click Next to display the Select Platform page.

6 Click Windows, then click Next to display the Installation Path page.
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7 Enter the path to the directory where you want the agents installed (worksheet item 22), select 
the installation options you want (worksheet item 24), then click Next to display the Language 
page.

8 Select the languages you want to install (worksheet item 23), then click Next.

If you are not running the Agent Installation program on the same server as the GroupWise 
Setup Advisor, the Domains/Post Offices page is displayed. Continue with Step 9.

If you are running the Agent Installation program on the same server as the GroupWise Setup 
Advisor, the Setup Advisor passes the domain and post office information to the Agent 
Installation program so you are not prompted for it again. Skip to Step 13.
Installing a Basic GroupWise System 53



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
The MTA and POA must know the location of the domain and post office directories.

9 To specify the location of your domain, click Add, select Domain, specify the domain name, 
specify the path to the domain directory, then click OK.

The location you specify for the domain directory is stored in the MTA startup file. When you 
start the MTA, it reads the startup file to find the location of the domain directory. The MTA 
then reads the domain database (wpdomain.db) in the domain directory for all configuration 
information it needs to run.

The MTA startup file is located in the agent installation directory you specified in Step 7. The 
startup file is named domain.mta, where domain is the first 8 letters of the domain name (for 
example, provo.mta).

10 To specify the location of your post office, click Add, select Post Office, specify the post 
office name, specify the path to the post office directory, then click OK. 

The location you specify for the post office directory is stored in the POA startup file. When 
you start the POA, it reads the startup file to find the location of the post office directory. The 
POA then reads the post office database (wphost.db file) in the post office directory for all 
configuration information it needs to run. 

The POA startup file is located in the agent installation directory you specified in Step 7. The 
startup file is named post_office.poa, where post_office is the first 8 letters of the post office 
name (for example, research.poa).

11 Click Next. 

12 If you are installing the agents as Window services, the Windows Service Information page 
is displayed. Fill in the service information (worksheet item 25), then click Next to display the 
Summary page.

or

If you are not installing the agents as services, the Summary page is displayed.
54   GroupWise 6.5 Installation Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
13 Click Install to install the agents.

The Installation Complete page appears when the files have been installed.

14 Select from the following options:

Update the AUTOEXEC File: This option does not apply to the Windows agents, so it is 
dimmed.

Launch GroupWise Agents Now: This option applies only if you installed the agents as 
Windows applications, rather than services. Select this option to start the GroupWise agents 
as applications.

15 Click Finish, then return to the workstation where the Setup Advisor is running (if necessary). 
The GroupWise Setup Progress: Set Up Client Software page is displayed.
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16 Now that you have the Windows agents installed and running, continue with Setting Up and 
Running the GroupWise Windows Client on Your Local Machine.

Setting Up and Running the GroupWise Windows Client on Your Local Machine

To set up the GroupWise Windows client on your local machine:

1 In the Setup Advisor, click Next to launch the GroupWise Windows client Setup program, 
then follow the prompts. 

2 When setup is finished, double-click the GroupWise shortcut on your desktop to start the 
GroupWise Windows client.

Because the GroupWise client can get the location of your post office from eDirectory, and 
because you do not yet have a password on your mailbox, the GroupWise client starts without 
prompting you for post office and password information.

If the GroupWise client cannot get the location of your post office from eDirectory or cannot 
access the post office, the GroupWise Startup page appears. You should make sure you are 
logged in through your own eDirectory user account and not through an Admin account, and 
your current eDirectory tree is the tree in which the post office is located. By default, the 
GroupWise client logs in to GroupWise as the user who is logged in at the workstation. If you 
are not logged in as yourself, you might receive a “user not found” error; specify your 
GroupWise user ID in the User ID field and click OK to log in.

3 Get started with the GroupWise client by completing the following tasks:

Setting A Mailbox Password: After you are logged in and using GroupWise, one of the 
first things you should do is set a password on your mailbox so that other users can't 
access it. For information about setting a password, see Help in the GroupWise client.

Sending Messages and Scheduling Appointments: You can send messages to or 
schedule appointments with any users you have added to the post office. To test your 
system, you might want to send a message to yourself. As soon as users set up the 
GroupWise clients on their workstations, as described in “Setting Up the GroupWise 
Windows Client” on page 179, they will also be able to send messages and schedule 
appointments.

Using Document Management Services (Optional): GroupWise Document 
Management Services (DMS) lets you store documents in GroupWise libraries. Library 
documents can be shared with other users, versioned, and searched for within the library. 
The Setup Advisor created a library under the post office directory. For information about 
using Document Management Services, see Help in the GroupWise client.
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4 Continue with Installing the GroupWise Administrator Snap-Ins to Additional Windows 
Locations.

or

If you have installed all the administrative software you need, skip to “What’s Next” on 
page 68

Installing the GroupWise Administrator Snap-Ins to Additional Windows Locations

As part of creating your basic GroupWise system, the GroupWise Administrator snap-ins to 
ConsoleOne were installed in one location (worksheet item 3). If ConsoleOne is installed in 
multiple locations and if you want to be able to administer GroupWise from those locations, you 
need to install the GroupWise snap-ins to each ConsoleOne installation.

1 Go to the Windows workstation or server where you want to install the GroupWise snap-ins 
to ConsoleOne.

2 Make sure you are logged in as an Admin equivalent and have network access to the software 
distribution directory (or GroupWise 6.5 Administrator CD) and the domain directory.

3 Start the Installation Advisor (setup.exe), then click Install Products > GroupWise 
Administration > Install GroupWise Administration.

4 Accept the License Agreement, then provide the information requested by the Installation 
Advisor just as you did the first time you installed the GroupWise snap-ins.

5 Repeat Step 1 through Step 4 for each location where you want to install the GroupWise snap-
ins.

6 Skip to “What’s Next” on page 68.

Setting Up a Basic GroupWise System on Linux
You should have already reviewed “Planning Your Basic GroupWise System” on page 24 and 
filled out the worksheet. 

The following sections step you through the GroupWise Installation Advisor and GroupWise 
Setup Advisor on Linux. The Installation Advisor installs the GroupWise software on your Linux 
server. It then launches the Setup Advisor in ConsoleOne to create your domain and post office 
and set up the GroupWise agents.

“Starting the GroupWise Installation Advisor on Linux” on page 60

“Installing the GroupWise Software” on page 61

“Selecting a Linux Mount Directory” on page 62

“Using ConsoleOne to Create Your Basic GroupWise System” on page 63

“Installing and Starting the GroupWise Linux Agents” on page 64

“Setting Up and Running the GroupWise Cross-Platform Client on Your Local Machine” on 
page 67

“Installing the GroupWise Administrator Snap-Ins to Additional Linux Locations” on 
page 67

If you are new to Linux, you might want to review “Useful Linux Commands for Administering a 
GroupWise System” in GroupWise 6.5 Troubleshooting 2: Solutions to Common Problems before 
beginning to set up your GroupWise system on Linux.
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Starting the GroupWise Installation Advisor on Linux

1 Make sure that ConsoleOne is installed on your Linux server.

ConsoleOne is installed in /usr/ConsoleOne/bin. If ConsoleOne and eDirectory have not yet 
been installed on your system, see “Novell eDirectory” on page 24.

2 Open a new terminal window, then enter the following command:

xhost + localhost

When creating your basic GroupWise system, you must run the GroupWise Installation 
Advisor in an environment where the X Window System is running and where your 
DISPLAY environment variable is set correctly.

3 In the same window, become root by entering su and the root password.

4 Change to the root of the GroupWise 6.5 for Linux Administrator CD.

5 Start the GroupWise Installation Advisor:

./install

6 Select the language in which you want to run the Installation Advisor and install software, 
then click OK.

If the X Window System is not installed or if your DISPLAY environment variable is not set 
correctly, a text-based Installation Advisor starts instead of the interface illustrated above. 
You cannot create a GroupWise system in the text-based Installation Advisor. It is designed 
for installing individual GroupWise components, not for creating a GroupWise system. If 
necessary, move to a Linux machine where the X Window System is running in order to run 
the GroupWise Setup Advisor to create your basic GroupWise system.

7 Continue with Installing the GroupWise Software.

Installing the GroupWise Software

1 Click Create or Update a GroupWise System.
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2 Review what the Installation Advisor accomplishes for you, then click Next.

The list on the left details the steps the Installation Advisor performs for you.

3 Accept the License Agreement, then click Next.

4 Specify or browse to and select the software distribution directory (worksheet item 4), then 
click Next.

5 Select the software components you want to copy into the software distribution directory 
(worksheet item 5), then click Next.

The Installation Advisor automatically installs the GroupWise agent software to the bin and 
lib subdirectories of /opt/novell/groupwise/agents. It also installs the GroupWise 
Administrator snap-ins to ConsoleOne under /usr/ConsoleOne. After installing the standard 
components, the Installation Advisor copies the selected software components into your 
software distribution directory.

6 When the copying is complete, click Next.

7 Select Creating a New GroupWise System, then click Next.

You use the New System utility in ConsoleOne to create your basic GroupWise system.

8 Review the instructions for accessing the New System utility in ConsoleOne, then click OK.

9 Continue with Selecting a Linux Mount Directory
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Selecting a Linux Mount Directory

The first time you start ConsoleOne with the GroupWise Administrator snap-ins installed, you are 
prompted to specify a Linux mount directory under which you create mount points. Typically, 
Linux servers and workstations use /mnt for this purpose. In the future as your system grows, this 
information helps ConsoleOne resolve the UNC paths of GroupWise database locations into Linux 
paths. Although the mount directory information is not used when you are creating your basic 
GroupWise system, it is gathered at this time for later reference.

GroupWise databases can be located on Linux servers, NetWare servers, or Windows servers. In 
the Linux mount directory, you will eventually create mount points that have the same names as 
the servers that are mounted to those mount points. You will need to do this for each server where 
a domain or post office is located that you want to access from ConsoleOne. The following table 
illustrates the correspondence between UNC paths and mount points for GroupWise database 
locations on Linux, NetWare, and Windows, assuming the typical mount directory of /mnt:

IMPORTANT: Although NetWare and Windows are not case-sensitive operating systems, the case of 
characters in pathnames becomes significant when the directory structure is mounted to a Linux server or 
workstation.

1 In the Installation Advisor, click Run to start ConsoleOne and display the Linux Mount 
Directory dialog box.

2 Browse to and select the Linux mount directory, then click OK.

A typical Linux mount directory is /mnt.

In the future, you and other GroupWise administrators might have different mounts points 
depending on the workstation or server where ConsoleOne is being run. To change the mount 
directory later in ConsoleOne, click Tools > GroupWise System Operations > System 
Preferences > Linux Settings. The mount directory information is stored in a user-specific 
preferences file (.consoleone/SnapinPrefs.ser in each GroupWise administrator’s home 
directory).

3 Continue with Using ConsoleOne to Create Your Basic GroupWise System.

Using ConsoleOne to Create Your Basic GroupWise System

On Linux, ConsoleOne does not automatically authenticate to any eDirectory trees when it starts, 
so the NDS object is not immediately expandable.

Platform GroupWise Domain UNC Path Corresponding Linux Mount Point

Linux \\Linux_server\GW_partition\domain_directory /mnt/Linux_server/GW_partition

NetWare \\NetWare_server\GW_volume\domain_directory /mnt/NetWare_server/GW_volume

Windows \\Windows_server\GW_share\domain_directory /mnt/Windows_server/GW_share
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1 In ConsoleOne, select NDS, then click File > Authenticate.

2 Fill in the following fields:

Login Name: Provide a Novell eDirectory username that has rights to create eDirectory 
objects.

Password: Provide the password for the username.

Tree: Type or select the eDirectory tree where you want to create GroupWise objects.

If the eDirectory tree is located on a Windows server, you might need to specify the IP address 
of the server instead of the tree name.

Context: Provide the full context of the User object associated with the username you 
provided.

3 Click Login.

4 Under the NDS object, select the tree where you want to create the GroupWise system, then 
click Tools > GroupWise Utilities > New System.

5 Follow the prompts to provide the information you planned using the “Basic GroupWise 
System Worksheet” on page 70.

6 After creating your basic GroupWise system, click Next to continue.
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7 Click Next to install the POA and MTA software.

8 Continue with Installing and Starting the GroupWise Linux Agents.

Installing and Starting the GroupWise Linux Agents

At this point, the Setup Advisor has created eDirectory objects and network server directories 
associated with your GroupWise system. You now need to install and start the MTA and POA on 
your Linux server.

“Installing the Linux Agents” on page 64

“Starting the Linux Agents for the First Time” on page 65

Installing the Linux Agents

The Setup Advisor starts the Agent Configuration program for you.

1 Review the Introduction, then click Next.

2 Accept the License Agreement, then click Next.

On the Configuration Complete page, Launch GroupWise Agents on System Startup is 
selected by default.

3 If you do not want the agents to start automatically when the server restarts, deselect Launch 
GroupWise Agents on System Startup.

4 Click Exit to complete the configuration.

5 Continue with Starting the Linux Agents for the First Time.

Starting the Linux Agents for the First Time

1 In a terminal window, become root by entering su and the root password.

2 Change to the GroupWise agent bin directory.

cd /opt/novell/groupwise/agents/bin

3 Enter the following command to start the MTA:

Syntax:
./gwmta --show --home domain_directory &

Example:
./gwmta --show --home /gwsystem/domlnx &
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The --show startup switch starts the MTA with an agent console interface similar to that 
provided for the NetWare and Windows MTAs. This user interface requires that the X 
Window System and OpenMotif be running on the Linux server.

The --home startup switch specifies the domain directory and is required to start the MTA.

The ampersand (&) causes the MTA to run in the background, so that the terminal window 
you started it in is again available for use.

The status messages displayed on the MTA agent console are also written to the MTA log file 
(mmddmta.nnn) in the /var/log/novell/groupwise/domain.mta directory. The log file name 
includes the month and day when it was created, along with an incrementing extension to 
accommodate multiple log files on the same day.

In ConsoleOne, you can see that the domain database has been updated by the MTA because 
the Version field on the Domain object shows 6.5 when the update is complete.

4 Wait until the domain has been updated before you start the POA.

5 Use the following command to start the POA:

Syntax:
./gwpoa --show --home post_office_directory &

Example:
./gwpoa --show --home /gwsystem/polnx &
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The status messages displayed on the POA agent console are also written to the POA log file 
(mmddpoa.nnn) in the /var/log/novell/groupwise/post_office.poa directory. The log file name 
includes the month and day when it was created, along with an incrementing extension to 
accommodate multiple log files on the same day.

In ConsoleOne, you can see that the post office database has been updated by the POA 
because the Version field on the Post Office object shows 6.5 when the update is complete.

After the post office database has been updated, you can install the GroupWise Cross-
Platform client and connect to the post office.

6 If you want to finish setting up your basic GroupWise system, continue with Setting Up and 
Running the GroupWise Cross-Platform Client on Your Local Machine.

or

If you want to learn more about managing the GroupWise agents on Linux, skip to the 
following sections in Chapter 7, “Installing GroupWise Agents,” on page 155:

“Starting the Linux Agents as Daemons” on page 169

“Monitoring the Linux Agents from Your Web Browser” on page 170

“Using Agent Startup Files” on page 170

“Starting the Linux Agents on System Startup” on page 170

“Stopping the Linux Agents” on page 171

Setting Up and Running the GroupWise Cross-Platform Client on Your Local Machine

On Linux, the Create or Update a GroupWise System option in the Setup Advisor does not include 
installation of the GroupWise Cross-Platform client.

1 On the GroupWise Installation main page, click Install Products > Install GroupWise Client.

2 When the Cross-Platform client files have been copied, click OK.

To start the Cross-Platform client:

3 Change to the client installation directory:

cd /opt/novell/groupwise/client/bin

4 Enter the following command:

./groupwise
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5 Specify your GroupWise user ID, password, and the required information about the server 
where the POA is running (worksheet item 18), then click OK.

For your convenience, the Installation Advisor created a shortcut for the Cross-Platform client 
on your desktop to simplify this process.

6 Get started with the GroupWise Cross-Platform client by completing the following tasks:

Setting A Mailbox Password: After you are logged in and using GroupWise, one of the 
first things you should do is set a password on your mailbox so that other users cannot 
access it. For information about setting a password, see Help in the GroupWise client.

Sending Messages and Scheduling Appointments: You can send messages to or 
schedule appointments with any users that you have added to the post office. To test your 
system, you might want to send a message to yourself. As soon as users set up the 
GroupWise clients on their workstations, as described in “Setting Up the GroupWise 
Cross-Platform Client” on page 181, they will also be able to send messages and schedule 
appointments.

7 Continue with Installing the GroupWise Administrator Snap-Ins to Additional Linux 
Locations.

or

If you have installed all the administrative software you need, skip to “What’s Next” on 
page 68.

Installing the GroupWise Administrator Snap-Ins to Additional Linux Locations

As part of creating your basic GroupWise system, the GroupWise Administrator snap-ins to 
ConsoleOne were installed in one location (worksheet item 3). If ConsoleOne is installed in 
multiple locations and if you want to be able to administer GroupWise from those locations, you 
need to install the GroupWise snap-ins to each ConsoleOne installation.

1 Go to the Linux workstation or server where you want to install the GroupWise snap-ins to 
ConsoleOne.

2 Make sure you are logged in as root and have network access to the software distribution 
directory (or GroupWise 6.5 for Linux Administrator CD) and the domain directory.

3 Start the Installation Advisor (install at the root of the CD), then click Install Products > 
GroupWise Administration > Install GroupWise Administration.

4 When the installation is complete, select Configure GroupWise Administration.

5 Accept the License Agreement, then provide the information requested by the Installation 
Advisor just as you did the first time you installed the GroupWise snap-ins.

6 Repeat Step 1 through Step 5 for each location where you want to install the GroupWise snap-
ins.

7 Continue with What’s Next.
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What’s Next
After you have set up your basic GroupWise system, you can expand the system by:

Setting up messaging access to the Internet through the GroupWise Internet Agent. See 
Chapter 4, “Installing the GroupWise Internet Agent,” on page 77.

Setting up GroupWise WebAccess so that users can access their mailboxes through a Web 
browser on a computer or wireless device such as a telephone. See Chapter 5, “Installing 
GroupWise WebAccess,” on page 99. 

Setting up GroupWise Monitor to monitor your GroupWise agents. See Chapter 6, “Installing 
GroupWise Monitor,” on page 135.

Installing the MTA or POA on a different server than the one you installed to during the basic 
system setup. See Chapter 7, “Installing GroupWise Agents,” on page 155.

Setting up users to run the GroupWise client on their workstations. See Chapter 8, “Installing 
the GroupWise Windows and Cross-Platform Clients,” on page 177.

Setting up users with instant messaging capabilities. See Chapter 9, “Installing GroupWise 
Messenger,” on page 183.

Adding more users to the post office. See “Users” in the GroupWise 6.5 Administration Guide 
(http://www.novell.com/documentation/gw65). 

Defining resources that users can schedule. See “Resources” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65). 

Defining groups of users that GroupWise users can select when addressing messages. See 
“Distribution Lists, Groups, and Organizational Roles” in the GroupWise 6.5 Administration 
Guide (http://www.novell.com/documentation/gw65).

Configuring your current post office’s library or setting up additional libraries. See “Libraries 
and Documents” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

Setting up GroupWise Remote so that Windows client users can access their mailboxes from 
a computer that is not directly connected to your network. See “Client” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65). 

Changing the GroupWise client from standard Online mode to Caching mode so that users’ 
messages are stored on a local drive rather than at the post office. See “Client” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Adding additional post offices to the domain. See “Post Offices” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

Adding additional domains to the system. See “Domains” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

Configuring the Post Office Agent (POA) and Message Transfer Agent (MTA) to support 
secure connections (SSL). See “Post Office Agent” and “Message Transfer Agent” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Connecting to other GroupWise 5.x or 6.x systems. See “System” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).
66   GroupWise 6.5 Installation Guide

http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65


    Novell Confidential                                                                                            Manual (99a)  21 December 2004
Basic GroupWise System Worksheet
The GroupWise Installation Advisor helps you install the GroupWise software. It then launches 
the GroupWise Setup Advisor, which helps you set up your first domain and post office. The 
Advisors prompt you for the information in the worksheet. You should print the worksheet and 
carefully fill in the information for your system.

Item Example Explanation

1) Tree Name: NOVELL_TREE Specify the name of the eDirectory tree where your domain 
and post office will be created. Because GroupWise 
introduces new objects into the tree, the eDirectory schema 
must be extended.

See “Novell eDirectory” on page 24.

2) Languages to Install: English-US

German

Specify the languages to install for GroupWise 
Administrator, the GroupWise agents, and the GroupWise 
clients.

See “GroupWise Languages” on page 27.

3) ConsoleOne Path: c:\novell\consoleone\1.2

or

z:/public/mgmt/consoleone

or

/usr/ConsoleOne

Specify the path to a ConsoleOne location, either on the 
local workstation or on a network server. The GroupWise 
Installation Advisor installs the GroupWise Administrator 
snap-in files in the specified location. 

ConsoleOne 1.3.4 (or higher) is required to run 
ConsoleOne on Windows. If necessary, you can install 
ConsoleOne 1.3.4 at the same time you install the 
GroupWise Administrator snap-ins.

On Linux, ConsoleOne 1.3.7 (or higher) is required. 
ConsoleOne must be installed before you start the Setup 
Advisor on Linux.

See “ConsoleOne” on page 25.

4) Software Distribution 
Directory:

z:\grpwise\software

or

\\server1\vol1\grpwise\software

or

/opt/novell/groupwise/software

Specify the directory path for the software distribution 
directory. If the directory does not exist, it is created. 

The path should be from the perspective of the machine 
you plan to use to install GroupWise. 

See “GroupWise Software Distribution Directory” on 
page 26.
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5) Software Selection:

GroupWise 
Administration

GroupWise agents

Internet Agent

WebAccess

GroupWise client

Monitor

GroupWise Administration

Agents

Client

Select the software you want copied to the software 
distribution directory.

See “GroupWise Software Distribution Directory” on 
page 26.

6) System Name: Novell Specify a one-word name. Names can reflect companies, 
locations, and so forth. 

See “System and Domain Names” on page 28.

7) Domain Name: Provo Specify a one-word name. Names can reflect locations, 
organizations, and so forth.

See “System and Domain Names” on page 28.

8) Domain Directory: j:\provo

or

\\server1\vol1\gwsystem\provo

or

/gwsystem/provo

Specify the path for the domain directory. If the directory 
does not exist, it is created. On NetWare, do not use a 
directory name that exceeds 8 characters. On Linux, use 
lowercase letters.

The path should be from the perspective of the machine 
you plan to use to install GroupWise.

See “Domain Directory” on page 29.

9) Domain Context: groupwise.novell Specify the eDirectory context where you want to create 
the Domain object. Make sure the context exists before you 
start installing GroupWise.

See “Domain Context” on page 29.

10) Domain Language: English Specify a language for the domain. The language 
determines how times, dates, and numbers are displayed 
in the GroupWise client and affects the sorting order for 
items in the GroupWise Address Book.

See “Domain Language” on page 32.

11) Domain Time Zone: Pacific Time Specify the time zone where the domain is located. The 
time zone information is used to ensure that times for 
messages sent between time zones are adjusted properly.

See “Domain Time Zone” on page 32.

Item Example Explanation
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12) Post Office Name: Research Specify a one-word name. Names can reflect locations, 
organizations, and so forth. 

See “Post Office Name” on page 33.

13) Post Office Directory: j:\research

or

\\server1\vol1\gwsystem\research

/gwsystem/research

Specify the path for the post office directory. If the directory 
does not exist, it is created. On NetWare, do not use a 
directory name that exceeds 8 characters. On Linux, use 
lowercase letters.

The path should be from the perspective of the machine 
you plan to use to install GroupWise.

See “Post Office Directory” on page 33.

14) Post Office Context: groupwise.novell Specify the eDirectory context where you want to create 
the Post Office object. Make sure the context exists before 
you start installing GroupWise.

See “Post Office Context” on page 34.

15) Post Office Language: English The post office language defaults to the domain language. 
Specify a different language if you do not want the post 
office to use the default domain language.

See “Post Office Language” on page 35.

16) Post Office Time Zone: Pacific Time The post office time zone defaults to the domain time zone. 
Specify a different time zone if the post office is not in the 
same time zone as the domain.

See “Post Office Time Zone” on page 35.

17) Post Office Link:

TCP/IP link

Direct link

TCP/IP link Select whether you want the Message Transfer Agent 
(MTA) to link to the post office through a TCP/IP connection 
to the Post Office Agent (POA) or a direct connection to the 
post office directory.

See “MTA Link to the Post Office” on page 38.

If you mark Direct Link, skip to worksheet item 20.

Item Example Explanation
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18) POA Network Address:

IP address or DNS 
hostname:

Client/Server port:
(default = 1677)

Message transfer port:
(default = 7101)

HTTP port:
(default = 7181)

IP address: 172.16.5.18

C/S port: 1677

MT port: 7101

HTTP port: 7181

This item applies only if you selected TCP/IP as the post 
office link method (worksheet item 17).

Specify the IP address or DNS hostname of the POA’s 
server.

By default, the POA listens for the GroupWise client on 
Client/Server port 1677. If this port is already being used, 
specify a different C/S port number (for example, 1678).

By default, the POA listens for the MTA on Message 
Transfer port 7101 (if the MTA and POA are 
communicating using TCP/IP). If this port is already being 
used, specify a different MT port number (for example, 
7102).

By default, the POA uses HTTP port 7181 for the Web 
console. The Web console enables you to view POA 
information through a Web browser. If this port is already 
being used, specify a different HTTP port number (for 
example, 7183).

See “MTA Link to the Post Office” on page 38.

19) MTA Network Address:

IP address or 
DNS hostname:

Message transfer port:
(default = 7100)

HTTP port:
(default =7180)

IP Address: 172.16.5.18

MT port: 7100

HTTP port:7180

This item applies only if you selected TCP/IP as the post 
office link method (worksheet item 17).

Specify the IP address or DNS hostname of the server 
running the Message Transfer Agent.

By default, the MTA listens for the POA on Message 
Transfer port 7100. If this port is already being used, 
specify a different MT port number (for example, 7103). 

By default, the MTA uses HTTP port 7180 for the Web 
console. The Web console enables you to view MTA 
information through a Web browser. If this port is already 
being used, specify a different HTTP port number (for 
example, 7182).

See “MTA Link to the Post Office” on page 38.

20) Post Office Users: jsmith.r&d.novell Specify the users who will have mailboxes on the post 
office. The Setup Advisor lets you browse the eDirectory 
tree to select the users you want. 

Adding users at this point is optional. After the Setup 
Advisor has finished, you can add users to the post office 
at any time.

See “Post Office Users” on page 35.

21) Agent Platform:

NetWare

Linux

Windows

NetWare Specify the platform (NetWare, Linux, or Windows) where 
you want to run the GroupWise agents.

See “Agent Platform” on page 36.

Item Example Explanation
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22) Agent Installation Path: z:\system

or

\\server1\vol1\system

or

/opt/novell/groupwise/agents

Specify the path to the directory where you want to install 
the agents. 

We recommend that you install the NetWare agents to the 
sys:\system directory to simplify the use of startup files and 
ensure that dependent NLM programs load properly.

You can install the Windows agents to any directory on the 
Windows server. Because the installation is done from the 
Windows server, the default is c:\grpwise.

The Linux agents are automatically installed into the bin 
and lib subdirectories of /opt/novell/groupwise/agents.

See “Agent Location” on page 36.

23) Agent Language: English Specify the language in which you want to be able to run 
the agents. 

See “Agent Language” on page 39.

24) Windows Agent 
Installation Options:

Install GroupWise agent 
software: 
Yes | No

Install and configure 
SNMP for GroupWise 
Agents: 
Yes | No

Install as Windows 
services: 
Yes | No

Install GroupWise agent software

Install as Windows services

This item applies only if you are installing the Windows 
agents.

Specify the installation options you want to use.

The Install GroupWise Agent Software option needs to be 
selected to install the files.

The Install and Configure SNMP for GroupWise Agents 
option requires the SNMP service to already be enabled on 
the Windows server. If SNMP is not enabled, this option is 
dim in the Installation Advisor.

The Install as Windows Services option configures the 
agents as Windows services. 

See “Windows Application vs. Windows Service (Windows 
Agents Only)” on page 38.

25) Windows Service 
Information:

Use local system 
account

Use a user account

Startup: 
Automatic | Manual 

Use a user account:
username = gwagents
password = admin

Startup: automatic

This item applies only if you are installing the Windows 
agents as Windows services.

Select whether you want the services to use the local 
system account or another user account. If the domain and 
post office directories are on the same Windows server as 
the agents, you can use the local system account. If the 
domain and post office directories are on a different server, 
specify a different user account that exists in eDirectory 
and has rights to the domain and post office directories.

Select whether you want to manually start the services or 
have them start automatically when the server starts. 

See “Windows Application vs. Windows Service (Windows 
Agents Only)” on page 38.

Item Example Explanation
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4 Installing the GroupWise Internet Agent

The Novell® GroupWise® Internet Agent enables you to send and receive messages over the 
Internet. The following sections provide information to help you successfully install the Internet 
Agent in your existing GroupWise system.

“GroupWise Internet Agent Overview” on page 77

“Internet Agent System Requirements” on page 80

“Planning the GroupWise Internet Agent” on page 82

“Setting Up the Internet Agent” on page 86

“What’s Next” on page 95

“GroupWise Internet Agent Installation Worksheet” on page 95

After you’ve installed the Internet Agent, there are additional tasks you can perform to optimize 
and maintain your GroupWise system. These tasks are discussed under “What’s Next” on page 95.
NOTE: If you plan to install the Internet Agent in a clustered server environment provided by Novell Cluster 
ServicesTM or Microsoft Clustering Services, see the GroupWise 6.5 Interoperability Guide for additional 
information. 

GroupWise Internet Agent Overview
The Internet Agent allows communication between GroupWise users and users of other messaging 
systems who use the Internet to send e-mail. The Internet Agent picks up inbound e-mail messages 
from the Internet, converts them from RFC-822 or MIME format to the GroupWise message 
format, and then passes the converted messages to the GroupWise Message Transfer Agent 
(MTA).

For outgoing messages transported by the Internet, the GroupWise MTA passes the message to the 
Internet Agent, which then converts the message to Internet messaging format, and then sends it 
to the designated Internet address.
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Choose from the following list of topics to learn more about the capabilities of the GroupWise 
Internet Agent. 

“SMTP/MIME Service” on page 78

“POP3 Service” on page 79

“IMAP4 Service” on page 79

“LDAP Services” on page 79

“Secure Connections via SSL” on page 80

“Access Control” on page 80

“Multiple Threading” on page 80

“SNMP-Compliant” on page 80

“SMP Support (NetWare Version)” on page 80

SMTP/MIME Service
The SMTP/MIME service in the Internet Agent allows you to send and receive e-mail with 
standard encoding on attachments, international character sets, and multipart messages. 
Multimedia e-mail with graphics, sound, and video can also be exchanged. The service also 
includes these additional features:

SMTP Dial-Up Service: The Internet Agent includes SMTP dial-up functionality. This can 
be useful when your system does not meet the requirements of a dedicated Internet 
connection, or when you prefer not to have a permanent Internet connection. With the SMTP 
dial-up feature, you can establish a schedule to periodically check the message store without 
having to maintain a permanent link.

Domain

PO

Domain

Domain

Domain

PO

PO

PO

PO

PO

PO

Internet

GWIA
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Flexible Addressing: The Internet Agent offers full GroupWise addressing support, 
including system groups, nicknames, and individual users.

The Internet Agent also takes advantage of GroupWise Internet addressing, which allows 
inbound messages addressed in a variety of formats to be delivered to GW users. These 
formats include:

UserID@Internet_domain_name
UserID.PostOffice@Internet_domain_name
Last_Name.First_Name@Internet_domain_name
First_Name.Last_Name@Internet_domain_name
First_Initial_Last_Name@Internet_domain_name

Internet Users in the Address Book: Internet users can be added to the GroupWise Address 
Book so users won't have to remember long Internet addresses.

Real-Time Blacklists: Many organizations, such as Mail Abuse Prevention System 
(MAPS*), Open Relay DataBase (ORDB), and SpamCop, provide lists of IP addresses that 
are known to be open relay hosts or spam hosts. You can use the real-time blacklists provided 
by these sites to protect your users from offensive spam.

Accounting: The accounting feature provides inbound and outbound tracking of messages 
passing through Internet Agent. This lets administrators track how the Internet Agent is being 
used.

DNS Name Resolution: The Internet Agent can access a DNS server directly to resolve host 
names to IP addresses, or it can rely on a relay host to perform the name resolution.

Connect to Other GroupWise Systems Through the Internet: Using passthrough 
addressing, you can connect to other GroupWise systems anywhere on the Internet and have 
access to all of the GroupWise features. The Internet simply becomes a mail transport medium 
for GroupWise.

POP3 Service
The POP3 service in the Internet Agent allows you to download messages from your GroupWise 
post office to a POP3 client application such as a Web browser’s e-mail program or a Telnet 
application. The Internet Agent acts as the POP3 server, providing a TCP connection between the 
user’s GroupWise post office and a POP3 client. Accessing the GroupWise post office via the 
Internet Agent’s POP3 server capability, users can retrieve their e-mail messages and manage 
them through user ID login options.

IMAP4 Service
The GroupWise Internet Agent supports the Internet Messaging Access Protocol 4 (IMAP4). As 
an IMAP4 server, the Internet Agent allows IMAP4-compliant e-mail clients to read and 
manipulate GroupWise messages.

LDAP Services
The Internet Agent supports the Lightweight Directory Access Protocol (LDAP) directory 
standard with LDAP server capability that allows access for directory searches of GroupWise post 
offices. Using LDAP Public Access, Internet mail clients can do lookups on GroupWise users and 
address information.
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Secure Connections via SSL
The Internet Agent supports the use of SSL for its connections to SMTP hosts, POP3 clients, 
IMAP4 clients, and Internet Agent Web consoles. 

Access Control
The Internet Agent program includes security capabilities called Access Control that allow 
administrators to control user access to all services (SMTP/MIME, LDAP, POP3, and IMAP4). 
Access Control can help you reduce costs and provide added security.

With the SMTP/MIME service, Access Control can be used to block messages being sent to or 
received from specific hosts.

Multiple Threading
Multiple threading allows more than one send or receive process to be running concurrently. You 
can configure the number of threads to enhance the speed and performance of the Internet Agent. 
The number of thread switches are set separately for the SMTP/MIME service, POP3 service, 
IMAP4 service, and LDAP service.

SNMP-Compliant
The NetWare version of the Internet Agent can be managed by any SNMP-compliant network 
manager, such as the Novell ManageWise® network management suite or the alarm management 
features of Novell ZENworks® Server Management.

The Windows version of the Internet Agent includes SNMP support for Windows NT and 
Windows 2000. The Linux version of the Internet Agent is also SNMP compliant.

SMP Support (NetWare Version)
The Internet agent supports Symmetric Multi-Processing (SMP), letting it take advantage of a 
server with multiple processors.

Internet Agent System Requirements
The following sections define the Internet Agent’s requirements:

“Network Server Requirements” on page 80

“GroupWise System Requirements” on page 81

“Internet Connectivity Requirements” on page 81

Network Server Requirements
The network server where you install the Internet Agent must meet the following requirements:

32-bit/x86 processor

Any of the following server operating systems:

NetWare® 4.2, NetWare 5.1, or NetWare 6.x, plus the latest Support Pack for your 
version of NetWare
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SUSE® Linux Standard Server 8, SUSE Linux Enterprise Server 8, SUSE Linux 
Enterprise Server 9, Red Hat Enterprise Linux 3 ES, or Red Hat Enterprise Linux AS

OpenMotif is required by the GUI Internet Agent console. The Internet Agent can also 
run as a daemon without a user interface.

Windows NT Server, Windows 2000 Server, Windows 2003 Server, plus the latest 
Support Pack for your version of Windows

Adequate server disk space:

17 MB for the Internet Agent program files.

200 MB minimum for message file processing. The actual amount will be determined by 
the number and size of message files being processed at one time by the Internet Agent.

Adequate RAM

12 MB. This is the amount of memory the Internet Agent needs to operate. It does not 
include memory for the operating system or for TCP/IP connectivity. This amount can 
increase depending on message size and complexity.

GroupWise System Requirements
The GroupWise system in which you install the Internet Agent must meet the following 
requirements:

The domain’s version must be equal to or newer than the Internet Agent’s version. The 
domain’s version is determined by the Message Transfer Agent (MTA) version running 
against it.

The versions of any post offices that the Internet Agent will access on behalf of POP3 or 
IMAP4 clients must be equal to or newer than the Internet Agent’s version. A post office’s 
version is determined by the Post Office Agent (POA) version running against it.

Internet Connectivity Requirements
Before you install the Internet Agent, you need to ensure that your network is configured for 
Internet connectivity.

Internet Connection: You can connect to the Internet using a direct connection over a leased 
line or a standard switched telephone line.

Internet Domain Name: You must have an Internet domain name. The domain name must 
be defined by an MX RR (mail exchanger resource record) in DNS. 

DNS Server Access or Relay Host Access: If you want the Internet Agent to send messages 
directly to other SMTP hosts, it requires access to a DNS server for address resolution. 
Otherwise, it requires access to a relay host that can perform the address resolution and 
message routing. Make sure the network server where you plan to install the Internet Agent is 
configured to access a DNS server or can access your relay host. For specific details, refer to 
your server documentation.

IP Address: The Internet Agent’s server requires a static IP address and fully qualified 
hostname.
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Planning the GroupWise Internet Agent
Use the “GroupWise Internet Agent Installation Worksheet” on page 95 to record your decisions 
about how to install the Internet Agent as you review the following considerations:

“Selecting the Internet Agent Platform” on page 82

“Selecting the Internet Agent Installation Directory” on page 82

“Gathering Domain and Gateway Information” on page 83

“Selecting the Gateway Object Name” on page 83

“Specifying the Internet Mail Domain Name for Your GroupWise System” on page 83

“Handling Outbound Mail” on page 83

“Clustering the NetWare Internet Agent” on page 84

“Configuring the Windows Internet Agent” on page 84

“Enabling the Internet Agent Web Console” on page 85

“Gathering LDAP Information (Linux Only)” on page 86

Selecting the Internet Agent Platform
The Internet Agent is available as a NetWare NLMTM program, a Linux executable, and a Windows 
executable.

Selecting the Internet Agent Installation Directory
You should install the Internet Agent on the same server where the domain directory is located. 
The Internet Agent installation directory depends on the platform where you are installing it. 

Consider these platform-specific guidelines:

NetWare: When installing the NetWare Internet Agent, we recommend you use the 
sys:\system directory on the NetWare server. This simplifies access to the Internet Agent 
configuration file and ensures that the NLM program is in the server’s search path. If you use 
a different directory, you must add that directory to the server’s search path.

Linux: The Linux Internet Agent is automatically installed to the bin and lib subdirectories 
under /opt/novell/groupwise/agents. 

Windows: The default installation directory is c:\grpwise\gwia. However, you can install the 
Internet Agent to any directory you want.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 1: Software Platform, mark whether you plan to install the Internet Agent on NetWare, 
Linux, or Windows. Review “Internet Agent System Requirements” on page 80 to ensure that the 
specific server you have selected meets the listed requirements.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 3: Installation Path, record the directory where you want to install the Internet Agent 
software.
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Gathering Domain and Gateway Information
The Internet Agent requires a GroupWise gateway directory in which to store configuration 
information and work files. The gateway directory must be located under a GroupWise domain 
directory. The default directory name is GWIA on NetWare and Windows, gwia on Linux. If you 
change the name on NetWare, use a maximum of 8 characters in the new name. If you change the 
name on Linux, use lowercase letters.

After you specify the domain directory location and a gateway directory name, the Installation 
Advisor creates the gateway directory under the domain\wpgate directory (for example, 
provo\wpgate\gwia on NetWare and Windows, provo/wpgate/gwia on Linux).

Selecting the Gateway Object Name
The Internet Agent also requires a GroupWise Gateway object in Novell eDirectory. This object 
stores the Internet Agent’s information and enables configuration of the agent through 
ConsoleOne®.

The Internet Agent’s object is created below the Domain object. If you have multiple domains, the 
Installation Advisor uses the Domain object associated with the domain directory where you are 
creating the Internet Agent’s gateway directory.

Specifying the Internet Mail Domain Name for Your GroupWise System
When e-mail users across the Internet address messages to GroupWise users, the address includes 
the Internet mail domain for your GroupWise system (for example, novell.com). Typically, the 
Internet mail domain name for your GroupWise system is the name of your company, with its 
accompanying domain type (.com, .edu, etc.).

Handling Outbound Mail
If the Internet Agent is connected to the Internet and is able to perform DNS name resolution, it 
can send messages from GroupWise users across the Internet to Internet users. However, you 
might prefer to keep the Internet Agent behind your firewall. To accomplish this, you can 
configure the Internet Agent to route all outbound messages to a relay host.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 5: GroupWise Domain, specify the domain name and the full path to the domain directory 
where you want to create the gateway directory, then give the gateway directory a name.

If you are installing the Linux Internet Agent, record the eDirectoryTM context of the Domain object (for 
example, cn=provo3,ou=groupwise,o=corporate).

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 6: GroupWise Internet Agent Name, specify the name you want to give the Internet Agent’s 
object. The default name is the same as the gateway directory name you chose for Item 5.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 7: Internet Mail Domain name, specify the name you want your GroupWise system to be 
known by across the Internet.
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Clustering the NetWare Internet Agent
Novell Cluster Services is a server clustering system that ensures high availability and 
manageability of critical network resources including volumes (where GroupWise domains 
reside) and applications (such as the Internet Agent). Novell Cluster Services supports failover, 
failback, and migration of individually managed cluster resources. 

The NetWare Internet Agent can be configured to take advantage of the fault-tolerant environment 
provided by Novell Cluster Services if the following requirements are met:

The domain where the Internet Agent is installed has already been created on a shared NSS 
volume in the cluster.

The NetWare Internet Agent is being installed to a server that is part of the same cluster.

When the agents are configured for clustering, their startup files are configured with shared 
volume names rather than specific server names. In addition, the POA is configured to more 
effectively re-establish logins with GroupWise clients when a failover or migration situation 
arises.

Additional configuration of the Internet Agent object in ConsoleOne is required to complete the 
agent setup in a clustering environment, as described in “Implementing the Internet Agent in a 
Novell Cluster” in “Novell Cluster Services” in the GroupWise 6.5 Interoperability Guide (http:/
/www.novell.com/documentation/gw65).

Configuring the Windows Internet Agent
When you install the Windows Internet Agent, you have choices about how the Internet Agent 
interacts with the Windows operating system.

“Configuring the Windows Internet Agent as a Service” on page 84

“Using SNMP Traps to Monitor the Windows Internet Agent” on page 85

Configuring the Windows Internet Agent as a Service

When you run the Windows Internet Agent as a service, it can start automatically and run without 
a user interface.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 4: Relay Host, mark how you want to handle outbound mail. If you plan to use a relay host, 
specify the IP address of the relay host.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 2: Installation Options, mark whether or not you want to configure the NetWare Internet 
Agent for clustering.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 2: Installation Options, mark Install as Windows Service if you want to run the Internet Agent 
as a service.
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When you run the Windows Internet Agent as a service, it must run under a specific Windows user 
account. 

When the Internet Agent domain is located on the same server where you are installing the Internet 
Agent, the Internet Agent can run under the local system account. You can also display the Internet 
Agent console when the agent software, directories, and databases are local. 

When the Internet Agent domain is located on a remote server, you must specify a user with rights 
to access the domain directory. If the Windows Internet Agent needs to log in to a Windows server, 
provide a Windows username and password. If the Windows Internet Agent needs to log in to a 
NetWare server, provide an existing eDirectory username and password, or create a new account 
for the agents.

As with all Windows services, the Windows Internet Agent can be started automatically or 
manually as a service each time the Windows server restarts.

Using SNMP Traps to Monitor the Windows Internet Agent

If you want to use an SNMP manager program, such as the Management and Monitoring Services 
component of Novell ZENworks Server Management, to monitor the Windows Internet Agent, 
you must install some SNMP components along with the Internet Agent software.

NOTE: The NetWare and Linux Internet Agents rely on operating system components for SNMP functionality 
and do not require this installation option.

Enabling the Internet Agent Web Console
The Internet Agent console enables you to monitor the Internet Agent from the server where it is 
running. If you want, you can enable the Internet Agent’s Web console. The Web console lets you 
view the Internet Agent’s statistical and diagnostic information through a Web browser, which is 
useful if want to see the Internet Agent’s activity without physically visiting the agent’s server.

You access the Web console by entering the Internet Agent’s network address and HTTP port 
number in a Web browser (for example, http://172.16.5.18:7211). If necessary, you can change the 
Internet Agent’s default HTTP port number (9850).

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 9: Windows Service Information, record the account the Internet Agent will run under, and 
if necessary, the password for the account.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 9: Windows Service Information, mark how you want the Windows Internet Agent to start 
each time the server is restarted.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 2: Installation Options, mark Install and Configure SNMP for GroupWise Agents if you 
want to use an SNMP manager program.

If this option is dimmed during installation, the SNMP service has not been enabled on the Windows 
server where you are installing the agents. If you want to monitor the agents from an SNMP 
management program, the SNMP service must be enabled so you can select this option.
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If you want to restrict access to the Web console, you can assign a username and password. This 
can be any username and password you want. By default, the username and password are passed 
through an unsecure connection between the Web browser and the Internet Agent. Therefore, we 
recommend that you do not use an existing eDirectory or Windows username and password unless 
you secure this connection using SSL. For information about securing the Internet Agent’s 
connections, see “Internet Agent” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

Gathering LDAP Information (Linux Only)
If you are installing the Linux Internet Agent, the Installation Advisor needs to access eDirectory 
through LDAP. eDirectory access is required in order to create the Internet Agent object. To obtain 
access, the Installation Advisor needs the IP address and port number of an LDAP server, along 
with a username and password to log in with. Because the Linux Installation Advisor uses LDAP 
to access eDirectory, you must provide the username in LDAP format. For example:

cn=admin,ou=users,o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a certificate file. For 
background information about SSL, see “Encryption and Certificates” in “Security” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Setting Up the Internet Agent
Complete the following tasks to set up the Internet Agent:

“Installing the Internet Agent” on page 86

“Assigning a Postmaster” on page 89

“Starting the Internet Agent” on page 90

“Testing the Internet Agent” on page 94

Installing the Internet Agent
As you install the Internet Agent, you are prompted to supply configuration information. Use the 
“GroupWise Internet Agent Installation Worksheet” on page 95 to understand the prompts and to 
record your installation and configuration information.

“Installing the Internet Agent Software on NetWare or Windows” on page 87

“Installing the Internet Agent Software on Linux” on page 88

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 3: Web Console Information, select Yes if you want to enable the Web console. If you want 
to restrict access to the Web console, enter a username and password. 

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 8: LDAP Information, specify the IP address and port number of an LDAP server, a 
username in LDAP format, the password for the username, and if necessary, the full path to your SSL 
certificate file.
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Installing the Internet Agent Software on NetWare or Windows

The Internet Agent Installation program does the following:

Installs Internet Agent files to the local server and to the domain directory.

Tests the server you are installing to for correct Internet configuration.

Creates the Internet Agent object in Novell eDirectory.

Configures startup files for the Internet Agent.

To install the Internet Agent:

1 Make sure the server from which you will perform the installation has the Novell ClientTM 
installed.

The Internet Agent Installation program creates GroupWise objects in eDirectory. The Novell 
Client is required to access eDirectory. If necessary, you can download the Novell Client from 
the Novell Product Downloads site (http://download.novell.com).

2 Make sure you have the appropriate file system and eDirectory access rights.

2a If you are installing the NetWare Internet Agent, on the Windows workstation from 
which you will install the Internet Agent to the NetWare server, make sure you have the 
following file system and eDirectory access rights:

You must be attached to the NetWare server where you will install the Internet Agent 
files. By default, the Internet Agent Installation program copies files to the 
sys:\system directory. You can specify a different directory if desired. Make sure you 
have rights to whichever directory you plan to install the files to.

You must be attached to the server where the domain directory resides. The Internet 
Agent Installation program creates domain subdirectories and copies Internet Agent 
files to the subdirectories. This requires full file system rights to the domain 
directory.

You must be logged in to eDirectory with Admin-equivalent rights to the eDirectory 
tree where the GroupWise Domain object resides. The Internet Agent Installation 
program creates an Internet Agent object under the Domain object.

2b If you are installing the Windows Internet Agent, on the Windows server where you will 
install the Internet Agent, make sure you have the following file system and eDirectory 
access rights:

You must be logged into the Windows server through a Windows user account that 
provides full local system access. The Internet Agent Installation program creates 
local directories and copies Internet Agent files to the directories.

You must be logged in to the server where the domain directory resides. The Internet 
Agent Installation program creates domain subdirectories and copies Internet Agent 
files to the subdirectories. This requires full file system rights to the domain 
directory.

You must be logged in to eDirectory with Admin-equivalent rights to the eDirectory 
tree where the GroupWise Domain object resides. The Internet Agent Installation 
program creates an Internet Agent object under the Domain object.

3 Insert the GroupWise 6.5 Administrator CD into the CD drive.

or

If you have already copied the Internet Agent files to the GroupWise software distribution 
directory, you can run the Internet Agent Installation program from that directory.
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4 Click Start, click Run, type the path or browse to install.exe, then click OK.

CD Path: d:\internet\gwia\install.exe

Directory Path: z:\grpwise\software\internet\gwia\install.exe

5 Follow the prompts, using the information from the “GroupWise Internet Agent Installation 
Worksheet” on page 95.

6 Continue with “Assigning a Postmaster” on page 89.

Installing the Internet Agent Software on Linux

As you install the Internet Agent, you are prompted to supply configuration information. Use the 
“GroupWise Internet Agent Installation Worksheet” on page 95 to understand the prompts and to 
record your installation and configuration information.

“Installing the Internet Agent” on page 88

“Configuring the Internet Agent” on page 88

Installing the Internet Agent

1 Make sure you have set up a basic GroupWise test system, described in Chapter 3, “Installing 
a Basic GroupWise System,” on page 23.

2 Make sure that LDAP is running on your eDirectory server and that it is configured to accept 
login from the Internet Agent Installation program (worksheet item 8).

The Installation Advisor requires eDirectory access in order to create the Internet Agent object 
in eDirectory. The Installation Advisor uses LDAP to gain the required access.

3 Open a new terminal window, then enter the following command:

xhost + localhost

If you cannot execute this command because the X Window System is not running on the 
Linux server, see “Installing the GroupWise Agents Using the Text-Based Installation 
Advisor” on page 167, which describes the process for the POA and the MTA.

4 In the same window, become root by entering su and the root password.

5 Change to the root of GroupWise 6.5 for Linux Administrator CD.

6 Enter ./install.

7 Select the language in which you want to run the Installation Advisor and install the Internet 
Agent software, then click OK.

8 In the Installation Advisor, click Install Products > GroupWise Internet Agent > Install 
GroupWise Internet Agent.

The GroupWise Internet Agent executable (gwia) is installed to the /opt/novell/groupwise/
agents/bin directory.

9 When the installation is complete, click OK.

10 Continue with Configuring the Internet Agent.

Configuring the Internet Agent

1 After the Internet Agent files have been installed, click Configure Internet Agent.

The Internet Agent installation and configuration steps are separate so that you can install 
updated agent software without needing to repeat the agent configuration steps.
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2 Review the Introduction, then click Next.

3 Accept the License Agreement, then click Next.

4 Specify the fully qualified DNS hostname of the Linux server where you are installing the 
Internet Agent, then click Next.

5 Select how you want the Internet Agent to handle outbound mail (worksheet item 4), then 
click Next.

6 Specify the hostname portion of your Internet mail domain name (worksheet item 7), then 
click Next.

If you do not know your Internet Main domain name yet, select Enter from ConsoleOne so 
that you can provide this information later.

7 Browse to and select the domain directory of the domain where you are installing the Internet 
Agent (worksheet item 5), then click Next.

8 Fill in the LDAP information (worksheet item 8), then click Next.

9 Fill in the Internet Agent object information (worksheet items 5 and 6), then click Next.

On the Configuration Complete page, Launch Internet Agent on System Startup is selected by 
default.

10 If you do not want the Internet Agent to start automatically when the server restarts, deselect 
Launch Internet Agent on System Startup.

11 Click Exit to complete the configuration.

12 Continue with Assigning a Postmaster.

Assigning a Postmaster 
The Internet requires each site to assign at least one user to be the Postmaster. The Postmaster is 
assigned to be the recipient of messages addressed to postmaster@host. 

To assign a Postmaster:

1 In ConsoleOne, right-click the Internet Agent object, click Properties, click the GroupWise 
tab, then click the Gateway Administrators page.

2 On the Gateway Administrators page, click Add, select a GroupWise user to be the 
Postmaster, then click OK.

3 Select the user from the list, then click Postmaster.
Installing the GroupWise Internet Agent 85



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
4 Click OK to save the information.

5 Continue with Starting the Internet Agent.

The Internet Agent can also be configured to send problem messages to the Postmaster. For 
instructions, see “Determining What to Do with Undeliverable Messages” in “Internet Agent” in 
the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Starting the Internet Agent
After you’ve installed the Internet Agent and configured a Postmaster, you can start the Internet 
Agent.

“Starting the Internet Agent on NetWare” on page 90

“Starting the Internet Agent on Linux” on page 91

“Starting the Internet Agent on Windows” on page 94

Starting the Internet Agent on NetWare

During installation, the Internet Agent Installation program copied the gwia.ncf startup file to the 
sys:\system directory (unless you specified a different directory). You use this file to load the 
Internet Agent.

If you chose to have the Internet Agent Installation program add the gwia.ncf command to your 
autoexec.ncf, the Internet Agent loads when you start the file server.

To manually start the Internet Agent:

1 At the NetWare server console, enter gwia to run the gwia.ncf file. 

After you have started the Internet Agent, verify that the program is running. You can monitor 
the program at the Internet Agent server console that displays on the NetWare server console. 
Press F10-Options, then press F9-Stats. If you see an error message in the Statistics window, 
the program has not loaded properly.

If you need to stop the Internet Agent, press F7-Exit at the Internet Agent console or enter 
unload gwia at the NetWare server console.

2 If you enabled the Internet Agent Web console, use the following URL in a Web browser to 
log into the Internet Agent Web console:

http://internet_agent_network_address:http_port

For example:

http://172.16.5.18:9850

3 Continue with “Testing the Internet Agent” on page 94.

Starting the Internet Agent on Linux

Complete the following tasks to set up the Linux Internet Agent. These tasks are designed to help 
you get the Internet Agent up and running as quickly as possible and to help you manage the 
Internet Agent in the future.

“Starting the Linux Internet Agent with a User Interface” on page 91

“Starting the Linux Internet Agent as a Daemon” on page 92

“Monitoring the Linux Internet Agent from Your Web Browser” on page 92
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“Starting the Linux Internet Agent on System Startup” on page 93

“Stopping the Linux Internet Agent” on page 93

Starting the Linux Internet Agent with a User Interface

1 If Sendmail, Postfix, or any other SMTP daemon is enabled on your Linux server, disable it 
before starting the Internet Agent.

2 If you want to use the Internet Agent for POP3 and IMAP4 mail, make sure no POP3 or 
IMAP4 daemons are running on your Linux server.

3 Make sure you are logged in as root.

4 Make sure that the MTA for the domain is running.

5 Change to the /opt/novell/groupwise/agents/bin directory.

6 Enter the following command to start the Internet Agent:

./gwia --show @../share/gwia.cfg &

The --show switch starts the Internet Agent with an agent console interface similar to that 
provided for the NetWare and Windows Internet Agent. This user interface requires that the 
X Window System and OpenMotif be running on the Linux server.

The @ startup switch points to the Internet Agent configuration file and is required to start the 
Internet Agent.

The ampersand (&) causes the Internet Agent to run in the background, so that the terminal 
window you started it in is again available for use.

The status messages displayed on the Internet Agent console are also written to the Internet 
Agent log file (mmddlog.nnn) in the /var/log/novell/groupwise/domain.gwia directory. The 
log file name includes the month and day when it was created, along with an incrementing 
extension to accommodate multiple log files on the same day.

Starting the Linux Internet Agent as a Daemon

1 Make sure you are logged in as root.

2 Change to the /etc/init.d directory.
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3 To start the Internet Agent, enter the following command:

./grpwise-ia start

4 To confirm that the Internet Agent has started, enter the following command:

ps -eaf | grep gwia

This lists all of the Internet Agent process IDs.

Monitoring the Linux Internet Agent from Your Web Browser

Before you can monitor the Linux Internet Agent from your Web browser, you must configure its 
HTTP port and, if desired, provide a username and password to prevent unauthorized access.

1 In ConsoleOne, right-click the WebAccess Agent object, then click Properties.

2 Click GroupWise > Network Address to display the Network Address page.

3 In the HTTP Port field, enter a port number. We recommend that you use port 9850 if it is not 
already in use on the Internet Agent’s server.

By default, any user who knows the Internet Agent’s IP address (or hostname) and the HTTP 
port number can access the Web console. If you want to restrict Web console access, you can 
assign a username and password.

4 Click the GroupWise tab, then click Optional Gateway Settings to display the Optional 
Gateway Settings page.

5 In the HTTP User Name field, enter an arbitrary username (for example, gwia).

6 Click Set Password to assign a password (for example, monitor).

7 Click OK to save your changes.

8 To monitor the Internet Agent from your Web browser, view the Internet Agent Web console 
by supplying the IP address and port number of the Internet Agent. For example:

http://172.16.5.18:9850

Starting the Linux Internet Agent on System Startup

If you selected Launch Internet Agent on System Startup in the Internet Agent Installation 
program, the Internet Agent Installation program configured your system so that the Internet Agent 
would start automatically each time you restart your server. The Internet Agent Installation 
Program always creates a grpwise-ia startup script in /etc/init.d for starting the Internet Agent. To 
enable automatic startup, the Internet Agent Installation program also creates symbolic links 
named S99grpwise-ia in the rc3.d and rc5.d directories so that the Internet Agent can load on 
startup into runlevel 3 or 5, depending on the configuration of your Linux system.
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When the grpwise-ia script runs and starts the Internet Agent, it reads the Internet Agent 
configuration file (gwia.cfg) in /opt/novell/groupwise/agents/share to check for configuration 
information provided by startup switches. Because the --show switch cannot be used in the 
configuration file, the Internet Agent never runs with an agent console interface when started 
automatically when the server restarts.

Stopping the Linux Internet Agent

When you use the --show startup switch to start the Internet Agent, you can stop it from the agent 
console.

1 Click File > Exit > Yes.

When you start the Internet Agent with the grpwise-ia script, you can also use the script to stop it.

1 Make sure you are logged in as root.

2 Change to the /etc/init.d directory.

3 To stop the Internet Agent, enter the following command:

./grpwise-ia stop

4 To confirm that the Internet Agent has stopped, enter the following command:

ps -eaf | grep gwia

The only gwia process ID you should see listed is the one for the grep command

When you start the Internet Agent manually (without using the grpwise-ia script), use the standard 
Linux kill command to stop it.

1 Make sure you are logged in as root.

2 Determine the process ID (PID) of the Internet Agent:

ps -eaf | grep gwia

The PIDs for all gwia processes are listed.

3 Kill the first gwia process in the list:

Syntax:
kill PID

Example:
kill 1483

It might take a few seconds for all gwia processes to terminate.

4 Repeat the ps command to verify that the Internet Agent has stopped.

Starting the Internet Agent on Windows

1 If the domain directory is not on the Internet Agent’s server, make sure you are logged in at 
the server through the user accounts (both Windows and eDirectory) that provide the Internet 
Agent with access to the domain directory.

2 If the Internet Agent isn’t installed as a Windows service, click the Start menu > Programs > 
GroupWise Internet Agent > GroupWise Internet Agent.

or

If the Internet Agent is installed as a Windows service, open the Services window (from the 
Control Panel or Administrative Tools), right-click the GWIA service, then click Start.
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If you need to stop the Internet Agent and it is running as an application in its own window, 
click File > Exit. If it is running as a Windows service, open the Services window, right-click 
the GWIA service, then click Stop.

3 If you enabled the Internet Agent Web console, use the following URL to log into the Web 
console:

http://internet_agent_network_address:http_port

For example:

http://172.16.5.18:9850

4 Continue with Testing the Internet Agent.

Testing the Internet Agent
After you’ve started the Internet Agent, you should send a message to ensure that the system is 
working properly. 

To send a message:

1 Open a new mail message in your GroupWise client.

2 In the To field, enter your Internet address using the following syntax:

internet_agent:"user@host" 

where internet_agent is the Internet Agent’s name. For example: 

gwia:"rcollins@novell.com"

3 Send the message and check your mailbox to verify that you receive it.

4 Continue with What’s Next.

What’s Next
The “Internet Agent” section of the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65) provides information to help you further configure and 
maintain the Internet Agent, including how to:

Configure addressing options. By default, your GroupWise system is set up to use the 
standard GroupWise address format (user_ID.post_office.domain). This requires your users 
to enter Internet addresses in the following format: internet_agent:"user@host". You can 
configure your GroupWise system to use Internet-style address format (user@host) rather 
than the standard GroupWise address format. 

Optimize configuration settings for the SMTP/MIME, IMAP, POP, and LDAP services.

Use SSL to secure connections between the Internet Agent and other SMTP hosts, POP/IMAP 
clients, and the Internet Agent Web console.

Control users’ access to SMTP/MIME (inbound and outbound), IMAP, and POP services.

Control logging for the Internet Agent.

Change the Internet Agent’s links to post offices.
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GroupWise Internet Agent Installation Worksheet
The following table lists the information you are prompted to provide as you complete the Internet 
Agent installation

Item Explanation

1) Software Platform

NetWare 

Linux

Windows

Select the type of server where you will install the Internet Agent.

For more information, see “Selecting the Internet Agent Platform” on page 82.

2) Installation Options

Path:

NetWare Options:

Update AUTOEXEC File

Configure Internet Agent for 
Clustering

Windows Options:

Install and Configure SNMP for 
GroupWise Agents

Install as Windows Service

Specify the server path where you want the Internet Agent files installed.

For more information, see “Selecting the Internet Agent Installation Directory” on 
page 82.

If you selected NetWare as the Internet Agent’s platform under item 1, you have the 
following NetWare options:

Update AUTOEXEC File: Select this option to add the Internet Agent startup 
command to the server’s autoexec.ncf file.

Configure Internet Agent for Clustering: Select this option if you are using 
Novell Cluster Services.

For more information, see “Clustering the NetWare Internet Agent” on page 84.

If you selected Windows as the Internet Agent’s platform under item 1, you have the 
following Windows options:

Install and Configure SNMP for GroupWise Agents: This option is available only 
if the SNMP service is enabled on the Windows server. Select this option to install 
the files required for SNMP monitoring of the Internet Agent.

Install as Windows Service: Select this option to install the Internet Agent as a 
Windows service rather than a Windows application.

For more information, see “Configuring the Windows Internet Agent” on page 84.

3) Web Console Information

Enable: Yes | No

Username:

Password:

HTTP Port: 9850 (default)

Specify whether or not you want to enable the Internet Agent’s Web console. The Web 
console allows you to monitor the operation of the agent through a Web browser.

For more information, see “Enabling the Internet Agent Web Console” on page 85.

4) Relay Host

Send Outbound Mail Directly to 
Internet Hosts

or

Send Outbound Mail through a 
Relay Host

IP address:

Mark how you want the Internet Agent to handle outbound messages from GroupWise 
users to Internet users.

For more information, see “Handling Outbound Mail” on page 83.
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5) GroupWise Domain

Domain Name:

Domain Directory:

Subdirectory:

eDirectory Context:

Specify the domain name and the domain directory where you want to create a 
subdirectory for the Internet Agent. If the domain directory is located on Linux, specify 
the eDirectory context of the Domain object.

On Linux, specify the eDirectory context of the Domain object.

For more information, see “Gathering Domain and Gateway Information” on page 83.

6) GroupWise Internet Agent Name Specify a name for the GroupWise Gateway object that will be created in eDirectory 
to represent the Internet Agent. 

For more information, see “Selecting the Gateway Object Name” on page 83.

7) Internet Mail Domain Name Specify the Internet domain name assigned to your GroupWise system.

For more information, see “Specifying the Internet Mail Domain Name for Your 
GroupWise System” on page 83.

8) LDAP Information

LDAP Server IP Address:

LDAP Server Port:

Username in LDAP Format:

Password:

SSL Certificate

This item applies to the Linux Internet Agent only.

List the IP address and port of an LDAP server in your system and the username and 
password that the Installation Advisor can use to log in to eDirectory to create the 
Internet Agent object. If you want to use an SSL connection, specify an SSL certificate 
file.

For more information, see “Gathering LDAP Information (Linux Only)” on page 86.

9) Windows Service Information

Use Local System Account

Allow Service to Interact with 
Desktop: Yes | No

Use this Windows User Account

Name:

Password:

Startup Type: Automatic | Manual | 
Disabled

This information applies only if you are installing the Internet Agent as a Windows 
service.

Indicate how you want the Internet Agent to access the domain directory specified 
under item 5. 

For more information, see “Configuring the Windows Internet Agent as a Service” on 
page 84.

Item Explanation
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5 Installing GroupWise WebAccess

Novell® GroupWise® WebAccess enables access to GroupWise mailboxes through computer 
Web browsers, WAP-enabled wireless telephones, Palm OS devices, and Windows CE devices. 
The following sections provide information to help you successfully install the GroupWise 
WebAccess (including GroupWise WebPublisher if desired) in your existing GroupWise system.

“GroupWise WebAccess Overview” on page 99

“WebAccess System Requirements” on page 103

“Planning GroupWise WebAccess” on page 104

“Setting Up GroupWise WebAccess” on page 112

“What’s Next” on page 128

“GroupWise WebAccess Installation Worksheet” on page 129

GroupWise WebAccess Overview
“GroupWise WebAccess Introduction” on page 99

“GroupWise WebAccess Components” on page 100

“One WebAccess Server vs. Two” on page 100

“WebAccess Security Requirements” on page 101

“Novell Cluster Services” on page 102

GroupWise WebAccess Introduction
GroupWise WebAccess, when used on a computer’s Web browser, provides most of the 
functionality available in the GroupWise client for Windows. For information about tasks that can 
be completed using GroupWise WebAccess, see the GroupWise WebAccess Help after 
installation. GroupWise WebAccess functionality on wireless devices or PDAs might be limited 
in comparison to the GroupWise client for Windows.

GroupWise WebAccess also includes GroupWise WebPublisher, an optional extension to 
GroupWise WebAccess. GroupWise WebPublisher lets GroupWise users publish documents from 
a GroupWise library to the Web. Web users can then view the published documents in their Web 
browsers.
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As shown above, GroupWise WebAccess requires users to have a mailbox in a GroupWise post 
office. GroupWise WebPublisher, on the other hand, is designed to provide public access to 
GroupWise library documents; users do not require a mailbox. 

After you’ve finished setting up GroupWise WebAccess, you should look at “What’s Next” on 
page 128 for additional information you might want to be aware of as you configure, maintain, and 
expand GroupWise WebAccess. 
NOTE: If you plan to install GroupWise WebAccess in a clustered server environment provided by Novell 
Cluster ServicesTM or Microsoft Clustering Services, see the GroupWise 6.5 Interoperability Guide (http://
www.novell.com/documentation/gw65) for additional information. 

GroupWise WebAccess Components
GroupWise WebAccess consists of three components: the WebAccess Application, the 
WebPublisher Application, and the WebAccess Agent. 

WebAccess Application: The WebAccess Application, which resides on the Web server, 
provides the WebAccess user interface. As users perform actions in WebAccess, the WebAccess 
Application passes information between the Web browser and the WebAccess Agent.

WebPublisher Application: The WebPublisher Application, which resides on the Web server, 
provides the WebPublisher user interface. As users perform actions in WebPublisher, the 
WebPublisher Application passes information between the Web browser and the WebAccess 
Agent.

WebAccess Agent: The WebAccess Agent receives user requests from the WebAccess 
Application and WebPublisher Application, accesses post offices and libraries to process the 
requests, and then passes information back to the applications.

The WebAccess Agent is required for both WebAccess and WebPublisher. The WebAccess 
Application must be installed to use WebAccess. Likewise, the WebPublisher Application must 
be installed to use WebPublisher.

One WebAccess Server vs. Two
The WebAccess Application and WebPublisher Application must be installed to a Linux, 
NetWare®, or Windows Web server. If desired, you can install the WebAccess Agent on the same 
server.
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Library

Documents

Browser
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No Login

WebAccess
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You can also install the WebAccess Agent on a different server, as shown below. The WebAccess 
Agent can be run on a Linux, NetWare, or Windows server.

Security, discussed in “WebAccess Security Requirements” on page 101, might also determine 
whether you run the WebAccess Agent on the same server as the Web server.

WebAccess Security Requirements
GroupWise WebAccess can be configured to support the level of security you have established for 
your Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use WebAccess on 
a secured intranet), you can install the WebAccess components to any servers that provide access 
for your users and meet the requirements (see “WebAccess System Requirements” on page 103). 

If you plan to use WebAccess to provide users with access to their mailboxes from anywhere on 
the Internet (rather than simply within a secured intranet), and you already have a firewall in place 
to provide security, you have the following options for configuring WebAccess:

Install all WebAccess components inside your firewall and use a proxy service. See 
“Configuration Using a Proxy Service” on page 101. This is the recommended configuration.

Install the WebAccess and WebPublisher Applications on a Web server outside your firewall 
and the WebAccess Agent on a server inside your firewall. See “Configuration Without a 
Proxy Service” on page 102.

Configuration Using a Proxy Service

If your firewall includes a proxy service, you can install the WebAccess Application and 
WebPublisher Application to a Web server inside your firewall, and the WebAccess Agent to 
another server inside the firewall, as shown in the following illustration.

If desired, the WebAccess Agent can also be installed to the Web server rather than a separate 
server, as discussed in “One WebAccess Server vs. Two” on page 100.
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Configuration Without a Proxy Service

If your firewall does not provide a proxy service, you need to install the WebAccess Application 
and WebPublisher Application to a Web server that is outside the firewall. Because the 
WebAccess Agent requires direct access (mapped path or UNC path) to a GroupWise domain 
directory, it needs to be installed to a server that is located within the firewall.

The firewall must allow inbound IP packets to be sent from the Web server to the IP address and 
port number of the WebAccess Agent (for example, 172.16.5.18:7205).

In addition, the firewall must allow outbound IP packets to be sent from the WebAccess Agent to 
the Web server. This requires all high ports (above 1023) to be open to outbound IP packets. 

Novell Cluster Services
Novell Cluster Services is a server clustering system that ensures high availability and 
manageability of critical network resources including volumes (where GroupWise domains and 
post offices reside) and applications (such as the GroupWise WebAccess Agent). Novell Cluster 
Services supports failover, failback, and migration of individually managed cluster resources. 

The NetWare WebAccess Agent can be configured to take advantage of the fault-tolerant 
environment provided by Novell Cluster Services if the following requirements are met:

The domains and post offices to be serviced by the NetWare WebAccess Agent have already 
been created on shared NSS volumes in the cluster.

The NetWare WebAccess Agent is being installed to a server that is part of the same cluster.

When the WebAccess Agent is configured for clustering, its startup file is configured with shared 
volume names rather than specific server names.

For more information, see “Novell Cluster Services” in the GroupWise 6.5 Interoperability Guide 
(http://www.novell.com/documentation/gw65).

WebAccess System Requirements
GroupWise 6.5 system: The GroupWise 6.5 WebAccess Agent can only access GroupWise 
6.5 post offices and libraries

32-bit/x86 processor

Any of the following server operating systems:

NetWare 4.2, 5.1, or 6.x

With NetWare 5.1 and 6.x, the WebAccess Agent can run on multi-processor servers and 
clustered servers.
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SUSE® Linux Standard Server 8, SUSE Linux Enterprise Server 8, SUSE Linux 
Enterprise Server 9, Red Hat Enterprise Linux 3 ES, or Red Hat Enterprise Linux AS

Windows NT Server, Windows 2000 server, or Windows 2003 Server, plus the latest 
Service Pack for your version of Windows

With Windows NT and 2000, the WebAccess Agent can run as either a Windows 
application or a Windows service.

Any of the following Web servers and Java* servlet engines:

NetWare 4.2/5.1 (latest Support Pack required): NetWare Enterprise Web Server with the 
Novell Servlet Gateway

NetWare 6.x: Enterprise Web Server or Apache Web Server, with the Tomcat 3.3 servlet 
engine

NetWare 6.5 with GroupWise 6.5 Support Pack 1 or later: Apache 2 Web Server with the 
Tomcat 4 servlet engine

Linux: Apache 2 with the Tomcat 4 servlet engine

The Apache 2 Web server, Java SDK, Tomcat 4 servlet engine, and Jakarta connector can 
be installed and configured on your Linux server when you install the WebAccess 
Application (and WebPublisher Application). If desired, you can use existing 
installations of these components instead.

Windows NT (latest Service Pack required): Microsoft Internet Information Server 4.0 or 
Netscape Enterprise Server 3.6 or later, either with the Novell Servlet Gateway

Windows 2000: Microsoft Internet Information Server 5 or later with the Novell Servlet 
Gateway

UNIX Solaris: Apache Web Server 1.3.3 or later with the Tomcat servlet engine 

For assistance with using WebAccess with an unlisted Web server, see “Unsupported 
Web Servers” in the GroupWise 6.5 Interoperability Guide.

Java Virtual Machine (JVM*) 1.4.2 or later

Keep in mind the following platform-specific details:

NetWare servers can run only one JVM. On NetWare, WebAccess requires JVM 1.3.1 or 
later. During installation, you might be prompted to replace your current version with the 
WebAccess version; you should only do so if the server’s current version is older than the 
WebAccess version.

Linux servers require J2SDK 1.4.2 and Jakarta Connector 1.2.3 in addition to the JVM. 
The JVM and the additional Java components can be installed when you install 
WebAccess on Linux, or you can integrate WebAccess into an existing Java installation.

Windows servers can run multiple JVMs at the same time. To ensure compatibility with 
WebAccess, you should install JVM 1.3.1 or higher. JVM 1.4.1 (Java 2 Runtime 
Environment, Standard Edition Version 1.4.1) is included with WebAccess. 

A JVM is not included for UNIX Solaris. You will need to separately install JVM 1.3.1 
or higher to your UNIX Web server. We recommend the newest version available.

Any of the following Web browsers:

Linux: Mozilla 1.4 or later and comparable Mozilla-based browsers

Windows: Microsoft Internet Explorer 4.0 or later; Netscape Navigator 4.0 or later
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Macintosh: Safari 1.0 or later; Microsoft Internet Explorer 4.5 or later; Netscape 
Navigator 4.51 or later

UNIX: Netscape 4.0 or later; Microsoft Internet Explorer 4.0 or later

Any of the following wireless devices:

Any wireless device that supports the Wireless Access Protocol (WAP) and has a 
microbrowser that uses Handheld Device Markup Language (HDML) 3.0 or later or 
Wireless Markup Language (WML) 1.1 or later

A Palm OS device with any Palm OS version that supports Web Clipping Applications 
(PQAs)

A Windows CE device with any Windows CE version

Planning GroupWise WebAccess
Before installing GroupWise WebAccess, you should complete the planning tasks listed below. 
The planning tasks help you gather information you will need as you install and set up GroupWise 
WebAccess. You can use the “GroupWise WebAccess Installation Worksheet” on page 129 to 
record your installation and setup information.

“Deciding Where to Install the GroupWise WebAccess Components” on page 104

“Determining the WebAccess Agent’s Configuration” on page 105

“Determining the WebAccess and WebPublisher Applications’ Configuration” on page 110

Deciding Where to Install the GroupWise WebAccess Components
After reviewing “GroupWise WebAccess Overview” on page 99 and the system requirements 
listed in “WebAccess System Requirements” on page 103, plan where you want to install the 
WebAccess components in your system.

After you’ve selected the servers where you will install the WebAccess components, you need to 
make sure they meet the requirements listed below.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 2: Server Platform and Installation Directory, specify the platform where you will install 
the WebAccess Agent, then specify the directory where you want to install the WebAccess Agent 
files. The default NetWare directory is sys:\system. The default Linux directory is /opt/novell/
groupwise/agents/bin. The default Windows directory is c:\webacc.

If you are installing the WebAccess Agent on a NetWare server that is using Novell Cluster Services, 
under Item 4: Clustering Support, select Yes. 

Under Item 13: Web Server Type and Root Directory, select the type of Web server where you will 
install the WebAccess Application and WebPublisher Application, then specify the Web server’s root 
directory. 

Under Item 17: Novell Root Directory, specify a directory on the Web server where you want to install 
the configuration files for the WebAccess Application and WebPublisher Application.

Under Item 18: Java Servlet Engine, if you are installing to a NetWare or Windows server, select 
whether you want to use the Novell Servlet Gateway, the Tomcat servlet engine, or another Java 
servlet engine. If you use the Tomcat servlet engine or another Java servlet engine, it must already 
be installed and you must specify the path to its root directory. (If you are installing to a Linux server, 
the Apache 2 Web server, Java SDK, Tomcat 4 servlet engine, and Jakarta connector are all installed 
and configured when you install the WebAccess Application and WebPublisher Application, so you 
do not need to make this selection.)
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Determining the WebAccess Agent’s Configuration
As you install the WebAccess Agent, you are prompted to supply the configuration information 
described in the following sections:

“Network Address” on page 105

“Gateway Directory Location and Name” on page 106

“Gateway Object Name” on page 106

“Domain and Post Office Access” on page 106

“Windows Options” on page 108

“Web Console” on page 108

“LDAP Information (Linux Only)” on page 109

“WebPublisher” on page 109

Network Address

The WebAccess Agent communicates with the WebAccess Application and WebPublisher 
Application (on the Web server) through TCP/IP.

Gateway Directory Location and Name

The WebAccess Agent requires a GroupWise gateway directory in which to store configuration 
information and work files. The gateway directory must be located under a GroupWise domain 
directory. The default directory name is WEBAC65A on NetWare and Windows, webacc65a on 
Linux. If you change the name on NetWare, use a maximum of 8 characters in the new name. If 
you change the name on Linux, use lowercase letters.

After you specify the domain directory location and a gateway directory name, the WebAccess 
Installation program creates the gateway directory under the domain\wpgate directory (for 
example, provo\wpgate\webac65a on NetWare and Windows, provo/wpgate/webacc65a on 
Linux).

Gateway Object Name

The WebAccess Agent also requires a GroupWise Gateway object in Novell eDirectory. This 
object stores the WebAccess Agent’s information and enables configuration of the agent through 
ConsoleOne®.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 3: Server Address, specify the IP address or DNS hostname of the WebAccess Agent’s 
server, then specify the port number for the agent to use. The default is 7205.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 5: Gateway Directory, specify the domain name and the full path to the domain directory 
where you want to create the gateway directory, then give the gateway directory a name.

If you are installing the Linux WebAccess Agent, record the eDirectoryTM context of the Domain object 
(for example, cn=provo3,ou=groupwise,o=corporate).
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The WebAccess Agent’s object is created below the Domain object. If you have multiple domains, 
the WebAccess Installation program uses the Domain object associated with the domain directory 
where you are creating the WebAccess Agent’s gateway directory.

Domain and Post Office Access

The WebAccess Agent requires access to the domain. It also requires access to each post office 
where mailboxes or libraries are located that WebAccess or WebPublisher users will access.

Domain: The WebAccess Agent needs direct access (mapped drive, UNC path, or file system 
mount) to the domain directory.

Post Offices: The WebAccess Agent needs direct access (mapped drive, UNC path, or file system 
mount) to the post office directory or client/server access (TCP/IP) to the post office’s POA. By 
default, the WebAccess Agent uses whatever access mode has been established for the post office 
(ConsoleOne > Post Office object > GroupWise tab > Post Office Settings page).

If you are using the NetWare or Linux versions of the WebAccess Agent, you need to ensure that 
an eDirectory user account exists that provides the required access to the domain and post office 
directories. For direct access to the domain directory or a post office directory, the WebAccess 
Agent needs Read, Write, Create, Erase, Modify, and File Scan rights.

If you are using the Windows version of the WebAccess Agent, you need to ensure that:

A Windows user account exists on the Windows server for the agent.

If the domain or any post office directories (directly accessed by the WebAccess Agent) are 
on Windows servers, the Windows user account provides Full Control access to those 
directories.

If the domain directory or any post office directories (directly accessed by the WebAccess 
Agent) are on NetWare servers, the WebAccess Agent has an eDirectory user account with 
the same username and password as the agent’s Windows user account. The eDirectory 
account must provide Read, Write, Create, Erase, Modify, and File Scan rights to the 
directories.

If the WebAccess Agent does require an eDirectory user account, the context of the account 
is defined in the bindery context of all NetWare servers that will be accessed.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 6: Gateway Object, specify the name you want to give the WebAccess Agent’s object. The 
default name is the same as the gateway directory name you chose for Item 5.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 7: eDirectory Authentication, specify the eDirectory username and password you want 
the WebAccess Agent to use to access the domain directory and post office directories. This 
applies to the NetWare WebAccess Agent only.

If you are using the Windows WebAccess Agent, ensure that the appropriate Windows and 
eDirectory user accounts exist.
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Windows Options

This section applies to the Windows version of the WebAccess Agent only.

The Windows WebAccess Agent can be configured to support SNMP. This enables the 
WebAccess Agent to be monitored and managed through an SNMP management program.

NOTE: The NetWare and Linux WebAccess Agents rely on operating system components for SNMP 
functionality and do not require this installation option.

The WebAccess Agent can also run as a Windows service rather than a standard Windows 
application. To do so, the WebAccess Agent service requires a user account. The requirements for 
the Windows service user account are the same as those listed for the Windows WebAccess Agent 
in “Domain and Post Office Access” on page 106. 

Web Console

The WebAccess Agent console enables you to monitor the WebAccess Agent from the server 
where it is running. If you want, you can enable the WebAccess Agent’s Web console. The Web 
console lets you view the WebAccess Agent’s statistical and diagnostic information through a 
Web browser, which is useful if want to see the WebAccess Agent’s activity without physically 
visiting the agent’s server.

You access the Web console by entering the WebAccess Agent’s network address and HTTP port 
number in a Web browser (for example, http://172.16.5.18:7211). If necessary, you can change the 
WebAccess Agent’s default HTTP port number (7211).

If you want to restrict access to the Web console, you can assign a username and password. This 
can be any username and password you want. By default, the username and password are passed 
through an unsecure connection between the Web browser and the WebAccess Agent. Therefore, 
we recommend that you do not use an existing eDirectory or Windows username and password 
unless you secure this connection using SSL. For information about securing the WebAccess 
Agent’s connections, see “WebAccess” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

If you want the WebAccess Agent to support SNMP, under Item 8: Execution Options, select the Install 
and Configure SNMP for WebAccess Agent option. 

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 8: Execution Options, select Run WebAccess Agent as a Windows Service.

Under Item 9: Windows Service User, enter the username and password for the service’s user 
account. 

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 10: Web Console, select Yes if you want to enable the Web console. If you want to restrict 
access to the Web console, enter a username and password. 
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LDAP Information (Linux Only)

If you are installing the Linux WebAccess Agent and WebAccess Application, the Installation 
Advisor needs to access eDirectory through LDAP. eDirectory access is required in order to create 
the WebAccess Agent and WebAccess Application objects. To obtain access, the Installation 
Advisor needs the IP address and port number of an LDAP server, along with a username and 
password to log in with. Because the Linux Installation Advisor uses LDAP to access eDirectory, 
you must provide the username in LDAP format. For example:

cn=admin,ou=users,o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a certificate file. For 
background information about SSL, see “Encryption and Certificates” in “Security” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65). If you do 
not want to use SSL, the LDAP server must be configured to accept clear text passwords.

WebPublisher

You can choose whether or not you want the WebAccess Agent to support GroupWise 
WebPublisher. If you enable WebPublisher support, you need to specify a GroupWise account 
(mailbox ID and password). The GroupWise account serves two purposes:

GroupWise users publish documents to WebPublisher users by sharing the documents with 
the GroupWise account.

When Web users access WebPublisher, the WebAccess Agent logs in to this GroupWise 
account. This lets the WebAccess Agent know which documents have been shared with 
WebPublisher users. It can then retrieve these documents (and only these documents) for the 
WebPublisher users.

We recommend that you create a new GroupWise account specifically for GroupWise 
WebPublisher. If you’ve already created an eDirectory account for the WebAccess Agent to use 
when accessing domain or post office directories (see “Domain and Post Office Access” on 
page 106), you might want to create the GroupWise account under that eDirectory user account.

If you enable GroupWise WebPublisher support, you need to select the libraries that you want to 
make public. The WebAccess Agent, acting on behalf of WebPublisher users, will only access 
documents in public libraries.

Making a library public does not automatically give WebPublisher users access to all documents 
in the library. For WebPublisher users to have access to a document in a public library, the 
document’s owner must have shared the document with the WebPublisher user account. 

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 11: LDAP Information, specify the IP address and port number of an LDAP server, a 
username in LDAP format, the password for the username, and if necessary, the full path to your SSL 
certificate file.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 12: WebPublisher Support, select Yes if you want to enable the WebAccess Agent to 
support WebPublisher, then enter the Mailbox ID and password for the GroupWise account you want 
the WebAccess Agent to use. 
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NOTE: When a WebPublisher user requests a library document in HTML format rather than its native format, 
the WebAccess Agent renders the document from its native format to HTML format. It also caches the HTML 
document to a directory on the agent’s local drive. This enables the WebAccess Agent to use the cached 
document for future requests. For NetWare, the cache directory is the sys:\system\cache directory. For Linux, 
the cache directory is /opt/novell/groupwise/webpublisher/cache. For Windows, the cache directory is the 
c:\webacc\cache directory. For information about changing the cache directory’s location, size, and refresh 
interval, see “WebAccess” in the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/
gw65).

Determining the WebAccess and WebPublisher Applications’ Configuration
As you install the WebAccess Application and/or the WebPublisher Application to a Web server, 
you are prompted to supply the configuration information described in the following sections:

“Web Clipping Application (PQA) URL (NetWare and Windows WebAccess)” on page 110

“Web Server Default Page” on page 111

“Default Language” on page 111

“eDirectory Objects and Configuration Files” on page 112
NOTE: You should have already selected the Web server where you will install the WebAccess Application 
and WebPublisher Application. If you have not, see “Deciding Where to Install the GroupWise WebAccess 
Components” on page 104.

Web Clipping Application (PQA) URL (NetWare and Windows WebAccess)

When installing to a NetWare or Windows server, the WebAccess Installation program creates a 
Web Clipping Application (PQA), also referred to as a Palm Query Application, to enable Palm 
OS device users to log in to GroupWise WebAccess. (The Web Clipping Application is not 
available on Linux.)

The Web Clipping Application, named groupwise.pqa, includes the URL required to connect to 
your GroupWise WebAccess installation, a Login page, an About Novell GroupWise page, and 
the images used when displaying GroupWise WebAccess on the Palm OS device.

You need to specify the URL you want used. For example:

http://groupwise.novell.com

The WebAccess Installation program automatically appends /servlet/webacc to the URL so that 
users are directed to the WebAccess login page. For example, using the URL above, the 
WebAccess Installation program would create the following URL in the groupwise.pqa file:

http://groupwise.novell.com/servlet/webacc

As you determine the URL, keep in mind the following:

If the Web server uses SSL, change http to https. 

If you are using a proxy server, enter the proxy server’s address.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 13: Libraries, list the libraries from which documents can be shared. The WebAccess 
Installation program will list all libraries in your GroupWise system. If you want, you can wait until then 
to select libraries.
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The web clipping proxy server (gateway) does not currently support challenge and response 
authentication. Therefore, ensure that the Web server is not configured to require basic 
challenge and response authentication, or at least is configured not to require this 
authentication for the URL defined in the groupwise.pqa file.

Web Server Default Page

When installing to a NetWare or Windows server, the WebAccess Installation program copies the 
Novell Web Services page to the Web Server’s root directory. This page includes links for 
GroupWise WebAccess and GroupWise WebPublisher (provided you are installing both). You 
can have this page replace the Web Server’s current default page, or you can retain your current 
page and create a link to the Novell Web Services page. This Web page is handled differently on 
Linux, so there is no need to replace an existing Web page on Linux.

The Novell Web Services page simply provides a link to the WebAccess login page and to the 
WebPublisher user interface. You or your users can bypass the Novell Web Services page and go 
directly to WebAccess or WebPublisher by using the following URLs:

NetWare/Windows: http://web_server_address/servlet/webacc
Linux: http://web_server_address/gw/webacc
NetWare/Windows: http://web_server_address/servlet/webpub
Linux: http://web_server_address/gw/webpub

where web_server_address is the IP address or DNS hostname of your Web server. If the Web 
server uses SSL, you’ll need to use https rather than http.

If you use the Novell Web Services page as the default, the Installation program renames the 
current default page to filename.001 (for example, default.001 or index.001). You should change 
the default Web server page only if the Web server is used solely for Novell products. As you 
install additional Novell products, such as GroupWise Monitor, the Novell Web Services page is 
updated to allow access to each product. On Linux, the Novell Web Services page is located in the 
gw directory, so the default page for your Web server does not need to be renamed.

If you retain your current default page, the Install program copies the Novell Web Services page 
(novell.htm) to the Web Server’s root directory. You need to add a link from your default page to 
the Novell Web Services page.

Default Language

The WebAccess Installation program installs all available languages. You need to specify which 
language should be used when displaying the Novell Web Services page. When users access the 
Novell Web Services page, they can use the default language for WebAccess or WebPublisher, or 
they can select another language.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 14: Web Clipping Application (PQA) URL, specify the URL you want included in the 
groupwise.pqa file.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 15: Web Server Default Page, select whether or not you want to use the Novell Web 
Services page as the Web server’s default page.
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eDirectory Objects and Configuration Files

WebAccess Application and WebPublisher Application configuration information is stored in two 
places: 1) eDirectory objects and 2) the webacc.cfg and webpub.cfg files, located by default in the 
Web server’s novell directory (worksheet item 16).

The WebAccess Application object and WebPublisher Application object allow you to easily 
modify configuration information in ConsoleOne. The eDirectory information is the master 
information; any changes made to the objects in eDirectory are also written to the configuration 
files.

In some installation scenarios, such as installing to a Web server outside a firewall or installing to 
a UNIX Web server, you might not have access to eDirectory, which means the WebAccess 
Installation program cannot create the objects. It can, however, still create the configuration files 
on the Web server. In this case, to change the application’s configuration, you need to manually 
modify the webacc.cfg and webpub.cfg files. 

You need to select the eDirectory container where you want the objects created. They are all 
created in the same container. The default container is the Domain object, which means the objects 
are created beneath the Domain object (similar to GroupWise MTA and Gateway objects).
NOTE: Each application also has several providers associated with it. For example, the WebAccess 
Application has a GroupWise Provider and an LDAP Provider. The GroupWise Provider is the component that 
actually communicates with the WebAccess Agent to request information for users. The LDAP Provider 
communicates with LDAP servers to enable users to search LDAP address books. Provider objects are 
created in the same location as the application objects.

Setting Up GroupWise WebAccess
“Setting Up GroupWise WebAccess on NetWare or Windows” on page 112

“Setting Up GroupWise WebAccess on Linux” on page 118

Setting Up GroupWise WebAccess on NetWare or Windows
Complete the following tasks to set up GroupWise WebAccess and WebPublisher: 

“Installing the WebAccess Agent” on page 113

“Installing the WebAccess Application and WebPublisher Application” on page 114

“Starting GroupWise WebAccess” on page 117

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 18: Default Language, specify the language for the Novell Web Services page.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 19: eDirectory Object Configuration, specify the tree where you want the objects created, 
then specify the context. If you will be installing from a location where you don’t have access to 
eDirectory, you can skip this item.
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Installing the WebAccess Agent

The following steps provide instructions for installing the WebAccess Agent. For information 
about installing the WebAccess and WebPublisher Applications to a Web server, see “Installing 
the WebAccess Application and WebPublisher Application” on page 114.

1 Make sure you install from the appropriate Windows workstation/server:

If you are installing to a NetWare server, you can run the WebAccess Installation 
program on any Windows workstation.

If you are installing to a Windows server, you must run the WebAccess Installation 
program on that server.

2 Make sure the Windows workstation/server from which you will perform the installation has 
the Novell ClientTM installed.

The WebAccess Installation program creates GroupWise objects in eDirectory. The Novell 
Client is required to access eDirectory. If necessary, you can download the Novell Client from 
the Novell Product Downloads site (http://download.novell.com).

3 Make sure you have the file system and eDirectory access required to install the WebAccess 
Agent:

You need full file system rights to the GroupWise domain directory where the 
WebAccess Installation program will create the WebAccess Agent’s gateway directory. 
See Item 5: Gateway Directory in the “GroupWise WebAccess Installation Worksheet” 
on page 129.

You need full file system rights to the server where the WebAccess Installation program 
will install the WebAccess Agent. If you are installing to a Windows server, you must run 
the WebAccess Installation program on that server. See Item 2: Server Platform and 
Installation Directory in the “GroupWise WebAccess Installation Worksheet” on 
page 129.

The WebAccess Installation program creates the WebAccess Agent object below the 
GroupWise Domain object in eDirectory. For it to do so, you must have Admin rights (or 
Admin equivalent rights) to the eDirectory container where the GroupWise Domain 
object resides.

4 Shut down any other GroupWise agents (MTA, POA, or Internet Agent) running on the 
server. 

This allows the WebAccess Installation program to properly install the agents’ common files 
(also referred to as the agent engine files). The WebAccess Installation program will attempt 
to shut down the GroupWise agents on a NetWare server. We recommend, however, that you 
shut down these agents yourself before starting the installation.

5 Insert the GroupWise 6.5 Administrator CD into the CD drive to start the WebAccess 
Installation program, click Install Products, click GroupWise WebAccess, then click Install 
GroupWise WebAccess. If the Installation program does not start automatically, run setup.exe 
from the root of the CD.

or

If you’ve already copied the GroupWise WebAccess software to a software distribution 
directory, run internet\webacces\setup.exe.

6 Click Yes to accept the license agreement and display the GroupWise WebAccess: 
Components dialog box.
106   GroupWise 6.5 Installation Guide

http://download.novell.com


    Novell Confidential                                                                                            Manual (99a)  21 December 2004
7 Select GroupWise WebAccess Agent. Deselect the GroupWise WebAccess Application and 
GroupWise WebPublisher Application options.
NOTE: You can also install the WebAccess Application and WebPublisher Application to your Web 
server at this time provided that 1) you have the appropriate Web server file system access and 
eDirectory access (see “Installing the WebAccess Application and WebPublisher Application” on 
page 114) and 2) you are running the WebAccess Installation program on that Web server, if it is a 
Windows Web server and you are installing the Novell Servlet Gateway.

8 Click Next, then follow the installation prompts, using the information you recorded on the 
“GroupWise WebAccess Installation Worksheet” on page 129.

9 Continue with Installing the WebAccess Application and WebPublisher Application.

Installing the WebAccess Application and WebPublisher Application

The following steps provide instructions for installing the WebAccess Application and 
WebPublisher Application. For information about installing the WebAccess Agent, see “Installing 
the WebAccess Agent” on page 113.

1 Make sure you install from the appropriate Windows workstation/server:

If you are installing to a NetWare Web server, you can run the WebAccess Installation 
program on any Windows workstation.

If you are installing to a Windows Web server, you must run the WebAccess Installation 
program on that server.

2 Make sure the Windows workstation/server from which you will perform the installation has 
the Novell Client installed.

The WebAccess Installation program creates GroupWise objects in eDirectory. The Novell 
Client is required to access eDirectory. If necessary, you can download the Novell Client from 
the Novell Product Downloads site (http://download.novell.com).

3 Make sure you have the file system and eDirectory access required to install the WebAccess 
Application and the WebPublisher Application:

You need full file system rights to the GroupWise domain directory. See Item 5: Gateway 
Directory in the “GroupWise WebAccess Installation Worksheet” on page 129.

You need full file system rights to the Web server. If your Web server is on a UNIX 
server, the WebAccess Installation program copies tar files to a location you specify; this 
can be the UNIX server if you have access to it from the Windows workstation where you 
are performing the installation, or another location from which you can then copy the tar 
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files to the UNIX server. See Item 13: Web Server Type and Root Directory in the 
“GroupWise WebAccess Installation Worksheet” on page 129.

The WebAccess Installation program creates the WebAccess Application and 
WebPublisher Application objects (and their associated provider objects) in a container 
you specify (worksheet item 19). Make sure you have Admin rights (or Admin-
equivalent rights) to the container. The default container is the GroupWise Domain 
object.

4 Shut down the JVM and the Web server.

When installing the WebAccess Application and WebPublisher Application to a NetWare or 
Windows Web server, the WebAccess Installation program will attempt to shut down the Web 
server and the JVM. We recommend, however, that you manually shut down the Web server 
and the JVM yourself before starting the installation.

5 Insert the GroupWise 6.5 Administrator CD into the CD drive to start the WebAccess 
Installation program, click Install Products, click GroupWise WebAccess, then click Install 
GroupWise WebAccess. If the Installation program does not start automatically, run setup.exe 
from the root of the CD.

or

If you’ve already copied the GroupWise WebAccess software to a software distribution 
directory, run setup.exe from the internet\webacces directory.

6 Click Yes to accept the license agreement and display the GroupWise WebAccess: 
Components dialog box.

7 Select GroupWise WebAccess Application and GroupWise WebPublisher Application (if 
you plan to use WebPublisher). Deselect the GroupWise WebAccess Agent option.

8 Click Next, then follow the installation prompts, using the information you recorded on the 
“GroupWise WebAccess Installation Worksheet” on page 129.

9 After installation is complete, you might need to do the following:

If you kept your Web server’s default home page, create a link from your home page to 
the Novell Web Services page (novell.htm file) in the document root directory. 

If you chose to use an existing Java servlet engine rather than installing the Novell Servlet 
Gateway, modify the Java servlet engine’s servlet properties files to include the settings 
shown in the sample WebAccess servlet.properties file. This sample file is located in the 
internet\webacces\other directory on the CD.
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If you chose to use an existing JVM on Windows rather than update to the one included 
with GroupWise WebAccess, edit the servletgateway.properties file and change the 
java.base setting to point to the existing JVM (for example, c:\jdk1.1.8). The 
servletgateway.properties file is located the novell\java\servlets directory.

If you are installing to an Apache Web server on UNIX Solaris, continue with 
“Completing the Installation on a UNIX Apache Web Server” on page 116.

Completing the Installation on a UNIX Apache Web Server

The WebAccess Installation program copies the following files to the location you specified: 
webaccess.tar, webaccessdocs.tar, webaccessjars.tar, webaccessservlets.tar, index.html, 
servlets.properties, and commgr.cfg. It also creates a palm subdirectory for the Palm Query 
Application (PQA) file it creates.

To complete the installation and configuration process:

1 Using the tar -xvf command, extract the following tar files to the specified locations: 

webaccess.tar: Extract to the root of the UNIX server. A /novell directory is created for 
the files.

webaccessdocs.tar: Extract to the Apache document root directory (for example, /usr/
local/apache/htdocs).

webaccessservlets.tar: Extract to the Tomcat ROOT/WEB-INF/classes directory (for 
example, /usr/local/tomcat/webapps/ROOT/WEB-INF/classes).

webaccessjars.tar: Extract to the Tomcat ROOT/WEB-INF/lib directory (for example, 
/usr/local/tomcat/webapps/ROOT/WEB-INF/lib).

2 Modify the Tomcat web.xml file to include the following information. The web.xml file is in 
the Tomcat ROOT/WEB-INF directory.

<web-app>

<servlet>
<servlet-name>webacc</servlet-name>
<servlet-class>com.novell.webaccess.WebAccessServlet</servlet-class>
<init-param>
<param-name>Config</param-name>
<param-value>/novell/webaccess/webacc.cfg</param-value>
</init-param>
<load-on-startup> </load-on-startup>
</servlet>

<servlet>
<servlet-name>spellchk</servlet-name>
<servlet-class>com.novell.collexion.spell.servlet.SpellServlet</servlet-
class>
<init-param>
<param-name>Config</param-name>
<param-value>/novell/webaccess/spellchk.cfg</param-value>
</init-param>
<load-on-startup> </load-on-startup>
</servlet>

<servlet>
<servlet-name>webpub</servlet-name>
<servlet-class>com.novell.webpublisher.WebPublisherServlet</servlet-
class>
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<init-param>
<param-name>Config</param-name>
<param-value>/novell/webpublisher/webpub.cfg</param-value>
</init-param>
<load-on-startup> </load-on-startup>
</servlet>

</web-app>

NOTE: If you will not use WebPublisher, do not include the webpub servlet definition.

3 Modify the webacc.cfg and webpub.cfg files, located in the /novell/webaccess and /novell/
webpublisher directories at the root of the UNIX server, to change the Templates.path setting 
to point to the templates.

For example, change the following line in webacc.cfg:

Templates.path=/java/servlets/com/novell/webaccess/templates

to

Templates.path=/usr/local/tomcat/webapps/ROOT/WEB-INF/classes/com/
novell/webaccess/templates

4 Copy the commgr.cfg file to the /novell/webaccess directory. If you installed GroupWise 
WebPublisher, you also need to copy the file to the /novell/webpublisher directory.

5 In the webacc.cfg file, verify that the paths for the following settings point to valid directories. 
Typically, these directories reside in the /novell/webaccess directory, but you can relocate 
them if desired. Refer to the comments in the webacc.cfg file for explanations of each of these 
settings.

Log.path=/novell/webaccess/logs
Security.Timeout.path=/novell/webaccess/users
File.Upload.path=/novell/webaccess/temp

Verify that the paths for the following settings are correct.

Provider.GWAP.Config.file=/novell/webaccess/commgr.cfg
Provider.LDAP.Config.file=/novell/webaccess/ldap.cfg

6 In the webpub.cfg file, verify that the paths for the following settings point to valid directories. 
Typically, these directories are reside in the /novell/webpublisher directory, but you can 
relocate them if desired. Refer to the comments in the webpub.cfg file for explanations of each 
of these settings.

Log.path=/novell/webpublisher/logs
File.Upload.path=/novell/webpublisher/temp

Verify that the path for the following setting is correct.

Provider.GWDOC.Config.file=/novell/webpublisher/commgr.cfg

7 Copy the index.html file to the Apache document root directory (for example, /usr/local/
apache/htdocs). You can replace your Web server’s current default home page with this file, 
or you can rename the file and link to it from your current default home page.

Starting GroupWise WebAccess

If you did not have the WebAccess Installation program start the WebAccess components, 
complete the following steps:
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1 Restart the JVM, Java servlet engine, and Web server. This loads the WebAccess Application 
(and WebPublisher Application if you installed it).

2 To start the WebAccess Agent on a NetWare server, enter strtweb.ncf at the system 
console.

or

To start the WebAccess Agent as an application on a Windows server, click the Start menu > 
Programs > Novell GroupWise WebAccess > GroupWise WebAccess.

or

To start the WebAccess Agent as a service on a Windows server, open the Services window 
(from the Control Panel or the Administrative Tools window), right-click the WebAccess 
service, then click Start. 

If you need to stop the NetWare WebAccess Agent, press F7-Exit at the WebAccess agent 
console or enter stopweb and the NetWare server console. 

If you need to stop the Windows WebAccess Agent and it is running as an application in its 
own window, close the window. If it is running as a Windows service, open the Services 
window, right-click the WebAccess service, then click Stop.

3 If you shut down other GroupWise agents to install the WebAccess Agent, make sure you start 
the agents again.

Setting Up GroupWise WebAccess on Linux
Complete the following tasks to set up GroupWise WebAccess and WebPublisher. These tasks are 
designed to help you get Linux WebAccess up and running as quickly as possible and to help you 
manage the WebAccess Agent in the future. 

“Installing the Linux WebAccess Agent” on page 118

“Configuring the Linux WebAccess Agent” on page 119

“Installing and Configuring the WebAccess Application and WebPublisher Application” on 
page 120

“Starting the Web Server” on page 121

“Starting the Linux WebAccess Agent for the First Time” on page 121

“Monitoring the Linux WebAccess Agent from Your Web Browser” on page 122

“Starting the Linux WebAccess Agent on System Startup” on page 123

“Stopping the Linux WebAccess Agent” on page 123

“Configuring WebPublisher on Linux” on page 125

Installing the Linux WebAccess Agent

1 Make sure you have set up a basic GroupWise test system, described in Chapter 3, “Installing 
a Basic GroupWise System,” on page 23.

2 Make sure that LDAP is running on your eDirectory server and that it is configured to accept 
login from the WebAccess Agent Installation program (worksheet item 11)

The Installation Advisor requires eDirectory access in order to create the WebAccess Agent 
object in eDirectory. The Installation Advisor uses LDAP to gain the required access.
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3 Open a new terminal window, then enter the following command:

xhost + localhost

If you cannot execute this command because the X Window System is not running on the 
Linux server, see “Installing the GroupWise Agents Using the Text-Based Installation 
Advisor” on page 167. Similar steps can be used to install the WebAccess Agent without 
needing the X Window System.

4 In the same window, become root by entering su and the root password.

5 Change to the root of the GroupWise 6.5 for Linux Administrator CD.

6 Enter ./install.

7 Select the language in which you want to run the Installation Advisor and install the 
WebAccess software, then click Next.

8 In the Installation Advisor, click Install Products > GroupWise WebAccess > Install 
WebAccess Agent.

The WebAccess Agent software is installed to the bin and lib subdirectories of /opt/novell/
groupwise/agents.

9 When the installation is complete, click OK.

10 Continue with Configuring the Linux WebAccess Agent.

Configuring the Linux WebAccess Agent

1 After the WebAccess Agent files have been installed, click Configure WebAccess Agent.

The WebAccess Agent installation and configuration steps are separate so that you can install 
updated agent software without needing to repeat the agent configuration steps.

2 Review the Introduction, then click Next.

3 Accept the License Agreement, then click Next.

4 Specify the IP address or DNS hostname of the Linux server where you are installing the 
WebAccess Agent (worksheet item 3), then click Next.

The default port number of 7205 is typically acceptable, unless another program is already 
using that port.

5 Browse to and select the domain directory for the domain where you are installing the 
WebAccess Agent (worksheet item 5), then click Next.
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The default WebAccess Agent subdirectory (webac65a) is typically acceptable. It is created 
as a subdirectory of the domain/wpgate directory.

6 Fill in the LDAP information (worksheet item 11), then click Next.

7 Fill in the domain and agent information (worksheet item 6), then click Next.

On the Configuration Complete page, Launch WebAccess Agent on System Startup is 
selected by default. 

8 If you do not want the WebAccess Agent to start automatically when the server restarts, 
deselect Launch WebAccess Agent on System Startup.

9 Click Exit to complete the configuration.

10 Continue with Installing and Configuring the WebAccess Application and WebPublisher 
Application.

Installing and Configuring the WebAccess Application and WebPublisher Application

1 After installing and configuring the WebAccess Agent, click Install GroupWise WebAccess 
Application with Apache and Tomcat.

This installs a version of Apache and Tomcat specifically for use with GroupWise. Apache 
files are installed under /var/opt/novell/http and /etc/opt/novell/http. Tomcat files are installed 
under /var/opt/novell/tomcat4 and /etc/opt/novell/tomcat4.

In addition, a self-signed certificate is generated, enabling users to use WebAccess and 
WebPublisher using an SSL connection.

or

If you want to use an existing Apache and Tomcat installations, click Install GroupWise 
WebAccess Application.

2 When the installation is complete, click OK.

3 Click Configure WebAccess Application.

4 Review the Introduction, then click Next.

5 Accept the License Agreement, then click Next.

6 Browse to and select the WebAccess subdirectory (typically webac65a) under domain/wpgate 
(worksheet item 5).

7 Click Next to accept the default Apache and Tomcat locations that were established in Step 1.
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or

Specify the locations of Apache and Tomcat installations on your system, then click Next.

8 Fill in the LDAP information (worksheet item 11), then click Next.

9 Browse to and select the eDirectory context where you want the WebAccess Application 
objects to be created. (worksheet item 19), then click Next.

The GroupWise WebAccess objects are GroupWiseWebAccess, GroupWiseProvider, 
LDAPProvider, and NovellSpeller.

10 On the Configuration Complete page, click Exit to complete the configuration.

11 Continue with Starting the Web Server.

Starting the Web Server

If you installed Apache and Tomcat along with the WebAccess Application, follow the 
instructions below to start the Web server. If you did not install Apache and Tomcat along with 
the WebAccess Application, restart Apache and Tomcat on your system.

1 Make sure you are logged in as root.

2 If you have other instances of Apache and Tomcat running on this server, bring them down 
before you start the new versions you just installed.

3 Change to the /etc/init.d directory.

4 Start Tomcat.

./novell-tomcat4 start

5 Wait until Tomcat is all the way up.

6 Start Apache.

./novell-httpd start

7 Continue with Starting the Linux WebAccess Agent for the First Time.

Starting the Linux WebAccess Agent for the First Time

You can choose to start the WebAccess Agent with or without a user interface.

“Starting the Linux WebAccess Agent with a User Interface” on page 121

“Starting the Linux WebAccess Agent as a Daemon” on page 122

Starting the Linux WebAccess Agent with a User Interface

1 Make sure you are logged in as root.

2 Make sure that the MTA for the domain is running.

3 Change to the /opt/novell/groupwise/agents/bin directory.

4 To start the WebAccess Agent, enter the following command:

./gwinter --show --home domain_directory/wpgate/webac65a &

The WebAccess Agent --show switch does not display an agent console interface like the 
other GroupWise agents. Instead, WebAccess configuration and status information displays 
in the terminal window where you start the WebAccess Agent.
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The --home startup switch specifies the domain directory and is required to start the 
WebAccess Agent.

The ampersand (&) causes the WebAccess Agent to run in the background, so that the 
terminal window you started it in is again available for use.

Status messages for the WebAccess Agent are written to the WebAccess Agent log file 
(mmddlog.nnn) in the /var/log/novell/groupwise/domain.webac65a directory. The log file 
name includes the month and day when it was created, along with an incrementing extension 
to accommodate multiple log files on the same day.

5 Skip to “Monitoring the Linux WebAccess Agent from Your Web Browser” on page 122.

Starting the Linux WebAccess Agent as a Daemon

1 Make sure you are logged in as root.

2 Make sure that the MTA for the domain is running. 

3 Change to the /etc/init.d directory.

4 To start the WebAccess Agent, enter the following command:

./grpwise-wa start

5 To confirm that the WebAccess Agent has started, enter the following command:

ps -eaf | grep gwinter

This lists all of the WebAccess Agent process IDs.

6 Continue with Monitoring the Linux WebAccess Agent from Your Web Browser.

Monitoring the Linux WebAccess Agent from Your Web Browser

Before you can monitor the Linux WebAccess Agent from your Web browser, you must configure 
its HTTP port and, if desired, provide a username and password to prevent unauthorized access.

1 In ConsoleOne, right-click the WebAccess Agent object, then click Properties.

2 Click GroupWise > Network Address to display the Network Address page.

3 In the HTTP Port field, enter a port number. We recommend that you use port 7211 if it is not 
already in use on the WebAccess Agent’s server.
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By default, any user who knows the WebAccess Agent’s IP address (or hostname) and the 
HTTP port number can use the Web console. If you want to restrict Web console access, you 
can assign a username and password.

4 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings 
page.

5 In the HTTP User Name field, enter an arbitrary username (for example, webacc).

6 Click Set Password to assign a password (for example, monitor).

7 Click OK to save your changes.

8 To monitor the WebAccess Agent from your Web browser, view the WebAccess Agent Web 
console by supplying the IP address and port number of the WebAccess Agent. For example:

http://172.16.5.18:7211

Starting the Linux WebAccess Agent on System Startup

If you selected Launch WebAccess Agent on System Startup in the WebAccess Agent Installation 
program, the WebAccess Installation program configured your system so that the WebAccess 
Agent would start automatically each time you restart your server. The WebAccess Installation 
program always creates a grpwise-wa startup script in /etc/init.d for starting the WebAccess Agent. 
To enable automatic startup, the WebAccess Installation program also creates symbolic links 
named S99grpwise-wa in the rc3.d and rc5.d directories so that the WebAccess Agent can load on 
startup into runlevel 3 or 5, depending on the configuration of your Linux system.

When the grpwise-wa script runs and starts the WebAccess Agent, it reads the WebAccess Agent 
configuration file (webaccess_agent_object.cfg) in /opt/novell/groupwise/agents/share to check 
for configuration information provided by startup switches. Because the WebAccess Agent does 
not have a user interface like the MTA, POA, and Internet Agent, the --show switch can be used 
in the configuration file. However, the information is directed to standard output, which might not 
be readily available to you.

Stopping the Linux WebAccess Agent

When you start the WebAccess agent with the grpwise.wa script, you can also use the script to stop 
it.

1 Make sure you are logged in as root.

2 Change to the /etc/init.d directory.

3 To stop the WebAccess Agent, enter the following command:

./grpwise-wa stop
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4 To confirm that the WebAccess Agent has stopped, enter the following command:

ps -eaf | grep gwinter

The only gwinter process ID you should see listed is the one for the grep command.

When you start the WebAccess Agent manually (without using the grpwise-wa script), use the 
standard Linux kill command to stop it.

1 Make sure you are logged in as root.

2 Determine the process ID (PID) of the WebAccess Agent:

ps -eaf | grep gwinter

The PIDs for all gwinter processes are listed.

3 Kill the first gwinter process in the list:

Syntax:
kill PID

Example:
kill 1483

It might take a few seconds for all gwinter processes to terminate.

4 Repeat the ps command to verify that the WebAccess Agent has stopped.

Configuring WebPublisher on Linux

After installing and configuring WebAccess, as described in “Setting Up GroupWise WebAccess 
on Linux” on page 118, if you want to enable WebPublisher as well, you must perform some 
manual configuration.

1 In ConsoleOne, connect to the domain where the WebAccess Agent object was created during 
installation.

2 In a convenient context, create a new user specifically for use with WebPublisher.

3 Add the new user to a post office and provide a GroupWise password for the WebPublisher 
user.

4 Browse to and right-click the WebAccess Agent object (by default, WEBAC65A), then click 
Properties > WebPublisher.
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5 In the GroupWise Mailbox ID field, specify the WebPublisher user you created in Step 2 
above.

6 Click Add, then select the library for WebPublisher to access for documents.

7 Select Assign General User Access to WebPublisher Users.

8 In the Disk Cache Path field, specify /opt/novell/groupwise/webpublisher/cache.

9 Click OK to save the WebPublisher configuration information.

10 Restart your Web server, as described in “Starting the Web Server” on page 121

11 Restart the WebAccess Agent, as described in “Starting the Linux WebAccess Agent for the 
First Time” on page 121.

In order the add documents to the library so that they can be viewed on the Internet, WebPublisher 
user must use the GroupWise Windows client. See “Publishing Documents to the Web with 
WebPublisher” in “Creating and Working with Documents” in the GroupWise 6.5 Windows Client 
User Guide (http://www.novell.com/documentation/gw65). This functionality is not currently 
available in the GroupWise Cross-Platform client.

Testing GroupWise WebAccess and WebPublisher
To test GroupWise WebAccess and WebPublisher, complete the steps in the following sections:

“Testing WebAccess on a Workstation” on page 126

“Testing WebAccess on a Wireless Device” on page 127

“Testing WebAccess on a Palm OS Device (NetWare and Windows WebAccess)” on 
page 127

“Testing GroupWise WebPublisher” on page 128

Testing WebAccess on a Workstation

1 To access the WebAccess client when the WebAccess Agent is running on NetWare or 
Windows, in a Web browser, enter the IP address or hostname of the Web server.

http://web_server_address
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or

To access the WebAccess client when the WebAccess Agent is running on Linux, in a Web 
browser, enter the IP address or hostname of the Web server plus the directory where the 
Novell Web Services page is located:.

http://web_server_address/gw

2 On NetWare and Windows, if the Novell Web Services page is not the Web server’s default 
page, click the link you created to the page.

3 Select a GroupWise WebAccess language, then click Go to display the Login page.

You can bypass the Novell Web Services page to go directly to the Login page by using the 
following URL:

NetWare/Windows: http://web_server_address/servlet/webacc
Linux: http://web_server_address/gw/webacc

where web_server_address is the IP address or DNS hostname of your Web server. If the Web 
server uses SSL, you’ll need to use https rather than http.

4 Type your GroupWise user ID or GroupWise full name in the Name box and your GroupWise 
mailbox password in the Password box.

5 Click Login to display the GroupWise WebAccess main window.

6 Click Help for more information about using GroupWise WebAccess.

Testing WebAccess on a Wireless Device

1 Enter the following URL:

NetWare/Windows: http://web_server_address/servlet/webacc
Linux: http://web_server_address/gw/webacc

where web_server_address is the IP address or DNS hostname of your Web server. If the Web 
server uses SSL, you’ll need to use https rather than http.

Follow the instructions in your wireless device’s documentation to add this URL to your 
Favorites or Bookmarks so you don’t need to type the URL every time you log in.

2 Enter your GroupWise user ID and GroupWise mailbox ID.

Testing WebAccess on a Palm OS Device (NetWare and Windows WebAccess)

1 Add the GroupWise Web Clipping Application (groupwise.pqa) to your Palm OS device. The 
groupwise.pqa file is located in the Web server’s 
doc_root_directory\com\novell\webacces\palm\en directory.

The GroupWise Web Clipping Application is not created by Linux WebAccess.

2 Open the GroupWise Application. To do so, tap the Applications icon, tap the pick-list in the 
upper-right corner of the screen, select Palm.Net, then tap GroupWise.

3 Enter your GroupWise user ID and password, then log in.

Testing GroupWise WebPublisher

GroupWise WebPublisher only supports access through a Web browser on a computer. Wireless 
devices are not supported.
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1 To use WebPublisher when the WebAccess Agent is running on NetWare or Windows, in a 
Web browser, enter the IP address or hostname of the Web server.

http://web_server_address

or

To use WebPublisher when the WebAccess Agent is running Linux, in a Web browser, enter 
the IP address of hostname of the Web server plus the directory where the Novell Web 
Services page is located.

2 On NetWare and Windows, if the Novell Web Services page is not the Web server’s default 
page, click the link you created to the page.

3 Select a GroupWise WebPublisher language, then click Go to display GroupWise 
WebPublisher.

You can bypass the Novell Web Services page to go directly to WebPublisher by using the 
following URL:

Linux: http://web_server_address/gw/webpub
NetWare and Windows: http://web_server_address/servlet/webpub

where web_server_address is the IP address or DNS hostname of your Web server. If the Web 
server uses SSL, you’ll need to use https rather than http.

4 To search for a specific document, enter the search words, then click Search.

or

To browse the documents in a library, click Document Browse, then click the library you want 
to browse. When you browse a library, the first 10 documents are listed. You can list 
additional documents if desired.

5 Click Help for more information about using GroupWise WebPublisher.

What’s Next
The “WebAccess” section of the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65) provides information to help you further configure and maintain 
GroupWise WebAccess, including how to:

Scale GroupWise WebAccess to meet the needs of your users and environment.

Control users’ access to GroupWise WebAccess.

Secure connections via SSL.

Modify the WebAccess Agent’s configuration information, including the number of threads 
allocated for request processing.

Control logging for the WebAccess Agent, WebAccess Application, and WebPublisher 
Application.

Change the WebAccess Agent’s links to post offices.

Modify configuration information for the WebAccess Application and WebPublisher 
Application.

Monitor the WebAccess Application through a Web console.

Create new Palm Query Application (PQA) files for Palm OS devices.
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GroupWise WebAccess Installation Worksheet
The following table lists the information you are prompted to provide as you complete the 
WebAccess installation. The table is divided into three sections:

“WebAccess Agent and WebAccess/WebPublisher Applications” on page 129 lists 
information you need to provide when you are installing the WebAccess Agent or the 
WebAccess/WebPublisher Applications. 

“WebAccess Agent” on page 129 lists information you need to provide when installing the 
WebAccess Agent.

“WebAccess/WebPublisher Applications” on page 132 lists information you need to provide 
when installing the WebAccess Application and/or the WebPublisher Application.

WebAccess Agent and WebAccess/WebPublisher Applications

WebAccess Agent

Item Explanation

1) Components to Install

WebAccess Agent

WebAccess 
Application

WebPublisher 
Application

Select the components you want to install. 

For details, see “GroupWise WebAccess Components” on page 100.

Item Explanation

2) Server Platform and 
Installation Directory

Platform: NetWare, 
Linux, or Windows

Installation directory:

Specify the type of network server (NetWare, Linux, or Windows) where you will install the 
WebAccess Agent.

Specify the directory where you will install the WebAccess Agent. The default Linux directory is /
opt/novell/groupwise/agents/bin. The default NetWare directory is sys:\system. The default 
Windows directory is c:\webacc. The directory path you specify must be from the perspective of the 
installation workstation.

For details, see “Deciding Where to Install the GroupWise WebAccess Components” on page 104.

3) Server Address

IP address:

DNS hostname:

Port number:
(default = 7205))

Specify the IP address or DNS hostname of the network server where you will install the 
WebAccess Agent. The WebAccess Installation program will attempt to discover this information 
from the server, but you should be prepared to supply it in case the attempt fails.

If port 7205 is already in use, specify a different port.

For details, see “Network Address” on page 105.
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4) Clustering Support

Enable: Yes | No

This item applies to the NetWare WebAccess Agent only.

Select Yes if you want to configure the WebAccess Agent for clustering.

For details, see “Novell Cluster Services” on page 102.

5) Gateway Directory

Domain name:

Domain directory 
path:

Gateway directory 
name: 
(default=WEBAC65A 
or webacc65a)

eDirectory context:

Specify the domain name and the path to the domain directory you want to associate with the 
WebAccess Agent. The WebAccess Agent stores configuration information and work files in the 
directory. 

Specify the name of the gateway directory you want created for the WebAccess Agent. This 
directory is created in the domain\wpgate or domain/wpgate directory.

On Linux, specify the eDirectory context of the Domain object.

For details, see “Gateway Directory Location and Name” on page 106.

6) Gateway Object

Name: 
(default=WEBAC65A 
or webacc65a)

Specify a name for the GroupWise Gateway object that will be created in eDirectory to represent 
the WebAccess Agent. The default name is the same as the gateway directory.

For details, see “Gateway Object Name” on page 106.

7) eDirectory 
Authentication

Username:

Password:

This item applies if you are installing the NetWare or Linux versions of the WebAccess Agent. It 
does not apply to the Windows version.

Specify an eDirectory username and password that will provide the WebAccess Agent with file 
system access to the servers where the domain and post office directories reside. 

For details, see “Domain and Post Office Access” on page 106.

8) Execution Options

Install and Configure 
SNMP for WebAccess 
Agent: Yes | No

Run WebAccess 
Agent as a Windows 
Service: Yes | No

Startup Options: 
Automatic | Manual

This item applies only if you are installing the Windows version of the WebAccess Agent.

If you want to enable the WebAccess Agent to be managed through an SNMP management 
program, select the Install and Configure SNMP for WebAccess option.

If you want to run the WebAccess Agent as a Windows service, select the Run WebAccess Agent 
as a Windows Service option, then choose whether you want to manually start the service each 
time or have it start automatically when the server starts.

For details, see “Windows Options” on page 108.

9) Windows Service User

Username:

Password:

This item applies only if you are installing the Windows version of the WebAccess Agent and plan 
to run it as a Windows service rather than a normal Windows application.

Enter the username and password for a user account that provides the service with access to the 
domain and post office directories.

For details, see “Windows Options” on page 108.

Item Explanation
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10) Web Console

Enable: Yes | No

Username:

Password:

HTTP Port:
(default = 7211)

Specify whether or not you want to enable the WebAccess Agent’s Web console. The Web console 
allows you to monitor the operation of the agent through a Web browser.

If you choose to enable the Web console, specify a WebAccess Agent username and password to 
use when logging in to the agent. If port 7211 is already in use, specify a different HTTP port.

For details, see “Web Console” on page 108.

11) LDAP Information

LDAP server IP 
address:

LDAP server port:

Username in LDAP 
format:

Password:

SSL certificate:

This item applies to the Linux WebAccess Agent only.

List the IP address and port of an LDAP server in your system and the username and password 
that the Installation Advisor can use to log in to eDirectory to create the WebAccess Agent object. 
If you want to use an SSL connection, specify an SSL certificate file.

For more information, see “LDAP Information (Linux Only)” on page 109.

12) WebPublisher 
Support

Enable: Yes | No

Mailbox ID:

Password:

Specify whether or not you want to enable the WebAccess Agent to support WebPublisher. If you 
enable WebPublisher support, you need to specify a GroupWise account (mailbox ID and 
password).

For details, see “WebPublisher” on page 109.

13) Libraries List the libraries from which you want to enable GroupWise users to share documents with 
WebPublisher users.

For details, see “WebPublisher” on page 109. 

Item Explanation
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WebAccess/WebPublisher Applications

Item Explanation

13) Web Server Type 
and Root Directory

Web server type:

Netscape Enterprise 
Server for NetWare

Apache Web Server 
for NetWare

Netscape 
FastTrack\Enterprise 
Server for Windows 
NT

Microsoft Internet 
Information Server for 
Windows NT

Apache Web Server 
for UNIX Solaris

Web server root 
directory:

This item applies if you are installing the NetWare or Windows versions of the WebAccess 
Application.

Select the type of Web server where you will install the WebAccess Application and/or the 
WebPublisher Application. 

Specify the path to the Web server’s root directory. The path must be from the perspective of the 
installation workstation.

For details, see “Deciding Where to Install the GroupWise WebAccess Components” on page 104.

14) Web Clipping 
Application (PQA) URL

This item applies if you are installing the NetWare or Windows versions of the WebAccess 
Application.

Specify the URL that you want built into the Web Clipping Application (PQA) that enables Palm OS 
devices to access GroupWise WebAccess.

For details, see “Web Clipping Application (PQA) URL (NetWare and Windows WebAccess)” on 
page 110.

15) Web Server Default 
Page

Current

Novell Web Services

This item applies if you are installing the NetWare or Windows versions of the WebAccess 
Application.

Select whether you want to retain your Web server’s current default page or replace it with the 
Novell Web Services page. 

For details, see “Web Server Default Page” on page 111. 

16) Novell Root Directory Specify a directory on the Web server where you want to install the configuration files for the 
WebAccess Application and/or WebPublisher Application. For NetWare and Windows, the default 
is the novell directory on the root of the server volume. For Linux, the default is /opt/novell/
groupwise/webaccess and /opt/novell/groupwise/webpublisher.

For details, see “Deciding Where to Install the GroupWise WebAccess Components” on page 104.
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17) Java Servlet Engine

Use Novell Servlet 
Gateway

Use Tomcat

Use other Java servlet 
engine

Path:

This item applies if you are installing the NetWare or Windows versions of the WebAccess 
Application.

Specify whether you want to use the Novell Servlet Gateway, Tomcat, or another Java servlet 
engine that is already installed on your Web server. If you use Tomcat or another Java servlet 
engine other than the Novell Servlet Gateway, you need to specify the path to the Java servlet 
engine’s root directory. 

For details, see “Deciding Where to Install the GroupWise WebAccess Components” on page 104.

18) Default Language Specify the language for the initial Novell Web Services page.

For details, see “Default Language” on page 111.

19) eDirectory Object 
Configuration

Tree:

Context:

Specify the tree where you are installing WebAccess. 

Specify the context where the WebAccess Installation program should create the WebAccess 
Application and/or WebPublisher Application objects. The default context is below the Domain 
object.

For details, see “eDirectory Objects and Configuration Files” on page 112.

Item Explanation
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6 Installing GroupWise Monitor

Novell® GroupWise® Monitor is a monitoring and management tool that allows you to monitor 
GroupWise agents and gateways from any location where you are connected to the Internet and 
have access to a Web browser. Some agent administration can also be performed from your Web 
browser. The topics below help you plan and set up GroupWise Monitor:

“GroupWise Monitor Overview” on page 135

“Monitor System Requirements” on page 137

“Planning GroupWise Monitor” on page 139

“Setting Up GroupWise Monitor” on page 143

“GroupWise Monitor Installation Worksheet” on page 152
NOTE: If you plan to install GroupWise Monitor in a clustered server environment provided by Microsoft 
Clustering Services, see the GroupWise 6.5 Interoperability Guide (http://www.novell.com/documentation/
gw65) for additional information. 

GroupWise Monitor Overview
GroupWise Monitor consists of two components:

Monitor Agent: The Monitor Agent continuously polls other GroupWise agents (POA, MTA, 
Internet Agent, WebAccess Agent, Messenger Agents, and gateways), gathers status information 
from them, and displays the status information at the Monitor Agent console. The Monitor Agent 
also services requests for agent status information from the Monitor Application. 

Monitor Application: The Monitor Application extends the capability of your Web server so that 
agent status information can be displayed in the Monitor Web console in your Web browser. 

The Monitor Agent and the Monitor Application can run on the same server or on different servers, 
depending on the needs of your system.

“One Monitor Server vs. Two” on page 135

“Monitor Security Requirements” on page 136

One Monitor Server vs. Two
The Monitor Agent and the Monitor Application can run together on a Linux server or a Windows 
server, as illustrated below:
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The server where they run together must be a Web server because the Monitor Application is 
installed into the Web server installation.

The Monitor Agent and the Monitor Application can also run on different servers. In addition to 
running on a Linux or Windows server, the Monitor Application can also run on a NetWare® or 
UNIX Solaris server in conjunction with a Web server running on one of those platforms, as 
illustrated below:

Security, discussed in the next section, might also determine whether you run the Monitor Agent 
on the same server as the Web server.

Monitor Security Requirements
GroupWise Monitor can be configured to support the level of security you have established for 
your Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use Monitor on a 
secured intranet), you can install the Monitor components to any servers that provide access for 
your GroupWise administrators and that meet the requirements listed in “Monitor System 
Requirements” on page 137. 

If you plan to use Monitor to provide GroupWise administrators with access to your GroupWise 
system from anywhere on the Internet (rather than simply within a secured intranet), and you 
already have a firewall in place to provide security, you have the following options for configuring 
Monitor:

Install both Monitor components inside your firewall and use a proxy service. See 
“Configuring Monitor Using a Proxy Service” on page 137. This is the recommended 
configuration.

Install the Monitor Application on a Web server outside your firewall and the Monitor Agent 
on a server inside your firewall. See “Configuring Monitor Without a Proxy Service” on 
page 137.
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Configuring Monitor Using a Proxy Service

If your firewall includes a proxy service, you can install the Monitor Application to a Web server 
inside your firewall, and the Monitor Agent to another server inside the firewall, as shown in the 
following illustration.

If desired, the Monitor Agent can also be installed to the Web server rather than a separate server, 
as discussed in “One Monitor Server vs. Two” on page 135.

Configuring Monitor Without a Proxy Service

If your firewall does not provide a proxy service, you need to install the Monitor Application to a 
Web server that is outside the firewall. Because the Monitor Agent requires direct access (mapped 
drive, UNC path, or file system mount) to a GroupWise domain directory, it needs to be installed 
to a server that is located within the firewall.

The firewall must allow inbound IP packets to be sent from the Web server to the IP address and 
port number of the Monitor Agent (for example, 172.16.5.18:8200).

In addition, the firewall must allow outbound IP packets to be sent from the Monitor Agent to the 
Web server. This requires all high ports (above 1023) to be open to outbound IP packets. 

Monitor System Requirements
32-bit/x86 processor

Any of the following server operating systems:

SUSE® Linux Standard Server 8, SUSE Linux Enterprise Server 8, SUSE Linux 
Enterprise Server 9, Red Hat Enterprise Linux 3 ES, or Red Hat Enterprise Linux AS

Windows NT Server, Windows 2000 Server, or Windows 2003 Server, plus the latest 
Service Pack for your version of Windows

Approximately 140 MB (111 MB shared with WebAccess; varies by platform)

Any of the following Web servers and Java servlet engines:

NetWare 4.2/5.1 (latest Support Pack required): NetWare Enterprise Web Server with the 
Novell Servlet Gateway

Firewall Server 
with Proxy 

Service

GroupWise
System

Web Server 
with Monitor
Application

Network Server
with Monitor 

AgentInternet

Web Server
with Monitor
Application

GroupWise
System
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Network Server
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NetWare 6.x: Enterprise Web Server or Apache Web Server, with the Tomcat 3.3 servlet 
engine

NetWare 6.5 with GroupWise 6.5 Support Pack 1 or later: Apache 2 with the Tomcat 4 
servlet engine

Windows NT (latest Service Pack required): Microsoft Internet Information Server 4.0 or 
Netscape Enterprise Server 3.6 or later, either with the Novell Servlet Gateway

Windows 2000: Microsoft Internet Information Server 5 or later with the Novell Servlet 
Gateway

Linux: Apache 2 with the Tomcat 4 servlet engine

UNIX Solaris: Apache Web Server 1.3.3 or later with the Tomcat servlet engine

 Java Virtual Machine (JVM) 1.4.2 or later

Keep in mind the following platform-specific details:

NetWare servers can run only one JVM. On NetWare, the Monitor Application requires 
JVM 1.1.7B dated 12/12/2001 or later. This version is included with Monitor. During 
installation, you are prompted to replace your current version with the Monitor version; 
you should do so unless the server’s current version is newer.

Linux servers require J2SDK 1.4.2 and Jakarta Connector 1.2.3 in addition to the JVM. 
The JVM and the additional Java components can be installed when you install Monitor 
on Linux, or you can integrate Monitor into an existing Java installation.

Windows servers can run multiple JVMs at the same time. To ensure compatibility with 
the Monitor Application, you should install JVM 1.1.8 or higher. JVM 1.4.1 (Java 2 
Runtime Environment, Standard Edition Version 1.4.1) is included with Monitor. 

A JVM is not included for UNIX Solaris. You need to separately install JVM 1.1.7B or 
later to your UNIX Web server. Install the latest version available.

Any of the following Web browsers for the agent Web consoles:

Windows: Microsoft Internet Explorer 4.0 or later; Netscape Navigator 4.0 or later

Linux: Mozilla 1.4 or later and comparable Mozilla-based browsers; Netscape 6.2.2 or 
later

Macintosh: Safari 1.0 or later, Microsoft Internet Explorer 4.5 or later; Netscape 
Navigator 4.51 or later

UNIX: Netscape 4.0 or later; Microsoft Internet Explorer 4.0 or later

Any of the following wireless devices for the agent Web consoles:

Any wireless device that supports the Wireless Access Protocol (WAP) and has a 
microbrowser that uses Handheld Device Markup Language (HDML) 3.0 or later or 
Wireless Markup Language (WML) 1.1 or later

A Palm OS device with any Palm OS version that supports Web Clipping Applications 
(PQAs)

A Windows CE device with any Windows CE version
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Planning GroupWise Monitor
Before installing GroupWise Monitor, you should complete the planning tasks listed below. The 
planning tasks help you gather information you need as you install and set up GroupWise Monitor. 
You can use the “GroupWise Monitor Installation Worksheet” on page 152 to record your 
installation and setup information.

“Deciding Where to Install the GroupWise Monitor Components” on page 139

“Determining the Monitor Agent’s Configuration” on page 140

“Determining the Monitor Application’s Configuration” on page 141

Deciding Where to Install the GroupWise Monitor Components
After reviewing “GroupWise Monitor Overview” on page 135 and the system requirements listed 
in “Monitor System Requirements” on page 137, plan where you want to install the Monitor 
components in your system.

“Monitor Server” on page 139

“Web Server” on page 139

Monitor Server

The Monitor Agent runs on Linux and Windows. 

If you want to install the Monitor Agent and the Monitor Application on the same server, you can 
install them at the same time. If you want to install them on different servers, you must run the 
Monitor Installation program twice, once for each server. For example, you might want to install 
the Monitor Application on NetWare for use with a NetWare Web server, but you must always 
install the Monitor Agent on Linux or Windows. 

The installation directory for the Monitor Agent depends on the platform:

Linux: The Linux Monitor Agent is automatically installed to the bin and lib subdirectories 
of /opt/novell/groupwise/agents.

Windows: The default installation directory is c:\gwmon.

Web Server

The Monitor Application integrates with your Web server to pass agent status information 
gathered by the Monitor Agent to your Web browser for display in the Monitor Web console. The 
location of the Monitor Application files that are installed depends on the Web server that it is 
being integrated with. For example, on Windows, the images used to produce the Monitor Web 
console interface and the Monitor Web console help files are installed in the 

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 1: Platform, mark the platform (Linux or Windows) where you plan to install the Monitor 
Agent.

Under Item 2: Components to Install, select whether you want to install the Monitor Agent, the Monitor 
Application, or both. 

Under Item 3: Monitor Agent Installation Path, specify the directory on the Linux or Windows server 
where you want to install the Monitor Agent software.
Installing GroupWise Monitor 131



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
docs\com\novell\gwmonitor subdirectory beneath the Web server root directory. On Linux, they 
are installed in the gwmon/com/novell/gwmonitor subdirectory beneath the tomcat/webapps 
directory.

The Web server uses a servlet engine in order to incorporate product-specific components, such as 
the Monitor Application, into its functioning.

Determining the Monitor Agent’s Configuration
As you install the Monitor Agent, you are prompted to supply the configuration information 
described in the following sections:

“Monitor Agent Network Address” on page 140

“Domain Directory Path” on page 140

“Default Monitor Agent Language (Windows Only)” on page 141

“LDAP Information (Linux Only)” on page 141

Monitor Agent Network Address

The Monitor Agent communicates with the Monitor Application and with monitored agents by 
way of TCP/IP.

Domain Directory Path

The Monitor Agent can gather information about the locations of GroupWise agents to monitor by 
reading from a domain database. Using the gathered information, the Monitor Agent can display 
a list of monitored agents when you start it for the first time.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 7: Web Server, select the Web server you want to use with Monitor. 

Under Item 8: Web Server Path, specify the directory path to the Web server root directory.

Under Item 12: Java Servlet Engine, mark whether you want to use the Novell Servlet Gateway, the 
Tomcat Servlet Gateway, or another Java servlet engine.

If you use the Novell Servlet Gateway, it is installed in sys:\java on NetWare or in c:\novell\java on 
Windows. If you choose to use the Tomcat Servlet Gateway or another Java servlet engine, you need 
to specify the directory path to where the servlet engine is installed.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 4: Monitor Agent Network Address, record the IP address or DNS hostname of the Linux 
or Windows server where you plan to install the Monitor Agent software. Use the default port number 
of 8200 unless that number is already in use on that server.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 5: Domain Directory Path, specify the directory path to a domain where a GroupWise 6.x 
MTA is running.
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Default Monitor Agent Language (Windows Only)

GroupWise Monitor is automatically installed in all available languages. During installation, you 
can select a default language for the Monitor Agent console interface, which is available on 
Windows but not on Linux.

On Linux, you use the Monitor Web console exclusively.

LDAP Information (Linux Only)

If you are installing the Linux Monitor Agent and Monitor Application, the Installation Advisor 
needs to access eDirectory through LDAP. eDirectory access is required in order to create the 
Monitor Agent and Monitor Application objects. To obtain access, the Installation Advisor needs 
the IP address and port number of an LDAP server, along with a username and password to log in 
with. Because the Linux Installation Advisor uses LDAP to access eDirectory, you must provide 
the username in LDAP format. For example:

cn=admin,ou=users,o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a certificate file. For 
background information about SSL, see “Encryption and Certificates” in “Security” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65). If you do 
not want to use SSL, the LDAP server must be configured to accept clear text passwords

Determining the Monitor Application’s Configuration
As you install the Monitor Application to a Web server, you are prompted to supply the 
configuration information described in the following sections:

“Web Clipping Application (PQA) URL” on page 141

“Web Server Default Page” on page 142

“eDirectory Objects and Configuration File” on page 142

“Default Monitor Web Console Language” on page 143

Web Clipping Application (PQA) URL

On Windows, the Monitor Installation program creates a Web Clipping Application (PQA), also 
referred to as a Palm Query Application, to enable Palm OS device users to access the GroupWise 
Monitor Web console. (The Web Clipping Application is not available on Linux.)

The Web Clipping Application, named gwmon.pqa, includes the URL required to connect to the 
Monitor Application, a Login page, an About Novell GroupWise page, and the images used when 
displaying the Monitor Web console on the Palm OS device.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 6: Default Monitor Agent Console Language, specify a default language.

WORKSHEET

Under Item 15: LDAP Information, specify the IP address and port number of an LDAP server, a 
username in LDAP format, the password for the username, and if necessary, the full path to your SSL 
certificate file.
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You must specify the URL you want used. For example:

http://groupwise.novell.com

The Monitor Installation program automatically appends /servlet/gwmonitor to the URL so that 
users are directed to the Monitor login page. For example, using the URL above, the Monitor 
Installation program creates the following URL in the gwmon.pqa file:

http://groupwise.novell.com/servlet/gwmonitor

As you determine the URL, keep in mind the following:

If the Web server uses SSL, you need to change http to https. 

If you are using a proxy server, you need to specify the proxy server’s address.

The Web clipping proxy server (gateway) does not currently support challenge and response 
authentication. Therefore, you need to ensure that the Web server is not configured to require 
basic challenge response authentication, or at least is configured not to require this 
authentication for the URL defined in the gwmon.pqa file.

Web Server Default Page

The main Novell Web Services page (novell.htm) is installed to the Web server’s root directory. 
In the Windows Monitor Installation program, you can have this file replace the Web server’s 
current default Web page, or you can retain the current default Web page. On Linux, this Web page 
is handled differently, so there is no need to replace an existing Web page on Linux.

If you use the Novell Web Services page as the default Web server page, the Web server’s current 
default page remains in its original location but is renamed to filename.001 (for example, 
default.001 or index.001). You should change the default Web server page only if the server and 
its Web server are used solely for Novell products. As you install additional Novell products, the 
Novell page is updated to allow access to each one.

eDirectory Objects and Configuration File

Monitor Application configuration information is stored in two places: in Novell eDirectoryTM and 
in a configuration file. You can easily modify the configuration information in ConsoleOne® by 
editing the properties of the GroupWise Monitor Application object (named GroupWiseMonitor). 
However, the configuration file is required if you need to install the Monitor Application to a Web 
server that is outside your firewall, where access to eDirectory is not available. The default 
location of the Monitor Application configuration file depends on the platform:

Linux: The Monitor Application configuration file is /opt/novell/groupwise/agents/
gwmonitor/gwmonitor.cfg.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 9: Web Clipping Application (PQA) URL, specify the URL you want included in the 
gwmon.pqa file.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 10: Default Web Page, specify whether you want to use the Novell Web Services page or 
retain the Web server’s current default page.
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Windows: The default application configuration file path is c:\novell and the Monitor 
Application configuration file (gwmonitor.cfg) is created in the gwmonitor subdirectory of 
the directory you specify.

eDirectory is considered the master location for the Monitor Application configuration 
information. Any changes made directly to the Monitor Application configuration file are 
overwritten the next time the information in eDirectory is modified and saved.

The default configuration information is sufficient for an initial Monitor installation. For more 
information about configuring Monitor, see “Monitor” in the GroupWise 6.5 Administration 
Guide (http://www.novell.com/documentation/gw65).

Default Monitor Web Console Language

GroupWise Monitor is automatically installed in all available languages. If necessary, you can 
select a different default language for the Monitor Web console interface and default Web server 
page than you selected for the Monitor Agent console interface.

Setting Up GroupWise Monitor
Follow the instructions for the platform where you are setting up GroupWise Monitor:

“Setting Up GroupWise Monitor on Linux” on page 143

“Setting Up GroupWise Monitor on Windows” on page 148

“Completing Optional Post-Installation Tasks” on page 149

Setting Up GroupWise Monitor on Linux
Complete the following tasks to install GroupWise Monitor on Linux:

“Installing the Linux Monitor Agent” on page 144

“Configuring the Linux Monitor Agent” on page 144

“Starting the Linux Monitor Agent for the First Time” on page 146

“Accessing the Monitor Web Console on Linux” on page 146

“Starting the Linux Monitor Agent on System Startup” on page 147

“Stopping the Linux Monitor Agent” on page 147

GROUPWISE MONITOR INSTALLATION WORKSHEET

If you are installing the Windows Monitor, under Item 11: Monitor Configuration File Path, specify the 
directory on the Web server where you want to create the Monitor Application configuration file. On 
Linux, the Monitor software is automatically installed in subdirectories under /opt/novell/groupwise/
agents.

Under Item 13: Monitor Object Configuration, specify the tree and context where you want the Monitor 
Installation program to create the GroupWise Monitor Application object and the accompanying 
Monitor Provider object (named GroupWiseProvider).

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 13: Default Monitor Web Console Language, specify a default language.
Installing GroupWise Monitor 135

http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65


    Novell Confidential                                                                                            Manual (99a)  21 December 2004
Installing the Linux Monitor Agent

1 Make sure that LDAP is running on your eDirectory server and that it is configured to accept 
login from the Monitor Agent Installation program (worksheet item 15)

The Installation Advisor requires eDirectory access in order to create the Monitor objects in 
eDirectory. The Installation Advisor uses LDAP to gain the required access.

2 At the Linux server where you want to install Monitor, open a new terminal window, then 
enter the following command:

xhost + localhost

If you cannot execute this command because the X Window System is not running on the 
Linux server, see “Installing the GroupWise Agents Using the Text-Based Installation 
Advisor” on page 167, which describes the process for the POA and the MTA.

3 Become root by entering su and the root password.

4 Change to the root of the GroupWise 6.5 for Linux Administrator CD.

5 Start the GroupWise Installation Advisor.

./install

6 Select the language in which you want to run the Installation Advisor and install software, 
then click OK.

7 Click Install Products > GroupWise Monitor > Install GroupWise Monitor.

The Monitor Agent software is installed to the bin and lib subdirectories of /opt/novell/
groupwise/agents.

8 When the file copy is complete, click OK.

9 Continue with Configuring the Linux Monitor Agent.

Configuring the Linux Monitor Agent

1 After the Monitor Agent files have been installed, click Configure Monitor.

The Monitor Agent installation and configuration steps are separate so that you can install 
updated agent software without needing to repeat the agent configuration steps.

2 Review the Introduction, then click Next.

3 Accept the License Agreement, then click Next.
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4 Browse to and select a domain directory (worksheet item 5) where the Monitor Installation 
program can access a domain database, then click Next.

This allows the Monitor Agent to automatically discover all agents in your GroupWise system 
and start monitoring them.

5 Click Exit to complete the installation.

6 Continue with Installing and Configuring the Monitor Application.

Installing and Configuring the Monitor Application

1 After installing and configuring the Monitor Agent, click Install Monitor Application with 
Apache and Tomcat.

This installs a version of Apache and Tomcat specifically for use with GroupWise. Apache 
files are installed under /var/opt/novell/http and /etc/opt/novell/http. Tomcat files are installed 
under /var/opt/novell/tomcat4 and /etc/opt/novell/tomcat4.

or

If you want to use an existing Apache/Tomcat installation, click Install Monitor Application.

2 Accept the License Agreement, then click Next.

3 Specify the IP address or DNS hostname of the Linux server where you are installing the 
Monitor Application (worksheet item 4), then click Next.

The default port number of 8200 is typically acceptable, unless another program is already 
using that port.

4 Click Next to accept the default Apache and Tomcat locations that were established in Step 1.

or

Specify the locations of Apache and Tomcat installations on your system, then click Next.

5 Fill in the LDAP information (worksheet item 15), then click Next.

6 Browse to and select the eDirectory context where you want the Monitor Application objects 
to be created (worksheet item 19), then click Next.

The GroupWise Monitor Application objects are GroupWiseMonitor and MonitorProvider.

7 Click Exit to complete the configuration.

8 Continue with Starting the Web Server.

Starting the Web Server

If you installed Apache and Tomcat along with the Monitor Application, follow the instructions 
below to start your Web server. If you did not install Apache and Tomcat along with the Monitor 
Application, restart Apache and Tomcat on your system.

1 Make sure you are logged in as root.

2 If you have other instances of Apache and Tomcat running on this server, bring them down 
before you start the new versions you just installed.

3 Change to the /etc/init.d directory.

4 Start Tomcat.

./novell-tomcat4 start
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5 Wait until Tomcat is all the way up.

6 Start Apache.

./novell-httpd start

7 Continue with Starting the Linux Monitor Agent for the First Time.

Starting the Linux Monitor Agent for the First Time

1 Make sure you are logged in as root.

2 Make sure you know the path to a domain directory where a domain database (domain.db) is 
located or the IP address of a server where the MTA is running.

3 Change to the GroupWise agent bin directory.

cd /opt/novell/groupwise/agents/bin

4 Use one of the following commands to start the Monitor Agent:

./gwmon --home /domain_directory &

./gwmon --ipa IP_address --ipp port_number &

The --home startup switch specifies a domain directory where the Monitor Agent can access 
a domain database.

The --ipa startup switch specifies the IP address of a server where an MTA is running, which 
is another way for the Monitor Agent to obtain information from a domain database. The --
ipp startup switch specifies the port number on which the Monitor Agent listens for incoming 
service requests.

The ampersand (&) causes the Monitor Agent to run in the background, so that the terminal 
window you started it in is again available for use.

A message indicates that the Monitor Agent is polling the domain you specified. 

You can also start the Monitor Agent using its startup script (/etc/initd/grpwise-ma).

The Monitor Agent does not have a --show switch. The Monitor log file (mmddmon.nnn) for 
status messages is located in the /var/log/novell/groupwise/gwmon directory. The log file 
name includes the month and day when it was created, along with an incrementing extension 
to accommodate multiple log files on the same day. The Monitor Agent can also be monitored 
from your Web browser.

5 Continue with Accessing the Monitor Web Console on Linux.

Accessing the Monitor Web Console on Linux

1 In your Web browser, view the following URL:

http://network_address/gwmon/gwmonitor
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For instructions on protecting the Monitor Agent Web console with a password, see 
“Configuring Authentication and Intruder Lockout for the Monitor Web Console” in 
“Monitor” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

Starting the Linux Monitor Agent on System Startup

If you selected Launch Monitor Agent on System Startup in the Monitor Agent Installation 
program, your system was configured so that the Monitor Agent would start automatically. The 
Monitor Installation program always creates a grpwise-m a startup script in /etc/init.d for starting 
the Monitor Agent. To enable automatic startup, the Monitor Installation program creates 
symbolic links named S99grpwise-ma in the rc3.d and rc5.d directories so that the Monitor Agent 
can load on startup into runlevel 3 or 5, depending on the configuration of your Linux system.

When the grpwise-ma script runs and starts the Monitor Agent, it reads the Monitor Agent 
configuration file (monitor.xml) in /opt/novell/groupwise/agents/share to check for configuration 
information. 

Stopping the Linux Monitor Agent

When you start the Monitor Agent with the grpwise-ma startup script, you can also use the script 
to stop it.

1 Make sure you are logged in as root.

2 Change to the /etc/init.d directory.

3 To stop the Monitor Agent, enter the following command:

./grpwise-ma stop

4 To confirm that the Monitor Agent has stopped, enter the following command:

ps -eaf | grep gwmon

The only gwmon process ID you should see listed is the one for the grep command.

When you start the Monitor Agent manually (without using the grpwise-ma script), use the 
standard Linux kill command to stop it.

1 Make sure you are logged in as root.

2 Determine the process ID of the Monitor Agent.

ps -eaf | grep gwmon

The PIDs for all gwmon processes are listed.

3 Kill the first gwmon process in the list.
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kill first_process_ID

It might take a few seconds for all gwmon processes to terminate.

4 Repeat the ps command to verify that the Monitor Agent stopped.

Setting Up GroupWise Monitor on Windows
1 At a Windows server that has the Novell ClientTM installed, log in as an Admin equivalent to 

the eDirectory tree in which you are installing Monitor.

The Monitor Installation program requires the Novell Client in order to create GroupWise 
objects in eDirectory. If necessary, you can download the Novell Client from the Novell 
Product Downloads site (http://download.novell.com).

2 If you want to monitor GroupWise gateways or non-HTTP-enabled agents (such as earlier 
versions of any GroupWise agent), install the SNMP service for Windows. This enables the 
Monitor Agent to use SNMP in addition to HTTP.

3 Make sure no GroupWise agents are currently running on the Windows server where you plan 
to install the Monitor Agent.

4 Run setup.exe at the root of the GroupWise 6.5 Administrator CD, then click Install Products 
> GroupWise Monitor > Install GroupWise Monitor.

or

Run setup.exe from the \admin\monitor subdirectory on the CD or in your software 
distribution directory if you have updated it with GroupWise 6.5 software. 

5 Follow the on-screen instructions to install GroupWise Monitor, supplying the information 
you gathered on the “GroupWise Monitor Installation Worksheet” on page 152.

On Windows, the Monitor Installation program starts the Monitor Agent for you and the 
Monitor Agent console displays on the Windows server.

After installation is complete, you might need to perform some additional steps, as described in 
“Completing Optional Post-Installation Tasks” on page 149.

Completing Optional Post-Installation Tasks
Depending on the configuration you have chosen for the Monitor Agent and Monitor Application, 
you might need to perform one of more of the following tasks after you have installed the Monitor 
software:
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If you kept your Web server’s default home page file, create a link from your home page to 
the Novell Web Services page (novell.htm file) in the document root directory. 

If you use a proxy service, follow the instructions in “Configuring Proxy Service Support for 
the Monitor Web Console” in “Monitor” in the GroupWise 6.5 Administration Guide.

If you are installing to the Apache Web Server for UNIX Solaris, continue with “Completing 
the Monitor Installation on a UNIX Apache Web Server” on page 149.

(Windows only) If you chose to use an existing Java servlet engine rather than installing the 
Novell Servlet Gateway, modify the Java servlet engine’s servlet properties files to include 
the settings shown in the sample Monitor servlet.properties file. This sample file is located in 
the \admin\monitor\other directory on the CD.

(Windows only) If you chose to use an existing JVM on Windows rather than update to the 
one included with Monitor, edit the servletgateway.properties file and change the java.base 
setting to point to the existing JVM (for example, c:\jdk1.1.8). The servletgateway.properties 
file is located the \novell\java\servlets directory.

After completing any post-installation tasks that pertain to your Monitor configuration, continue 
with “Using GroupWise Monitor” on page 150.

Completing the Monitor Installation on a UNIX Apache Web Server

The Monitor Installation program copies the following files to the location you specified: 
gwmonitor.tar, gwmonitordocs.tar, gwmonitorjars.tar, gwmonitorservlets.tar, index.html, and 
servlets.properties. It also creates a palm subdirectory for the Palm Query Application (PQA) file 
it creates.

To complete the installation and configuration process:

1 Using the tar -xvf command, extract the following tar files to the specified locations: 

gwmonitor.tar: Extract to the root of the UNIX server. A /novell directory is created for 
the files.

gwmonitordocs.tar: Extract to the Apache document root directory (for example, /usr/
local/apache/htdocs).

gwmonitorservlets.tar: Extract to the Tomcat ROOT/WEB-INF/classes directory (for 
example, /usr/local/tomcat/webapps/ROOT/WEB-INF/classes).

gwmonitorjars.tar: Extract to the Tomcat ROOT/WEB-INF/lib directory (for example, 
/usr/local/tomcat/webapps/ROOT/WEB-INF/lib).

2 Modify the Tomcat web.xml file to include the following information. The web.xml file is in 
the Tomcat ROOT/WEB-INF directory.

<web-app>

<servlet>
<servlet-name>gwmonitor</servlet-name>
<servlet-class>com.novell.gwmonitor.MonitorServlet</servlet-class>
<init-param>
<param-name>Config</param-name>
<param-value>/novell/gwmonitor/gwmonitor.cfg</param-value>
</init-param>
<load-on-startup> </load-on-startup>
</servlet>

</web-app>
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3 Modify the gwmonitor.cfg file, located in the /novell/gwmonitor directory at the root of the 
UNIX server, to change the Templates.path setting to point to the templates.

For example, change the following line in webacc.cfg:

Templates.path=/java/servlets/com/novell/gwmonitor/templates

to

Templates.path=/usr/local/tomcat/webapps/ROOT/WEB-INF/classes/com/
novell/gwmonitor/templates

4 In the gwmonitor.cfg file, verify that the paths for the following settings point to valid 
directories. Typically, these directories reside in the /novell/gwmonitor directory, but you can 
relocate them if desired. Refer to the comments in the gwmonitor.cfg file for explanations of 
each of these settings.

Log.path=/novell/gwmonitor/logs
Security.Timeout.path=/novell/gwmonitor/users

5 Copy the index.html file to the Apache document root directory (for example, /usr/local/
apache/htdocs). You can replace your Web server’s current default home page with this file, 
or you can rename the file and link to it from your current default home page.

Using GroupWise Monitor
You can use GroupWise Monitor in various environments:

“Monitor Agent Console on a Windows Server” on page 150

“Monitor Web Console in Your Web Browser” on page 151

“Monitor Web Console on Your Palm OS Device” on page 152

Monitor Agent Console on a Windows Server
To start the Monitor Agent on a Windows server and display the Monitor Agent console, click 
Start > Programs > GroupWise Monitor > GroupWise Monitor. The Monitor Agent console 
appears.

At the Monitor Agent console, you can perform many activities, for example:

Use items on the Configuration menu to configure the Monitor Agent as needed.

Use items on the View menu to choose how much and what kind of agent status information 
to display.
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Create agent groups in order to monitor related agents together.

Use items on the Reports menu to check the status of links throughout your GroupWise 
system and to organize status information into a format that can be e-mailed or printed.

Use items on the Actions menu to control agent polling.

For more information about using the Monitor Agent console, see “Monitor” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

To stop the Monitor Agent, click Configuration > Exit or close the window where the Monitor 
Agent is running.

Monitor Web Console in Your Web Browser
To display similar information in your Web browser, enter the Monitor Web console URL in your 
Web browser:

Linux: https://network_address/gwmon/gwmonitor
Windows: https://network_address/servlet/gwmonitor

where network_address represents the IP address or DNS hostname of the server where your Web 
server runs. The Monitor Web console appears.

You can use this same URL to view the same agent status information in various wireless browsers 
and devices.

You can perform the same monitoring activities at the Monitor Web console as you can at the 
Monitor Agent console. Refer to the online help in the Monitor Web console for additional 
information about each Monitor Web console page.

For more information about using the Monitor Web console, see “Monitor” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

Monitor Web Console on Your Palm OS Device
To access the Monitor Web console on your Palm OS device:

1 Add the GroupWise Monitor Web Clipping Application (gwmon.pqa) to your Palm OS 
device. 

The gwmon.pqa file is located in the Web server’s docs\com\novell\gwmonitor\palm\en 
directory. 

2 Open the GroupWise Monitor Application. To do so, tap the Applications icon, tap the pick-
list in the upper-right corner of the screen, select Palm.Net, then tap GroupWise Monitor.

3 Enter your login ID and password, then log in.
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GroupWise Monitor Installation Worksheet

Item Explanation

1) Platform

Linux

Windows

Mark the platform where you want to install the Monitor Agent.

For more information, see “Deciding Where to Install the GroupWise Monitor Components” on 
page 139.

2) Components to Install:

GroupWise Monitor 
Agent

GroupWise Monitor 
Application

Mark the components you want to install. You don't need to install both components at the same 
time or on the same platform.

For more information, see “Deciding Where to Install the GroupWise Monitor Components” on 
page 139.

3) Monitor Agent 
Installation Path:

Linux: /opt/novell/
groupwise/agents

Windows:

c:\gwmon (default)

Other:

Specify the directory path where you want the Monitor Agent software installed.

For more information, see “Deciding Where to Install the GroupWise Monitor Components” on 
page 139.

4) Monitor Agent 
Network Address:

IP address:

DNS hostname:

Port number: 8200 
(default)

Specify the IP address or DNS hostname of the server where you plan to install the Monitor Agent.

Specify the port number for the Monitor Agent to listen on. The Monitor Agent must use a unique 
port number.

For more information, see “Monitor Agent Network Address” on page 140.

5) Domain Directory 
Path:

Specify a domain directory where a GroupWise 6.x MTA is running.

For more information, see “Domain Directory Path” on page 140.

6) Default Monitor Agent 
Console Language:

Select the default language for the Monitor Agent console Interface on the Windows server.

For more information, see “Default Monitor Agent Language (Windows Only)” on page 141.
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7) Web Server:

Netscape Enterprise 
Server for NetWare

Apache Web Server 
for NetWare

Apache Web Server 
for Linux

Microsoft Internet 
Information Server 
(IIS) Windows

Netscape FastTrack/
Enterprise Server for 
Windows NT

Apache Web Server 
for UNIX Solaris

Mark the Web server you want to use with GroupWise Monitor.

For more information, see “Deciding Where to Install the GroupWise Monitor Components” on 
page 139.

8) Web Server Path: Specify the directory path to the Web server’s root directory.

For more information, see “Deciding Where to Install the GroupWise Monitor Components” on 
page 139.

9) Web Clipping 
Application (PQA) URL

Specify the URL that you want built into the Web Clipping Application (PQA) that enables Palm OS 
devices to access the Monitor Web console.

For details, see “Web Clipping Application (PQA) URL” on page 141.

10) Default Web Page:

Novell page 

Current page

Select whether or not you want the Novell Web Services page to replace the Web server's default 
Web page. 

For more information, see “Web Server Default Page” on page 142.

11) Monitor 
Configuration File Path:

Linux: /opt/novell/
groupwise

Windows:

c:\novell (default)

Other:

Specify the directory path where you want the Monitor configuration file installed.

For more information, see “eDirectory Objects and Configuration File” on page 142.

12) Java Servlet Engine:

Use Novell Servlet 
Gateway

Use Tomcat Servlet 
Gateway

Use Other Java 
Servlet Engine

Java Servlet Root 
Directory:

Select the Java servlet engine you want to use with Monitor.

For the Tomcat Servlet Gateway or another Java servlet engine, specify the directory path to the 
servlet engine.

For more information, see “Deciding Where to Install the GroupWise Monitor Components” on 
page 139.

Item Explanation
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13) Default Monitor Web 
Console Language:

Select the default language for the Monitor Web console Interface.

For more information, see “Default Monitor Web Console Language” on page 143.

14) Monitor Object 
Configuration:

Tree:

Context:

Specify the tree where you are installing Monitor. 

Specify the context in which the Monitor Installation program should create the GroupWise Monitor 
and Monitor Provider objects, where configuration information is stored.

For more information, see “eDirectory Objects and Configuration File” on page 142.

15) LDAP Information

LDAP server IP 
address:

LDAP server port:

Username in LDAP 
format:

Password:

SSL certificate:

This item applies only on Linux.

List the IP address and port of an LDAP server in your system and the username and password 
that the Monitor Installation program can use to log in to eDirectory to create the Monitor Agent 
object. If you want to use an SSL connection, specify an SSL certificate file.

For more information, see “LDAP Information (Linux Only)” on page 141.

Item Explanation
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7 Installing GroupWise Agents

Novell® GroupWise® agents are first installed and started as part of installing a basic GroupWise 
system, as described in Chapter 3, “Installing a Basic GroupWise System,” on page 23. The 
following sections help you install additional agents as you create new domains and post offices 
in your growing GroupWise system.

“GroupWise Agent Overview” on page 155

“Agent System Requirements” on page 156

“Planning the GroupWise Agents” on page 157

“Setting Up the GroupWise Agents” on page 161

“What’s Next” on page 173

“GroupWise Agent Installation Worksheet” on page 174
NOTE: If you plan to install the GroupWise agents in a clustered server environment provided by Novell 
Cluster ServicesTM or Microsoft Clustering Services, see the GroupWise 6.5 Interoperability Guide (http://
www.novell.com/documentation/gw65) for additional information. 

GroupWise Agent Overview
Each time you create a new post office, you must set up at least one Post Office Agent (POA) for 
it. Some of the POA’s tasks in the post office include:

Connecting GroupWise clients to mailboxes through network connections (TCP/IP, POP, 
IMAP)

Sending messages to other users and delivering incoming messages into mailboxes

Indexing messages and documents to support the Find feature in the GroupWise clients

Managing disk space usage in the post office and controlling the size of messages that users 
are allowed to send and receive

Each time you create a new domain, you must set up a Message Transfer Agent (MTA) for it. 
Some of the MTA’s tasks in the domain include:

Routing user messages between post offices and domains

Routing administration messages throughout the GroupWise system so that databases are kept 
in sync

Synchronizing GroupWise user information with Novell eDirectoryTM user information

The POA requires direct access to the post office directory. The MTA requires direct access to the 
domain directory. The preferred way to fulfil this requirement is to install each agent on the same 
server with its directory. Running an agent locally on the same server where its directory and 
database are located simplifies network connections, because no remote login is required. In 
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addition, it reduces network traffic and protects database integrity. The following diagram 
illustrates direct access:

However, if necessary, you can install the agent on a different server from its directory. This 
requires the agent to have a direct link (mapped drive, UNC path, or file system mount) to its 
directory on the remote server in order to function. The following diagram illustrates the direct 
links:

To route user and administration messages to the post office, the MTA requires a direct link (or 
direct access) to the post office directory, or a TCP/IP link to the POA for the post office. The 
following diagram illustrates the alternatives:

Agent System Requirements
32-bit/x86 processor

Any of the following server operating systems:

Message
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NetWare® 4.2, NetWare 5.1, or NetWare 6.x, plus the latest Support Pack for your 
version of NetWare
NOTE: Domains and post offices can be located on NetWare 3.12 servers, although the agents 
cannot run there.

SUSE® Linux Standard Server 8, SUSE Linux Enterprise Server 8, SUSE Linux 
Enterprise Server 9, Red Hat Enterprise Linux 3 ES, or Red Hat Enterprise Linux AS

The X Window System and OpenMotif are required by the GUI GroupWise agent 
consoles. The agents can also run as daemons without user interfaces.

Windows NT Server, Windows 2000 Server, or Windows 2003 Server, plus the latest 
Service Pack for your version of Windows

Approximately 25 MB of free disk space (varies by platform)

Adequate memory to ensure acceptable performance

Approximately 10 MB of free memory (minimum for the agents to start)

Substantially more free memory for the POA depending on the number of active users, 
as illustrated by the table below:

Although the Linux and Windows agent memory requirements differ slightly from the 
NetWare agents, you can use the figures provided for the NetWare agents to see what 
agent processes are most memory intensive. This can help you figure memory 
requirements for more complex configurations. See the following sections in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65):

“Estimating NetWare POA Memory Requirements” in “Post Office Agent”

“Estimating NetWare MTA Memory Requirements” in “Message Transfer Agent”

Planning the GroupWise Agents
Use the “GroupWise Agent Installation Worksheet” on page 174 to record your decisions about 
how to install the GroupWise agents as you review the following considerations:

“Selecting the Agent Platform” on page 158

“Selecting the Agent Location” on page 158

“Selecting the Agent Installation Directory” on page 159

“Gathering Domain and Post Office Information” on page 159

“Clustering the NetWare Agents” on page 159

“Configuring the Windows Agents” on page 160

“Deciding Which Languages to Install” on page 161

Concurrent Users Actual Memory Usage 
at Peak Time

100 active users (100-250 users in post office) 50 MB

250 active users (250-500 users in post office) 110 MB

500 active users (500-1000 users in post office) 125 MB

1000 active users (1000-2500 users in post office) 150 MB
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Selecting the Agent Platform
The MTA and POA are available as NetWare NLMTM programs, Linux executables, and Windows 
executables.

In general, GroupWise is most efficient if you match the agent platform with the network operating 
system where the post office and domain are located. For example, if a domain and post office are 
located on a NetWare server, then you would install the NetWare agents for them. However, this 
is not required. 

Those with mixed networks might wonder what platform combinations are possible. For more 
information, see the following sections in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65):

“Cross-Platform Issues in the Post Office” in “Post Office Agent”

“Cross-Platform Issues between Domains and Post Offices” in “Message Transfer Agent”

Selecting the Agent Location
Record which GroupWise agents you plan to run on the selected server (POA, MTA, or both) and 
whether you want to install the agents locally or remotely in relation to their directories and 
databases, as described in “GroupWise Agent Overview” on page 155.

If the NetWare agents need to access their directories and databases on remote NetWare servers, 
you must add configuration information to the agent startup files to provide the needed access. You 
can choose from two access methods: 

Use the /dn switch to specify the distinguished name of the agent object that was created along 
with the Domain or Post Office object.

Use the /user and /password switches to specify a network user ID and password for the agent 
to use when it accesses the remote NetWare server.

Selecting the Agent Installation Directory
The agent installation directory depends on the platform where you are installing the agents. 

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 1: Agent Platform, mark whether you plan to install the agents on NetWare, Linux, or 
Windows. Review “Agent System Requirements” on page 156 to ensure that the specific server you 
have selected meets the listed requirements.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 2: Agents and Locations, mark the agents to install and their locations relative to the 
directories and databases they need to access.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 2: Agents and Locations, for the NetWare agents, record the startup switches and settings 
you’ll need to add to the agent startup files after installation if you are installing the agents on a 
different NetWare server from where their directories and databases are located.
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Consider these platform-specific guidelines:

NetWare: When installing the NetWare agents, we recommend you use the sys:\system 
directory on the NetWare server. This simplifies the use of startup files and ensures that the 
NLM programs are in the server’s search path. If you use a different directory, you must add 
that directory to the server’s search path.

Linux: The Linux agents are automatically installed to the bin and lib subdirectories under /
opt/novell/groupwise/agents. 

Windows: The default installation directory is c:\grpwise. However, you can install the 
agents to any directory you want.

Both the MTA and the POA are installed to the specified directory.

Gathering Domain and Post Office Information
Record the following information about the domains and post offices for which you are installing 
and setting up the GroupWise agents: 

Clustering the NetWare Agents 
Novell Cluster Services is a server clustering system that ensures high availability and 
manageability of critical network resources including volumes (where GroupWise domains and 
post offices reside) and applications (such as the GroupWise agents). Novell Cluster Services 
supports failover, failback, and migration of individually managed cluster resources. 

The GroupWise NetWare agents can be configured to take advantage of the fault-tolerant 
environment provided by Novell Cluster Services if the following requirements are met:

The domains and post offices to be serviced by the NetWare agents have already been created 
on shared NSS volumes in the cluster.

The NetWare agents are being installed to a server that is part of the same cluster.

When the agents are configured for clustering, their startup files are configured with shared 
volume names rather than specific server names. In addition, the POA is configured to more 
effectively re-establish logins with GroupWise clients when a failover or migration situation 
arises.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 3: Installation Path, record the directory where you want to install the GroupWise agent 
software.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 6: Domains, record the domain name and path to the domain directory for the new domain.

Under Item 7: Post Offices, record the post office name and path to the post office directory for the 
new post office.

Domains and post offices must exist before you install the agents for them. If necessary, create the 
domains and post offices that you are installing the agents for.
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Additional configuration of the Agent objects in ConsoleOne® is required to complete the agent 
setup in a clustering environment, as described in “Setting Up a Domain and Post Office in a 
Novell Cluster” in “Novell Cluster Services” in the GroupWise 6.5 Interoperability Guide (http:/
/www.novell.com/documentation/gw65):

Configuring the Windows Agents
When you install the Windows agents, you have choices about how the agents interact with the 
Windows operating system.

“Configuring the Windows Agents as Services” on page 160

“Using SNMP Traps to Monitor the Windows Agents” on page 161

Configuring the Windows Agents as Services

When you run the GroupWise Windows agents as services, they can start automatically and run 
without a user interface.

When you run the Windows agents as services, they must run under a specific Windows user 
account. 

When domains and post offices are located on the same server where you are installing the agents, 
the agents can run under the local system account. You can also display the agent consoles when 
the agent software, directories, and databases are local. 

When domains and post offices are located on a remote server, you must specify a user with rights 
to access the domain and post office directories. If the Windows agents need to log in to a 
Windows server, provide a Windows username and password. If the Windows agents need to log 
in to a NetWare server, provide an existing eDirectory username and password, or create a new 
account for the agents, as described in “Creating a NetWare Account for Agent Access (Optional)” 
on page 163.

As with all Windows services, the Windows agents can be started automatically or manually as 
services each time the Windows server restarts.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 4: Configuring GroupWise Agents for Clustering, mark whether or not you want to 
configure the NetWare agents for clustering.

If you are using clustering, under Item 11: Launch in Protected Mode, mark that you want the Agent 
Installation program to start the agents in Protected Mode. This is required in a clustering environment.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 8: Installation Options, mark Install as Windows Services if you want to run the agents as 
services.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 9: Windows Service Information, record the account the agents will run under, and if 
necessary, the password for the account.
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Using SNMP Traps to Monitor the Windows Agents

If you want to use an SNMP manager program, such as the Management and Monitoring Services 
component of Novell ZENworks® Server Management, to monitor the agents, you must install 
some SNMP components along with the Windows agent software.

NOTE: The NetWare and Linux agents rely on operating system components for SNMP functionality and do 
not require this installation option.

Deciding Which Languages to Install
If you have users with various language preferences, you can install the GroupWise agents in 
multiple languages. 

By default, the agents start in the language selected for the domain. If that language has not been 
installed, the agents start in the language used by the operating system. If that language has not 
been installed, the agents start in English.

Setting Up the GroupWise Agents
After creating a new domain or post office, you need to configure the Agent object that was 
automatically created with it, then follow the setup instructions for the platform where you are 
installing the GroupWise agents:

“Configuring New Agent Objects in eDirectory” on page 162

“Setting Up the GroupWise Agents on NetWare” on page 162

“Setting Up the GroupWise Agents on Linux” on page 165

“Setting Up the GroupWise Agents on Windows” on page 171

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 9: Windows Service Information, mark how you want the Windows agents to start each 
time the server is restarted.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 8: Installation Options, mark Install and Configure SNMP for GroupWise Agents if you 
want to use an SNMP manager program.

If this option is dimmed during installation, the SNMP service has not been enabled on the Windows 
server where you are installing the agents. If you want to monitor the agents from an SNMP 
management program, the SNMP service must be enabled so you can select this option.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 5: Languages, list the languages you want to install the agents for.
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Configuring New Agent Objects in eDirectory
When you create new post offices and domains, Agent objects are automatically created for them. 
Most agent configuration can be done after installation, but a few settings should be established 
before you install the agent software.

In ConsoleOne:

1 Browse to and expand the eDirectory container where the new post office or domain is located 
to display its contents.

2 Select the Post Office object or Domain object to display its contents.

3 Right-click the Agent object, then click Properties to display the agent Identification page.

4 In the Description field, type a brief description of the agent for display at the agent console.

5 In the Platform field, select NetWare, Linux, or Windows.

6 Click OK to save the new Agent object properties.

7 Repeat these steps for each new post office and domain for which you are installing agents.

8 Continue with the installation instructions for the platform where you are installing the 
GroupWise agents.

“Setting Up the GroupWise Agents on NetWare” on page 162

“Setting Up the GroupWise Agents on Linux” on page 165

“Setting Up the GroupWise Agents on Windows” on page 171

Setting Up the GroupWise Agents on NetWare
Complete the following tasks to set up the GroupWise NetWare agents. These tasks are designed 
to help you get the agents up and running as quickly as possible.

“Preparing the NetWare Server for the Agents” on page 162

“Installing the NetWare Agent Software” on page 163

“Editing the NetWare Agent Startup Files” on page 165

Preparing the NetWare Server for the Agents

Make sure the NetWare server where you plan to install the GroupWise agents has been properly 
prepared to run the agents:

“Obtaining a Static IP Address” on page 162

“Creating a NetWare Account for Agent Access (Optional)” on page 163

“Adding the NetWare Agent Installation Directory to the Server Search Path (Optional)” on 
page 163

Obtaining a Static IP Address

The NetWare server where the GroupWise agents run should have a static IP address. DHCP 
should not be used to dynamically assign an IP address for it. Make sure the server where you plan 
to install the agents has a static IP address.
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Creating a NetWare Account for Agent Access (Optional)

When the GroupWise agents run on a different NetWare server from where their directories and 
databases are located, and they are not set up to authenticate through eDirectory (using the /dn 
startup switch), the agents must use a specific eDirectory username and password to log in to that 
server.

To create a user for the agents to log in as:

1 In ConsoleOne, create a new user (such as GWAgents).

2 Provide a password for that user (such as GWise).

3 Grant that user the following rights to all domain, post office, and document storage 
directories:

Read or execute files

Write to files

Create files or directories

Erase files or directories

Modify files (rename or change attributes)

File scan

4 Add the /user and /password startup switches to the agent startup files so that the agents can 
log in to the remote server as the user you have created.

Adding the NetWare Agent Installation Directory to the Server Search Path (Optional)

If you have selected a directory other than sys:\system to install the agents to, add the agent 
installation directory to the server search path by adding a search command to the autoexec.ncf 
file.

Installing the NetWare Agent Software

After you have prepared the NetWare server to run the GroupWise agents, you are ready to install 
them.

At a Windows machine:

1 Map a drive to the NetWare server where you want to install the agents. 

2 Make sure you have sufficient rights to install software in the desired directory.

3 Run setup.exe at the root of the GroupWise 6.5 Administrator CD > click Install Products > 
GroupWise Agents > Install GroupWise Agents.

or

Run install.exe from the \agents subdirectory on the CD or in your software distribution 
directory if you have updated it with GroupWise 6.5 software. 

4 Follow the on-screen instructions to install the GroupWise agents on the NetWare server, 
supplying the information you gathered on the “GroupWise Agent Installation Worksheet” on 
page 174, until you reach the Installation Complete page.
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The Agent Installation program has created a grpwise.ncf file that contains the commands to 
start the GroupWise agents on the NetWare server whenever the server starts. Here at the end 
of the Agent Installation program, you can select how you want to start the agents.

Update AUTOEXEC File: Select this option if you want the Agent Installation program to 
add the grpwise.ncf file to the NetWare autoexec.ncf file so that the agents start automatically 
whenever the server restarts.

Launch GroupWise Agents Now: Select this option if you want the Agent Installation 
program to start the agents for you immediately. This is appropriate when you have installed 
the agents on the same server with the domain and post office directories.

If you have installed the agents on a remote server from where the domain and post office 
directories are located, do not select this option. You must manually edit the agent startup files 
to configure the agents to access the remote servers. This configuration procedure is explained 
in “Editing the NetWare Agent Startup Files” on page 165.

Launch in Protected Mode: If you want the Agent Installation program to launch the agents 
for you, you can choose to launch them in Protected Mode on NetWare 5.1 and later. This 
option also adds the protect command to the grpwise.ncf line in the NetWare autoexec.ncf 
file:

protect grpwise.ncf

This line automatically starts the agents in Protected Mode when the server restarts.

5 Select the desired agent startup options, then click Finish.

If you encounter any problems starting the agents or if you chose not to have the Agent 
Installation program start the agents for you, refer to “Post Office Agent” and “Message 
Transfer Agent” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65) for additional instructions. 

If you need the stop the agents, press F7-Exit at the agent console or enter unload gwpoa 
and unload gwmta at the NetWare server console.

6 If necessary, modify the agent startup files as described in “Editing the NetWare Agent 
Startup Files” on page 165, then manually start the NetWare agents by running grpwise.ncf.

7 To monitor an agent from your Web browser, view the agent Web console by supplying the 
IP address and port number of the agent. For example:

http://172.16.5.18:1677
http://172.16.5.18:7100
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http://172.16.5.18:7180
http://172.16.5.18:7181

When viewing the agent Web console, you can specify the POA client/server port, the MTA 
message transfer port, or the HTTP port you specified when you created the domain or post 
office. The POA client/server port and the MTA message transfer port are automatically 
redirected to their respective HTTP ports.

Editing the NetWare Agent Startup Files

The Agent Installation program creates a customized agent startup file for each domain and post 
office location. The first 8 characters of the post office and domain names became the names of 
the agent startup files, along with an agent-specific extension. For example, if the post office name 
is acctpo, then the POA startup file is named acctpo.poa. The Agent Installation program also 
customizes each startup file with the correct /home switch setting, pointing to the domain or post 
office directory. 

Each startup file also provides a comprehensive list of startup switches, with all but the /home 
switch commented out. You can use any ASCII text editor to set the startup switches required by 
the access method you recorded under Worksheet Item 2: Agents and Locations. The agent startup 
files are located in the agent installation directory.

After modifying the startup files, use the grpwise.ncf file to start the NetWare agents from the 
NetWare server console. 

Setting Up the GroupWise Agents on Linux
Complete the following tasks to set up the Linux agents. These tasks are designed to help you get 
the Linux agents up and running as quickly as possible and to help you manage the agents in the 
future.

“Installing the GroupWise Agents on Linux” on page 165

“Installing the GroupWise Agents Using the Text-Based Installation Advisor” on page 167

“Starting the Linux Agents with a User Interface” on page 168

“Starting the Linux Agents as Daemons” on page 169

“Monitoring the Linux Agents from Your Web Browser” on page 170

“Using Agent Startup Files” on page 170

“Starting the Linux Agents on System Startup” on page 170

“Stopping the Linux Agents” on page 171

Installing the GroupWise Agents on Linux

1 Open a new terminal window, then enter the following command:

xhost + localhost

If you cannot execute this command because the X Window System is not running on the 
Linux server, see “Installing the GroupWise Agents Using the Text-Based Installation 
Advisor” on page 167

2 Become root by entering su and the root password.

3 Change to the root of the GroupWise 6.5 for Linux Administrator CD.
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4 Start the GroupWise Installation Advisor.

./install

5 Select the language in which you want to run the Installation Advisor and install the agent 
software, then click OK.

6 In the Installation Advisor, click Install Products > GroupWise Agents > Install GroupWise 
Agents.

7 When the file copy is complete, click OK.

The GroupWise agent software is installed to the bin and lib subdirectories of /opt/novell/
groupwise/agents.

8 Click Configure GroupWise Agents.

The agent installation and configuration steps are separate so that you can install updated 
agent software without needing to repeat the agent configuration steps.

9 Review the Introduction, then click Next.

10 Accept the License Agreement, then click Next.

11 Provide the domain and post office information that the agents need:
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11a Click Add, select Domain, specify the domain name and domain directory, then click 
OK.

11b Click Add, select Post Office, specify the post office name and post office directory, then 
click OK.

11c Verify that the names and directories you have provided are correct, then click Next.

On the Configuration Complete page, Launch GroupWise Agents on System Startup is 
selected by default. 

12 If you do not want the agents to start automatically when the server restarts, deselect Launch 
GroupWise Agents on System Startup.

13 Click Exit to complete the configuration.

14 Skip to “Starting the Linux Agents with a User Interface” on page 168 or “Starting the Linux 
Agents as Daemons” on page 169 depending on whether or not you want a user interface on 
the Linux server where the agents run.

Installing the GroupWise Agents Using the Text-Based Installation Advisor

If you want to install the GroupWIse agents on a server where the X Window System is not 
running, you can use the text-based Installation Advisor.

1 Make sure you are logged in as root.

2 Change to the root of the GroupWise 6.5 for Linux Administrator CD.

3 Start the GroupWise Installation Advisor.

./install

4 Press any key to display the License Agreement.

5 Press any key to scroll through the License Agreement, then enter y to accept the License 
Agreement.

6 Enter 1 for GroupWise Agents.

7 Enter 1 for Install GroupWise Agents.

A status bar indicates progress.

8 Enter y to configure the GroupWise agents.

9 Enter 1 to continue.

10 If you want to configure the MTA, enter 1 to specify the domain, enter the domain name, then 
enter the path to the domain directory.

11 If you want to configure the POA, enter 2 to specify the post office, enter the post office name, 
then enter the path to the post office directory.

12 Enter 3 to review the information you have provided, then press any key to continue.

13 Enter 4 to configure the agents, then press any key to exit.

14 Skip to “Starting the Linux Agents as Daemons” on page 169.

Starting the Linux Agents with a User Interface

1 Make sure you are logged in as root.

2 Change to the GroupWise agent bin directory.

cd /opt/novell/groupwise/agents/bin
Installing GroupWise Agents 159



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
3 Enter the following command to start the MTA:

Syntax:
./gwmta --show --home domain_directory &

Example:
./gwmta --show --home /gwsystem/domlnx &

The --show startup switch starts the MTA with an agent console interface similar to that 
provided for the NetWare and Windows MTA. This user interface requires that the X Window 
System and OpenMotif be running on the Linux server.

The --home startup switch specifies the domain directory and is required to start the MTA.

The ampersand (&) causes the MTA to run in the background, so that the terminal window 
you started it in is again available for use.

The status messages displayed on the MTA agent console are also written to the MTA log file 
(mmddmta.nnn) in the /var/log/novell/groupwise/domain.mta directory. The log file name 
includes the month and day when it was created, along with an incrementing extension to 
accommodate multiple log files on the same day.

In ConsoleOne, you can see that the MTA has updated the domain database because the 
Version field on the Domain object shows 6.5 when the update is complete.

4 Wait until the domain database has been updated before you start the POA.

5 Use the following command to start the POA:

Syntax:
./gwpoa --show --home post_office_directory &

Example:
./gwpoa --show --home /gwsystem/polnx &
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The status messages displayed on the POA agent console are also written to the POA log file 
(mmddpoa.nnn) in the /var/log/novell/groupwise/post_office.poa directory. The log file name 
includes the month and day when it was created, along with an incrementing extension to 
accommodate multiple log files on the same day.

In ConsoleOne, you can see that the POA has updated the post office database because the 
Version field on the Post Office object shows 6.5 when the update is complete.

If you encounter any problems starting the agents, see “Post Office Agent” and “Message 
Transfer Agent” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65) for additional instructions. 

After the post office database has been updated, users can connect to the post office using 
either the Cross-Platform client or the Windows client.

6 Skip to “Monitoring the Linux Agents from Your Web Browser” on page 170

Starting the Linux Agents as Daemons

1 Make sure you are logged in as root.

2 Change to the /etc/init.d directory.

3 To start the Linux agents, enter the following command:

./grpwise start

4 To confirm that the agents have started, enter the following command:

ps -eaf | grep gw

This lists all GroupWise agent process IDs.

5 Continue with Monitoring the Linux WebAccess Agent from Your Web Browser.

Monitoring the Linux Agents from Your Web Browser

To monitor an agent from your Web browser, view the agent Web console by supplying the IP 
address and port number of the agent. For example:

http://172.16.5.18:1677
http://172.16.5.18:7100
http://172.16.5.18:7180
http://172.16.5.18:7181
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When viewing an agent Web console, you can specify the client/server port for the POA, the 
message transfer port for the MTA, or the HTTP port you specified when you created the post 
office or domain. The POA client/server port and the MTA message transfer port are automatically 
redirected to their respective HTTP ports.

For instructions on protecting the agent Web consoles with passwords see “Using the POA Web 
Console” in “Post Office Agent” and “Using the MTA Web Console” in “Message Transfer 
Agent” in the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/
gw65).

Using Agent Startup Files

The agent startup files are created by the Installation Advisor in the /opt/novell/groupwise/agents/
share directory and are named after the domain or post office that the agent services. Because the 
Installation Advisor prompted you for domain and post office names and directories, it can set the 
--home startup switches in the MTA and POA startup files. In the bin directory where the agent 
executables are located, you could start the agents with commands similar to the following 
examples:

./gwmta --show @../share/LnxDom.mta

./gwpoa --show @../share/LnxPost.poa

Starting the Linux Agents on System Startup

If you selected Launch GroupWise Agents on System Startup in the Agent Installation program, 
the Agent Installation program configured your system so that the agents would start automatically 
each time you restart your server. The Agent Installation program always creates a grpwise startup 
script in /etc/init.d for starting the agents. To enable automatic startup, the Agent Installation 
program also creates symbolic links named S99grpwise in the rc3.d and rc5.d directories so that 
the agents load on restart into level 3 or 5, depending on the configuration of your Linux system.

When the grpwise script runs and starts the agents, it reads the agent startup files in /opt/novell/
groupwise/agents/share to check for configuration information provided by startup switches. 
Because the --show switch cannot be used in the startup files, the agents never run with agent 
console interfaces when started automatically when the server restarts.

Stopping the Linux Agents

When you use the --show startup switch to start the MTA and POA, you can stop them from the 
agent console interface.

1 Click File > Exit > Yes.
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When you start the GroupWise agents with the grpwise script, you can also use the script to stop 
them.

1 Make sure you are logged in as root.

2 Change to the /etc/init.d directory.

3 To stop the GroupWise agents, enter the following command:

./grpwise stop

4 To confirm that the agents have stopped, enter the following commands:

ps -eaf | grep gwmta
ps -eaf | grep gwpoa

The only gwmta and gwpoa process IDs you should see listed are the ones for the grep 
commands.

When you start the GroupWise agents manually (without using the grpwise script), use the 
standard Linux kill command to stop them.

1 Make sure you are logged in as root.

2 Determine the process IDs (PIDs) of the MTA and POA:

ps -eaf | grep gwmta
ps -eaf | grep gwpoa

The PIDs for all gwmta and gwpoa processes are listed.

3 Kill the first process listed for each agent:

Syntax:
kill PID

Example:
kill 1483
kill 1892

It might take a few seconds for all agent processes to terminate.

4 Repeat the ps commands to verify that the agents have stopped.

Setting Up the GroupWise Agents on Windows
Complete the following tasks to set up the Windows agents. These tasks are designed to help you 
get the Windows agents up and running as quickly as possible:

“Preparing the Windows Server for the Windows Agents” on page 172

“Installing the Windows Agent Software” on page 172

Preparing the Windows Server for the Windows Agents

Make sure the Windows server where you plan to install the GroupWise Windows agents has been 
properly prepared to run the agents:

“Obtaining a Static IP Address” on page 172

“Mapping Drives to Post Offices and Domains” on page 172

“Creating a Windows User Account for Remote Access (Optional)” on page 172

“Enabling SNMP (Optional)” on page 172
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Obtaining a Static IP Address

The Windows server where the GroupWise Windows agents run should have a static IP address. 
DHCP should not be used to dynamically assign an IP address for it. Make sure the server where 
you plan to install the Windows agents has a static IP address.

Mapping Drives to Post Offices and Domains

The POA requires direct access to the post office directory and the MTA requires direct access to 
the domain directory. If the agents are not installed on the same server where their directories are 
located, make sure the server has drives mapped to all locations where the agents need access. 

After installation, the agents can access their directories using either mapped drives or UNC paths. 
However, mapped drives are required during installation so that the agent startup files can be set 
up properly.

Creating a Windows User Account for Remote Access (Optional)

If you specified a new Windows username and password under Worksheet Item 9: Windows 
Services Information, create the new Windows user account so it is ready when you start the agents 
for the first time. Follow the instructions for your Windows version:

In Windows NT, click Start > Programs > Administrative Tools > User Manager to create a 
new user.

In the Control Panel of Windows 2000, double-click Users and Passwords to add a new user.

Grant the user Full Control rights in the domain and post office directories.

Enabling SNMP (Optional)

If you want to monitor the GroupWise Windows agents from an SNMP manager program, such as 
the Management and Monitoring Services component of Novell ZENworks Server Management, 
SNMP must be enabled on the Windows server where the agents are installed. If it is not already 
enabled, you should enable it before you run the Agent Installation program. Follow the 
instructions for your Windows version:

In the Control Panel in Windows NT, double-click Network > click Services > Add > double-
click SNMP.

In the Control Panel in Windows 2000, double-click Add/Remove Programs > click Add/
Remove Windows Components > double-click Management and Monitoring Tools > select 
Simple Network Management Protocol.

Installing the Windows Agent Software

After you have prepared the Windows server to run the GroupWise Windows agents, you are ready 
to install them.

At the Windows server where you want to install the Windows agents:

1 Make sure you have mapped drives to all domain and post office directories for which you are 
installing agents.

2 Run setup.exe at the root of the GroupWise 6.5 Administrator CD > click Install Products > 
GroupWise Agents > Install GroupWise Agents.

or

Run install.exe from the \agents subdirectory on the CD or in your software distribution 
directory if you have updated it with GroupWise 6.5 software. 
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3 Follow the on-screen instructions to install the GroupWise agents on the Windows server, 
supplying the information you gathered on the “GroupWise Agent Installation Worksheet” on 
page 174, until you reach the Installation Complete page.

4 Choose whether or not you want the Agent Installation program to start the agents for you 
immediately, then click Finish.

If you encounter any problems starting the agents or if you chose not to have the Agent 
Installation program start the agents for you, see “Post Office Agent” and “Message Transfer 
Agent” in the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/
gw65) for additional instructions. 

If you need to stop the agents and they are running as applications in their own windows, click 
File > Exit in each window. If they are running as Windows services, open the Services 
window (from the Control Panel or Administrative Tools), right-click each agent service, then 
click Stop.

5 To monitor an agent from your Web browser, view the agent Web console by supplying the 
IP address and port number of the agent. For example:

http://172.16.5.18:1677
http://172.16.5.18:7100
http://172.16.5.18:7180
http://172.16.5.18:7181

When viewing the agent Web console, you can specify the POA client/server port, the MTA 
message transfer port, or the HTTP port you specified when you created the post office or 
domain.

What’s Next
After you have created new domains and post offices, and installed the agents for them, you can 
complete their configuration by:

Refining the configuration of the agents to meet the specific needs of the new domains and 
post offices. See “Post Office Agent” and “Message Transfer Agent” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

Refining the configuration of the new domains and post offices. See “Post Offices” and 
“Domains” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

Adding users to the new post offices. See “Users” in the GroupWise 6.5 Administration Guide 
(http://www.novell.com/documentation/gw65).
Installing GroupWise Agents 165

http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw65


    Novell Confidential                                                                                            Manual (99a)  21 December 2004
GroupWise Agent Installation Worksheet

Item Explanation

1) Agent Platform:

NetWare

Linux

Windows

Mark the platform where you are installing the GroupWise agents.

2) Agents and Locations:

POA:

Local to post office

Different server from post office

/dn setting (NetWare only)

MTA:

Local to domain

Different server from domain

/dn setting (NetWare only)

Mark the agents you want to install and where you want to install them. 

On NetWare, if you want to install the agents on a server different from where their 
directories and databases are located, specify the settings for the /dn startup 
switches the agents can use to access the remote servers.

For more information, see “Selecting the Agent Location” on page 158.

3) Installation Path: Specify the directory where you want to install the agent software. 

For more information, see “Selecting the Agent Installation Directory” on page 159.

4) Configure NetWare Agents for 
Clustering: 
Yes | No

This item applies only if you are installing the NetWare agents.

Mark whether or not you want to optimize the NetWare agents for use with Novell 
Cluster Services.

For more information, see “Clustering the NetWare Agents” on page 159.

5) Languages: List the languages you want to install.

For more information, see “Deciding Which Languages to Install” on page 161.

6) Domains:

Domain name:

Path to database:

List the domains you are installing the MTA for.

For more information, see “System and Domain Names” on page 28 and “Domain 
Directory” on page 29.

7) Post Offices:

Post office name:

Path to database:

List the post offices you are installing the POA for.

For more information, see “Post Office Name” on page 33 and “Post Office Directory” 
on page 33.
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8) Installation Options:

Install GroupWise agent software: 
Yes | No

Install and configure SNMP for 
GroupWise agents: 
Yes | No

Install as Windows services: 
Yes | No

This item applies only if you are installing the Windows agents.

Mark the installation options you want when you install the Windows agents.

For more information, see “Selecting the Agent Location” on page 158, “Using SNMP 
Traps to Monitor the Windows Agents” on page 161, and “Configuring the Windows 
Agents as Services” on page 160.

9) Windows Service Information:

Account type:

Use local system account

Allow service to interact with 
desktop: 
Yes | No

Use this Windows user account:
User name:
Password:

Startup type:

Automatic

Manual

Disabled

This item applies only if you are installing the Windows agents.

If you are installing the Windows agents as services, mark the type of account they 
can use to log in. 

If needed, specify the Windows user account they can run under. 

Also mark whether you want them to be started automatically or manually each time 
the Windows server restarts.

For more information, see “Configuring the Windows Agents as Services” on 
page 160.

10) Launch GroupWise Agents Now: 

Yes | No

Mark whether or not the Agent Installation program can start the agents for you at the 
end of the installation process.

11) Launch in Protected Mode:

Yes | No

This item applies only if you are installing the NetWare agents.

Mark whether or not you want the Agent Installation program to start the NetWare 
agents in Protected Mode on NetWare 5.1 or above.

Item Explanation
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8 Installing the GroupWise Windows and Cross-
Platform Clients

The following sections assist you with assigning GroupWise accounts to users and with installing 
the Novell® GroupWise® 6.5 Windows client and the GroupWise 6.5 Cross-Platform client.

“GroupWise Client Overview” on page 177

“GroupWise Client Workstation Requirements” on page 177

“Planning Your GroupWise Client Installation” on page 178

“Setting Up the GroupWise Client” on page 179

GroupWise Client Overview
Each user with a GroupWise account has a mailbox in a post office. In a corporate workplace 
environment, GroupWise users with Windows workstations can run the GroupWise Windows 
client to access their mailboxes and to send and receive mail. GroupWise users with Linux or 
Macintosh workstations can run the GroupWise Cross-Platform client. 

GroupWise users can also access their mailboxes via a Web browser, WAP-enabled wireless 
telephone, Palm OS device, or Windows CE device by using the GroupWise WebAccess client. 
For information about WebAccess, see Chapter 5, “Installing GroupWise WebAccess,” on 
page 99.

The GroupWise Windows client provides a full set of features, the GroupWise WebAccess client 
provides a similar but more limited set of features, and the GroupWise Cross-Platform client 
provides a basic set of features. Subsequent releases of the Cross-Platform client will include 
additional features.

GroupWise Client Workstation Requirements

GroupWise Windows Client
Any of the following Windows versions:

Windows 98 on a Pentium 133 or higher with at least 48 MB RAM

Windows NT on a Pentium 133 or higher with at least 64 MB RAM

Windows 2000 on a Pentium 200 or higher with at least 128 MB RAM

Windows XP on a Pentium 300 or higher with at least 128 MB RAM

60 MB of free disk space to install the GroupWise Windows client
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GroupWise Cross-Platform Client
Any of the following desktop operating systems:

SUSE® Linux Desktop, SUSE Linux 8.2, or SUSE Linux 9 Professional, plus the KDE 
desktop or the GNOME desktop

Red Hat 9 or Red Hat Enterprise 3 WS, plus the GNOME desktop

Macintosh OS 10.3 (Panther)

Java Virtual Machine (JVM) 1.4.2 or later

40 MB of free disk space to install the GroupWise Cross-Platform client

Planning Your GroupWise Client Installation
“Assigning GroupWise Accounts to Users” on page 178

“System-Wide Rollouts” on page 179

Assigning GroupWise Accounts to Users
After you’ve finished your basic GroupWise system setup, you need to add users to the post office 
before they can log in to a GroupWise client. To do so, follow the instructions in one of the 
following sections:

“Assigning GroupWise Accounts to eDirectory Users” on page 178

“Assigning GroupWise Accounts to Non-eDirectory Users” on page 178

Assigning GroupWise Accounts to eDirectory Users 

To give an eDirectoryTM user a GroupWise account on the post office:

1 In ConsoleOne®, right-click the user you want to give an account to, then click Properties.

2 Click the GroupWise tab to display the GroupWise Account page.

3 In the Post Office field, click the Browse button to select the post office.

4 In the Mailbox ID field, enter the name the user will use when logging in to his or her mailbox. 
The field defaults to the eDirectory username. 

5 Click OK.

Assigning GroupWise Accounts to Non-eDirectory Users

You give a non-eDirectory user a GroupWise account on a post office by adding the user to 
eDirectory as a GroupWise external entity.

To add a user as a GroupWise external entity:

1 In ConsoleOne, right-click the container where you want to create the GroupWise external 
entity, click New, then click Object to display the New Object dialog box.

2 In the list, select GroupWise External Entity, then click OK to display the Create GroupWise 
External Entity dialog box.

3 Define the following properties:
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GroupWise Object ID: Enter the user’s GroupWise ID. The user’s ID, along with the user’s 
post office and domain, provide the user with a unique name within the GroupWise system.

Last Name: Enter the user’s last name.

GroupWise Post Office: Select the post office where you want the user’s mailbox.

External Network ID: Enter the user’s network ID for the network that he or she logs in to.

Define Additional Properties: Select this option so that you can define additional 
information such as the user’s first name. The user’s first name appears in the GroupWise 
Address Book.

Create Another External Entity: As soon as you select Define Additional Properties, this 
option becomes unavailable. Repeat Step 1 through Step 3 if you need to create additional 
GroupWise external entities.

4 Click Create.

5 Enter the user’s first name in the Given Name field.

6 Fill in any other fields you want, then click OK.

The user is given a GroupWise account on the post office you selected and can access his or 
her mailbox through the GroupWise client.

Logging in to GroupWise as a Non-eDirectory User

Because non-eDirectory users do not log in to eDirectory, the GroupWise clients cannot use the 
GroupWise information in eDirectory to automatically log in to the users’ post office. When a non-
eDirectory user starts a GroupWise client for the first time, he or she is prompted for a GroupWise 
user ID and post office location (IP address and port number). You need to provide non-eDirectory 
users with this information.

If you don’t want to provide non-eDirectory users with the post office information, you can 
automate the login process by creating a GroupWise name server. A GroupWise name server is a 
DNS hostname entry that defines the TCP/IP address of the POA. During startup, the GroupWise 
client automatically looks for the GroupWise name server in DNS. For information about creating 
a GroupWise name server, see “Post Office Agent” in the GroupWise 6.5 Administration Guide 
(http://www.novell.com/documentation/gw65).

System-Wide Rollouts
For a system-wide rollout of the GroupWise client software, you might want to consider 
alternatives to each user installing from the CD or the software distribution directory.

For the GroupWise Cross-Platform client, you can use Ximian® Red CarpetTM for a system-wide 
rollout.

For the GroupWise Windows client, if you have Novell ZENworks® Desktop Management, you 
can use it, along with the preconfigured .aot files included with GroupWise 6.5, to distribute the 
client. Or, you can have a login script run the client setup program with a response file to perform 
a silent install on workstations.

For more information about these and other installation methods, see “Client” in the GroupWise 
6.5 Administration Guide (http://www.novell.com/documentation/gw65). 
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Setting Up the GroupWise Client
“Setting Up the GroupWise Windows Client” on page 179

“Setting Up the GroupWise Cross-Platform Client” on page 181

Setting Up the GroupWise Windows Client
“Installing the Windows Client” on page 180

“Starting the Windows Client” on page 180

Installing the Windows Client

1 At the user’s workstation, insert the GroupWise 6.5 Client CD in the CD drive.

or

Map a drive to the client files in the software distribution directory. 

During the installation of your GroupWise system, the client files were copied to the software 
distribution directory on your server. For example, if you accepted the default 
z:\grpwise\software as your target, the client software was copied to 
z:\grpwise\software\client\win32.

The setup program (setup.exe) can be run from the software distribution directory. In order to 
run this setup program, users require rights to client\win32 in the software distribution 
directory. The minimum rights required are Read and File Scan.

2 From the Windows taskbar, click Start > Run.

3 Browse to the GroupWise 6.5 Client CD or the client\win32 directory in the software 
distribution directory, then select setup.exe.

4 Click OK, follow the prompts until you reach the Setup Options screen, then click one of the 
following options:

Workstation Install: Allows the user to run GroupWise from the network, which saves disk 
space on the user's hard drive. 

Standard Install: Installs all of the client files on the user’s hard drive. This option is required 
when the computer will run GroupWise in Caching or Remote mode. See “Client” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65) for 
more information about setting up GroupWise Remote and Caching modes.

5 Click the Browse button to select a different Destination Folder path or click Next to select 
the default.

6 Make sure each component you want to install is selected, then click Next.

GroupWise: This component is required.

Internet Browser Mail Integration: Sets GroupWise to be the default e-mail program on the 
workstation, so that whenever the user clicks an e-mail link on a Web page or chooses the Mail 
command in the browser (Internet Explorer 3.x and higher, Netscape Navigator 4.03-4.08), 
GroupWise starts.

GroupWise Tip of the Day: The Tip of the Day displays different hints about using 
GroupWise. A new tip is displayed each time GroupWise is started. The user can disable Tip 
of the Day at any time.

7 Continue to follow the prompts and select the options you want. When the setup program has 
completed, a shortcut to run GroupWise appears on the user's desktop. 
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Starting the Windows Client

At startup, the GroupWise client needs to know the location (IP address/hostname and port 
number) of the user’s post office. There are three ways that the client can get this information:

If the user is logged into eDirectory, the GroupWise client can read eDirectory for the post 
office’s location.

If the user is not logged into eDirectory, the GroupWise client can use a GroupWise name 
server to get the user’s post office location. A GroupWise name server is a DNS hostname 
entry that defines the IP address of the post office’s POA. During startup, the GroupWise 
client automatically looks for the GroupWise name server in DNS. For information about 
creating a GroupWise name server, see “Post Office Agent” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

The user can provide the post office location when prompted.

To start the GroupWise client for the first time:

1 Double-click the GroupWise icon on the Windows desktop.

2 Enter the password and post office address information, then click OK.

Setting Up the GroupWise Cross-Platform Client
“Setting Up the GroupWise Cross-Platform Client on Linux” on page 181

“Setting Up the GroupWise Cross-Platform Client on Macintosh” on page 182

Setting Up the GroupWise Cross-Platform Client on Linux

“Installing the Cross-Platform Client on Linux” on page 181

“Starting the Cross-Platform Client on Linux” on page 182

Installing the Cross-Platform Client on Linux

1 Open a new terminal window, then enter the following command:

xhost + localhost

2 In the same window, become root by entering su and the root password.

3 Change to the root of the GroupWise 6.5 for Linux Cross-Platform Client CD.

4 Enter ./install.

5 Select the language in which you want to run the Installation Advisor and install the Cross-
Platform client software, then click OK.

6 In the Installation Advisor, click Install Products > Install GroupWise Client.

The GroupWise Client is installed to the bin and lib subdirectories of /opt/novell/groupwise/
client.

7 When the installation is complete, click OK.

You can also install the Cross-Platform client by changing to the client/linux directory on the 
GroupWise 6.5 for Linux Cross-Platform Client CD, then running the .rpm.
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Starting the Cross-Platform Client on Linux

1 At the command line, change to the /opt/novell/groupwise/client/bin directory.

2 Enter the following:

./groupwise

3 Specify the username, password, and server information, then click OK.

For your convenience, a Cross-Platform client icon is automatically created on your desktop.

Setting Up the GroupWise Cross-Platform Client on Macintosh

Installing the Cross-Platform Client on Macintosh

1 Browse to the GroupWise.app.sit file on the GroupWise 6.5 for Linux Cross-Platform Client 
CD.

2 Double-click the GroupWise.app.sit file to install the Cross-Platform client software.

The installation process adds a GroupWise Cross-Platform client icon to your desktop.

Starting the Cross-Platform Client on Macintosh

1 Double-click the GroupWise Cross-Platform client icon to start the Cross-Platform client.

2 Specify the username, password, and server information, then click OK.

What’s Next
For information about using the features in the GroupWise Windows and GroupWise Cross-
Platform clients, click Help > Help Topics, or Help > User Guide in the client. The user guides are 
both available on the GroupWise 6.5 documentation Web site (http://www.novell.com/
documentation/gw65/index.html).
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9 Installing GroupWise Messenger

Novell® GroupWise® Messenger is a corporate-based, secure instant messaging solution that 
supports instant messaging, presence, and archiving of conversations. The Messenger client 
integrates with the GroupWise client to provide access to instant messaging features from with the 
GroupWise client.

GroupWise Messenger is installed separately from GroupWise and does not rely on your 
GroupWise system. All Messenger information is stored in eDirectory, not in GroupWise 
databases. For information, see the Novell GroupWise Messenger Installation Guide 
(NovellMessengerInstallationGuide.pdf) in the \server\docs\en directory on the Novell GroupWise 
Messenger CD.
Installing GroupWise Messenger 175



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
176   GroupWise 6.5 Installation Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
II Update

Chapter 10, “What’s New in GroupWise 6.5 for Linux,” on page 179
Chapter 11, “What’s New in GroupWise 6.5,” on page 181
Chapter 12, “Understanding the Update Process,” on page 205
Chapter 13, “Preparing Your GroupWise System,” on page 211
Chapter 14, “Updating Your GroupWise 6.x System to Version 6.5,” on page 213
Chapter 15, “Updating Your GroupWise 5.x System to Version 6.5,” on page 229
Chapter 16, “Updating an Evaluation GroupWise System to a Fully Licensed System,” on 

page 231
Chapter 17, “Moving Your Existing GroupWise System to Linux,” on page 233
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10 What’s New in GroupWise 6.5 for Linux

GroupWise® 6.5 for Linux is GroupWise 6.5 Support Pack 1 running on Linux. It includes all the 
standard GroupWise components, plus a new client:

GroupWise System on Linux: The GroupWise Installation Advisor helps you create a new 
GroupWise system on your Linux server.

GroupWise Administration on Linux: You can install the GroupWise Administrator snap-
ins to the Linux version of ConsoleOne® to administer GroupWise domains and post offices 
located on Linux, NetWare®, and Windows servers.

GroupWise Agents on Linux: All the GroupWise Agents (Post Office Agent, Message 
Transfer Agent, Internet Agent, WebAccess Agent, and Monitor Agent) run on Linux as 
daemons that can start automatically when the server restarts. The POA, MTA, and Internet 
Agent can be monitored from their agent consoles on the servers where they run. All the 
agents can be monitored using their Web consoles.

GroupWise Cross-Platform Client on Linux and Macintosh: The GroupWise Cross-
Platform client provides the same look and feel as the GroupWise Windows client and is 
available for use on Linux and Macintosh. The initial release includes most major features of 
the Windows client. Future releases will bring it even closer to full feature parity with the 
Windows client.

For a list of Linux-specific updates to this GroupWise 6.5 Installation Guide, see Appendix C, 
“Documentation Updates,” on page 257.
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11 What’s New in GroupWise 6.5

Novell® GroupWise® 6.5 provides substantial improvements over GroupWise 6 in five key areas:

Expanded Client Features: The GroupWise client has an updated look and feel. The new 
Contacts folder provides access to the Frequent Contacts address book in the Address Book 
or any personal address book of your choice. From the Contacts folder, you can view, create, 
and modify contacts, resources, organizations, and groups. The new Checklist folder provides 
an area to create a personal task list. You can move any items to this folder, arrange them in 
the order you want, and check them off as you complete them. In addition, you can view any 
folder as a Checklist, allowing you to reorder messages and other mailbox items into a task 
list. You can assign color-coded categories messages, appointment, contacts, and so on and 
edit the displayed subject of any item, allowing you to more efficiently manage your mailbox.

Improved Security: Secure Sockets Layer (SSL) connections can now be required by the 
administrator for all client access (GroupWise, POP3, and IMAP4) to GroupWise mailboxes. 
In addition, the Internet Agent and the WebAccess Agent can connect to post offices using 
SSL connections.

Spam Handling: The GroupWise 6.5 client has a new Junk Mail Handling feature that lets 
users quickly control unwanted Internet e-mail messages (spam) with block lists and by 
automatically filing in the Junk Mail folder all messages from senders that are not in your 
personal address books (including Frequent Contacts). In addition, the Internet Agent can be 
configured to reject messages from known open relay hosts and spam hosts. Combined, these 
features protect users from seeing unwanted messages in their GroupWise mailboxes.

Virus Scanning: By integrating third-party software into GroupWise as trusted applications, 
you can scan messages and attachments for viruses and prevent virus damage to your system.

Instant Messaging: Novell GroupWise Messenger is a corporate-based, secure instant 
messaging solution that supports instant messaging, presence, and archiving of conversations. 
GroupWise Messenger must be installed separately from GroupWise. For information, see the 
Novell GroupWise Messenger Installation Guide (NovellMessengerInstallationGuide.pdf) in 
the \server\docs\en directory on the GroupWise Messenger 1.0 CD.

For a complete listing of all major enhancements and new features in the GroupWise components, 
please refer to the following sections:

“GroupWise Administration” on page 182

“GroupWise Agents” on page 188

“GroupWise Client” on page 189

“GroupWise Internet Agent” on page 194

“GroupWise WebAccess” on page 197

“GroupWise Monitor” on page 202
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GroupWise Administration
GroupWise administration includes the following enhancements and new features. Changes 
included in GroupWise 6.5 are indicated by (v6.5). Changes included in GroupWise 6.5 Support 
Pack 1 are indicated by (v6.5 SP1).

“User Move Status Utility (v6.5)” on page 182

“Recover Deleted Account Utility (v6.5)” on page 182

“Internet Addressing Changes (v6.5)” on page 183

“GroupWise View Enhancements (v6.5)” on page 184

“System Preferences Enhancements (v6.5)” on page 184

“Client Options Updates (v6.5)” on page 185

“Trusted Applications (v6.5)” on page 186

“User Description Display (v6.5)” on page 186

“GroupWise / eDirectory Associations (v6.5)” on page 186

“Multiple Account Deletion (v6.5)” on page 187

“Mailbox Auditing Information Display (v6.5)” on page 187

“Link Configuration Tool Enhancement (v6.5)” on page 187

“Message Retention Service for Trusted Applications (v6.5 SP1)” on page 188

“DirXML Driver Warnings (v6.5 SP1)” on page 188

User Move Status Utility (v6.5)
The User Move Status utility in ConsoleOne® (Tools menu > GroupWise Utilities > User Move 
Status) helps you track progress as you move users from one post office to another. Using the User 
Move Status utility, you can:

List users that are currently being moved and filter the list by domain, post office, and object.

View the current status of the move for each object and see any errors that have occurred.

Immediately retry a move where some of the information on the user inventory list failed to 
arrive at the destination post office. By default, the POA automatically retries every 12 hours 
for seven days to move all the information included on the user inventory list.

Stop the POA from continuing its automatic retries.

Restart (from the beginning) a move that has stopped before successful completion.

Refresh the list to display current move status and clear completed moves from the list.

For more information, see “Monitoring User Move Status” in “Users” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

Recover Deleted Account Utility (v6.5)
If you have a reliable backup procedure in place, you can restore recently deleted user and resource 
accounts in ConsoleOne (Tools menu > GroupWise Utilities > Recover Deleted Account). After 
the account has been re-created, you then restore the corresponding mailbox and its contents 
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(Tools menu > GroupWise Utilities > Backup/Restore Mailbox) to complete the process. 
Membership in distribution lists and ownership of resources must be manually re-established.

For complete instructions, see “Recovering Deleted GroupWise Accounts” in “Databases” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Internet Addressing Changes (v6.5)
The following changes have been made for Internet addressing:

“Allowed Address Formats” on page 183

“Free Form User Address for Internet Addressing Override” on page 183

“Prompt to Synchronize eDirectory E-Mail Address Attribute” on page 183

“IDomains for External Objects” on page 183

Allowed Address Formats

At the system level, you can select which address formats are allowed when receiving messages 
(for example, FirstName.LastName@InternetDomainName, UserID@InternetDomainName, and 
so forth). You can override these allowed address formats at the domain, post office, or user level. 
For example, you could allow all address formats at the system level; however, for a user named 
John Smith, you could override the settings to enable the user to receive messages as jsmith and 
john.smith, but not allow smith.john or jsmith.po.domain.

You set system-level address formats in the Internet Addressing dialog box (ConsoleOne > Tools 
menu > GroupWise System Operations > Internet Addressing.

For more information, see “Planning Internet Addressing” in “System” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

Free Form User Address for Internet Addressing Override

For the Internet Address override at the user level, you can enter the user address in any form as 
long as all characters are RFC compliant (no spaces, commas, etc.). This eliminates the need to 
create gateway aliases for Internet addresses.

This option is set on the User object’s GroupWise Internet Addressing page in ConsoleOne.

For more information, see “Changing a User's Internet Addressing Settings” in “Users” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Prompt to Synchronize eDirectory E-Mail Address Attribute

If you change your Internet addressing options (for example, you change your preferred address 
format), you are prompted to update the eDirectory E-Mail Address attribute for all affected users. 
This prevents out-of-date e-mail address information in eDirectory.

For a large system, the update process might take several minutes. A progress dialog box is 
displayed.

IDomains for External Objects

You can specify an Internet domain (IDomain) for any external (non-GroupWise) domains, post 
offices, and users defined in your system.

Use the GroupWise Internet Addressing page on the Domain, Post Office, or User object.
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GroupWise View Enhancements (v6.5)
The GroupWise View in ConsoleOne, which is displayed in the right pane when you select 
GroupWise System in the left (tree) pane, has been enhanced as follows:

Column Display and Order: For each view (Users, Distribution Lists, Gateways, Post 
Offices, and so forth), you can determine which columns are displayed and the order in which 
they are displayed. To edit the columns for a view, select GroupWise System in the left (tree) 
pane, select the view (for example, Users), click the View menu, then click Edit Columns to 
display the Select GroupWise View Columns dialog box. Use the dialog box to select the 
columns to display and their display order.

Column Widths: You can change column widths in a view by dragging the right or left edge 
of the column label.

Persistent Changes: Changes (width, order, last view) are preserved from one session to the 
next. For example, if you last used the Distribution Lists view, the next time you start 
ConsoleOne and open the GroupWise View, the Distribution Lists view is displayed. If the 
last-used view is not applicable (for example, you had the Gateways view open and when the 
new ConsoleOne session starts you select a Post Office object), the GroupWise View defaults 
to the Users view.

Searching: When listing users in the GroupWise view, you can search for a complete user 
name (both first name and last name) by using a comma as a delimiter between the names. A 
space after the comma is optional.

For example, if the user list displays first names in the first column and last names in the 
second column, you can type John,Smith to go directly to that user name, rather than 
searching on “John” and then scrolling down through several other Johns until you reach 
“Smith.” If the columns were reversed, you could use Smith,John.

For more information, see “GroupWise View” in “System” in the GroupWise 6.5 Administration 
Guide (http://www.novell.com/documentation/gw65).

System Preferences Enhancements (v6.5)
The following enhancements have been made to the GroupWise System Preferences.

“Default Password for New Users” on page 184

“Admin Lockout” on page 184

Default Password for New Users

For convenience when creating numerous GroupWise user accounts, you can establish a default 
password to be assigned to all new GroupWise accounts (ConsoleOne > Tools menu > GroupWise 
System Operations > System Preferences > Default Password for New Users).

For more information, see “System Preferences” in “System” in the GroupWise 6.5 Administration 
Guide (http://www.novell.com/documentation/gw65).

Admin Lockout

You can restrict GroupWise administrators from performing system operations (Tools menu > 
GroupWise System Operations) unless they are connected to the primary domain. All operations, 
except Select Domain and Pending Requests, will be unavailable when connected to a secondary 
domain.
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You configure this option through System Preferences (ConsoleOne > Tools menu > GroupWise 
System Operations > System Preferences > Admin Lockout Settings).

For more information, see “System Preferences” in “System” in the GroupWise 6.5 Administration 
Guide (http://www.novell.com/documentation/gw65).

Client Options Updates (v6.5)
The following updates have been made to Client Options:

“Junk Mail Handling” on page 185

“Force Client Caching Mode” on page 185

“New Views Tab in Environment Options” on page 185

“Restore Default Settings” on page 185

“Locked Settings Show Where the Setting Was Locked” on page 185

“New Lockable Settings” on page 186

For additional information about Client Options, see “Setting Defaults for the GroupWise Client 
Options” in “Users” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

Junk Mail Handling

In Client Options Environment Options, the General tab includes settings for the new Junk Mail 
Handling feature.You can specify whether or not the Junk Mail Handling feature is available for 
a user. This setting affects both the client and the POA. Junk Mail Handling allows users to block 
or junk unwanted Internet e-mail.

Force Client Caching Mode

The Force Caching Mode setting (User object > Tools > Client Options > Environment Options > 
Client Access tab) now includes a field to specify a number of days before Caching mode is 
enforced. This allows the user to continue using Online mode until the grace period has passed. 

New Views Tab in Environment Options

In Client Options Environment Options, there is a new Views tab. The settings Read Next After 
Accept, Decline, or Delete and Open New View After Send have been moved from the General 
tab to the Views tab.

The Disable HTML View setting has also been moved from the General tab to the Views tab.

Restore Default Settings

A Restore Default Settings button is available on every Client Options tab.

Locked Settings Show Where the Setting Was Locked

When settings are locked at the domain or post office level, the information is passed down to the 
levels below it. The lock icons indicate at which level the setting was locked. 
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New Lockable Settings

In previous versions of GroupWise, settings in Client Options that were not available in the 
GroupWise client were not lockable. In this version, these settings are lockable.

Trusted Applications (v6.5)
Trusted applications are third-party programs that can log into the POA in order to access 
GroupWise mailboxes and perform various tasks. The Trusted Applications feature (Tools > 
GroupWise System Operations > Trusted Applications) allows you to edit and delete trusted 
applications that are available in your GroupWise system.

For instructions on creating and installing trusted applications to your GroupWise system, search 
for GroupWise Trusted Application API at the Novell Developer Kit (NDK) Web site (http://
developer.novell.com/ndk).

For information about editing trusted applications, see “Trusted Applications” in “System 
Operations” in “System” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

User Description Display (v6.5)
You can suppress the display of the contents in the Description field of the User object from 
appearing in the GroupWise Address Book. (Domain object > Properties > Address Book > Do 
Not Display User Comments). This keeps comments provided by an administrator in ConsoleOne 
private from GroupWise users.

For more information, see “Determining Fields, Field Order, and Sort Order for the Address 
Book” in “Address Book” in “System” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

GroupWise / eDirectory Associations (v6.5)
The following changes have been made for GroupWise / Novell eDirectoryTM associations:

“Graft GroupWise Objects Utility” on page 186

“Invalid Associations Utility” on page 187

“Convert User to External Entity” on page 187

Graft GroupWise Objects Utility

Previous versions of the Graft GroupWise Objects utility (Tools menu > GroupWise Utilities > 
GW/eDirectory Association > Graft GroupWise Objects) allowed you to create eDirectory objects 
for a post office’s users, resources, libraries, and distribution lists. However, you had to graft all 
four object types at once.

You can now select which object types you want to graft. For example, you could graft a post 
office's users and resources, but not its libraries and distribution lists.

For more information, see “Graft GroupWise Objects” in “System” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).
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Invalid Associations Utility

In a proper association between directories, a GroupWise object in eDirectory points to the 
corresponding information in the GroupWise directory; that is, the domain database 
(wpdomain.db). In turn, the information in the GroupWise directory points back to its 
corresponding object in eDirectory.

Occasionally, perhaps because of improper grafting, an invalid association occurs, where the 
information in the GroupWise directory no longer points to the same eDirectory object that points 
to it. Such directory problems can now be easily resolved.

For information, see “Invalid Associations” in “System” in the GroupWise 6.5 Administration 
Guide (http://www.novell.com/documentation/gw65).

Convert User to External Entity

You can now convert User objects to GroupWise External Entity objects. This removes the user’s 
User object from eDirectory while retaining the user’s GroupWise account information in a 
GroupWise External Entity object.

See “Convert User to External Entity” in “System” in the GroupWise 6.5 Administration Guide 
(http://www.novell.com/documentation/gw65).

Multiple Account Deletion (v6.5)
After you select multiple GroupWise accounts for deletion and indicate whether to delete the 
eDirectory account, the GroupWise account, or both, the OK to All button applies your deletion 
options to all selected GroupWise accounts, rather than prompting you on each account to delete.

See “Removing GroupWise Accounts” in “Users” in the GroupWise 6.5 Administration Guide 
(http://www.novell.com/documentation/gw65).

Mailbox Auditing Information Display (v6.5)
You can run an audit report in ConsoleOne to determine licensing and activity status for mailboxes 
in a post office (Post Office object > Tools menu > GroupWise Utilities > Mailbox/Library 
Maintenance > Audit Report action). Any time after the report runs, you can display the audit 
information for the post office (Post Office object > Tools > GroupWise Diagnostics > 
Information).

By selecting a Domain object instead of a Post Office object, you can display cumulative 
information for all audited post offices in the domain.

For more information, see “Auditing Mailbox License Usage in the Post Office” in “Post Offices” 
in the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Link Configuration Tool Enhancement (v6.5)
In the Link Configuration Tool in ConsoleOne, you can drag and drop domains from one link type 
to another like you could in NetWare® Administrator. This is a quick alternative to the previous 
ConsoleOne method, where you would right-click a domain, click Edit, then select a different link 
type.
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Message Retention Service for Trusted Applications (v6.5 SP1)
GroupWise now supports trusted applications that perform message retention services. When you 
enable message retention services for a user, the user is unable to purge or archive mailbox items 
until after the trusted application has copied the items from the user’s mailbox to another storage 
location.

For more information, see “Retaining User Messages” in “Databases” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

DirXML Driver Warnings (v6.5 SP1)
The DirXML® Driver for GroupWise provides data integration between GroupWise users and 
groups in eDirectory. For example, you can have an e-mail account automatically created as soon 
as an employee is hired. The same driver can also disable an e-mail account when a user is no 
longer active.

If you are using the DirXML Driver for GroupWise, some GroupWise operations that you perform 
in ConsoleOne require you to take preliminary actions with the driver. For example, if you recover 
a deleted account, you need to stop the driver before recovering the account and restart it after the 
operation is complete.

The Admin Preferences (ConsoleOne > Tools menu > GroupWise System Operations > System 
Preferences) now includes a Display DirXML Warnings option that, when enabled, lets you 
receive a warning message whenever you perform a GroupWise operation in ConsoleOne that is 
affected by the DirXML driver. The warning message includes instructions about the actions you 
need to take with the driver before continuing with the GroupWise operation.

By default, the Display DirXML Warnings option is enabled. If you are not using the driver, you 
can disable the option to avoid receiving unnecessary messages. 

For more information about enabling or disabling the option, see “System Preferences” in “System 
Operations” in “System” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

GroupWise Agents
The GroupWise agents include the enhancements and new features listed below. Changes included 
in GroupWise 6.5 are indicated by (v6.5). Changes included in GroupWise 6.5 Support Pack 1 are 
indicated by (v6.5 SP1).

“IMAP Support in the POA (v6.5)” on page 188

“Secure Connections via SSL between the POA and Clients (v6.5)” on page 189

“LDAP Server Pooling (v6.5)” on page 189

“More Specific QuickFinder Intervals (v6.5)” on page 189

“CAP Support in the POA (v6.5 SP1)” on page 189

IMAP Support in the POA (v6.5)
The Post Office Agent (POA) now supports connections to IMAP (Internet Messaging Application 
Protocol) clients. 

For setup instructions, see “Supporting IMAP Clients” in “Post Office Agent” in the GroupWise 
6.5 Administration Guide (http://www.novell.com/documentation/gw65).
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Secure Connections via SSL between the POA and Clients (v6.5)
You can use SSL to secure connections between the POA and GroupWise clients or IMAP e-mail 
clients. You can disable, enable, or require (force) SSL connections for GroupWise clients either 
inside or outside your firewall and for IMAP e-mail clients that access the post office. 

For setup instructions, see “Enhancing Post Office Security with SSL Connections to the POA” in 
“Post Office Agent” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

LDAP Server Pooling (v6.5)
Initial LDAP server pooling capabilities, to facilitate robust LDAP authentication for GroupWise 
users, were introduced in GroupWise 6 Support Pack 2. In GroupWise 6.5, LDAP server 
information is entered into ConsoleOne once per LDAP server (Tools menu > GroupWise System 
Operations > LDAP Servers > Add). Additional LDAP information can be configured specifically 
for each post office (Post Office object > Security page). 

For setup instructions, see “Providing LDAP Authentication for GroupWise Users” in “Post 
Office Agent” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

More Specific QuickFinder Intervals (v6.5)
You can specify the QuickFinderTM Interval and Start QuickFinder Indexing settings in terms of 
hours and minutes, instead of just hours. 

See “Regulating Indexing” in “Post Office Agent” in the GroupWise 6.5 Administration Guide 
(http://www.novell.com/documentation/gw65).

CAP Support in the POA (v6.5 SP1)
The POA now supports connections to CAP (Calendar Access Protocol) clients. 

For setup instructions, see “Supporting CAP Clients” in “Post Office Agent” in the GroupWise 6.5 
Administration Guide (http://www.novell.com/documentation/gw65).

GroupWise Client
The GroupWise client for Windows includes the enhancements and new features listed below. 
Changes included in GroupWise 6.5 are indicated by (v6.5). Changes included in GroupWise 6.5 
Support Pack 1 are indicated by (v6.5 SP1).

“Contacts Folder (v6.5)” on page 190

“Checklist Folder (v6.5)” on page 190

“Sent Items Folder (v6.5)” on page 191

“Junk Mail Handling (v6.5)” on page 191

“Tabbed Item Views (v6.5)” on page 191

“Categories (v6.5)” on page 191

“My Subject (v6.5)” on page 192
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“Filter Enhancements (v6.5)” on page 192

“Calendar Enhancements (v6.5)” on page 192

“New Headers (v6.5)” on page 192

“New Icons (v6.5 / v 6.5 SP1)” on page 192

“Pending Sent Items (v6.5)” on page 192

“Attachment Enhancement (v6.5 / v6.5 SP1)” on page 192

“Mode Drop-Down List (v6.5)” on page 193

“From Drop-Down List in a Compose View (v6.5)” on page 193

“Read Views (v6.5)” on page 193

“Toolbar Enhancements (v6.5)” on page 193

“Address Selector (v6.5)” on page 193

“Address Book Enhancements (v6.5)” on page 193

“S/MIME Secure Message Enhancements (v6.5)” on page 193

“HTML Enhancement (v6.5 SP1)” on page 194

“POP3 and IMAP4 Account Passwords (v6.5 SP1)” on page 194

For information about using new features, from the GroupWise client for Windows, click Help > 
What’s New. For additional information about using the GroupWise client, see the GroupWise 6.5 
Windows Client User Guide.

Contacts Folder (v6.5)
The Contacts folder, by default, represents the Frequent Contacts address book in the Address 
Book. (You can change the folder properties so that it represents a different address book in the 
Address Book.) Any modification you make in the Contacts Folder is also made in the Frequent 
Contacts address book.

From this folder, you can view, create, and modify contacts, resources, organizations, and groups.

The Contacts folder is a system folder, which means that it cannot be deleted.

Checklist Folder (v6.5)
Use the Checklist folder to create a task list. You can move any items (mail messages, phone 
messages, reminder notes, tasks, or appointments) to this folder and arrange them in the order you 
want. Each item is marked with a check box so that you can check off items as you complete them.

After you have moved an item to the Checklist folder, you can open it, click the Checklist tab, and 
assign it a due date. You can also mark it Completed and set its position in the list from the 
Checklist tab.

If you want another folder to work the way the Checklist folder does, right-click the folder, click 
Properties, click the Display tab, then select Checklist from the Setting Name drop-down list.

The Checklist folder is a system folder. It replaces the Task List folder.
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Sent Items Folder (v6.5)
The Sent Items folder displays all the items you have sent. Use this folder to find items you want 
to resend, reschedule, retract, and so forth.

When you send items in Remote or Caching mode, the number of pending items displays in square 
brackets to the right of the Sent Items folder. This number displays until the items have been sent.

The Sent Items folder is a system folder. (The Sent Items folder in previous versions of GroupWise 
was a Find Results folder.)

Junk Mail Handling (v6.5)
Use Junk Mail Handling to decide what to do with unwanted Internet e-mail that is sent to your 
GroupWise e-mail address. 

Junk Mail Handling allows you to block or junk unwanted Internet e-mail. When you block e-mail, 
the e-mail address or Internet domain is added to a Block List. When you junk e-mail, the e-mail 
address or Internet domain is added to a Junk List. You can also add addresses and domains 
directly to the Block and Junk Lists.

E-mail that is junked is moved to a Junk Mail folder. E-mail that is blocked never arrives in your 
mailbox.

A Trust List allows you add addresses and domains that you never want to block or junk.

You can specify to junk all Internet e-mail originating from all users except those in your personal 
address books (including the Frequent Contacts address book).

Tabbed Item Views (v6.5)
Item views have tabs where you can make selections and specify additional information about that 
item.

In items you are composing, the Send Options tab lets you select the send options that apply to that 
item. For example, the Mail item view includes options for Priority, Delayed Delivery, Security, 
Status Tracking, and so forth.

In items you have received and sent, the Properties tab shows who else received the item, the size 
and creation date of attached files, and more. The Personalize tab gives you the options of adding 
a personal subject and assigning a category to the item.

Categories (v6.5)
You can assign a category to any item, including contacts. Categories provide you with a way to 
organize your items. You create and add categories and assign identifying category colors. The 
colors display in the item list and in the Calendar. 

You can assign more than one category to an item, and specify which category is the primary one. 
The color of the primary category is used to identify the item. To assign a category to an item, 
right-click the item, click Category, then click the category name.

Four default categories (Follow-Up, Low Priority, Personal, and Urgent) are available for you to 
immediately assign to items. You can modify and delete them if you choose, as well as continue 
to create new categories.

You can filter on categories by using the Show menu next to the new Filter icon. You can add a 
Category column heading and sort your item list by category.
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My Subject (v6.5)
You can add a personal subject to items in your item list. This subject displays in the item list and 
in the Calendar. When you open the item, you can see the original subject.

Filter Enhancements (v6.5)
The new Filter icon is two overlapping circles, one shaded and one white. The Filter icon is now 
located in the top right of the item list header. The Filter dialog box has been simplified. To access 
the previous Filter dialog box, click Advanced Filter in the Filter dialog box.

Calendar Enhancements (v6.5)
The Calendar has a new header with new navigation and date-choosing controls. These controls 
are consistent in every Calendar view. The colors in the Calendar have been softened to allow 
category colors of Calendar items to be more noticeable.

New Headers (v6.5)
Headers have been added above the item list, Folder List, Calendar, and QuickViewer. They have 
also been added to items. These headers provide information about the folder or view you are in. 
In items, they include drop-down lists that display who the item was sent to, recurring dates of 
auto-date appointments, attachment lists, and more.

New Icons (v6.5 / v 6.5 SP1)
New icons have been added, and existing icon images have been updated in the toolbar, Item List, 
Folder List, Calendar, attachment window, item views, and QuickViewer. 

Four new icons indicate status for sent items. In SP1, seven new icons indicate status for received 
items that have been replied to, forwarded, and/or delegated. For an image and description of these 
icons, click Help, click Help Topics, click the Index tab, look up icons, then display the topic 
About the Icons Appearing Next to Your Items.

Pending Sent Items (v6.5)
Pending sent items are displayed in bold in the Item List.

Attachment Enhancement (v6.5 / v6.5 SP1)
Opening attachments has been enhanced. If the attached item is a forwarded or embedded 
message, single-clicking the attachment opens the attached message in the message field of the 
open item. When an attached message is displayed in the message field, the item header includes 
a link called Parent Message. If you click this link, the message field displays the “parent 
message,” meaning the item one level up.

If the attached item is a file, single-clicking the attachment displays it in the message field of the 
open item. Double-clicking the attachment either opens it in the application with which it is 
associated, or displays it in the viewer.

New options in Tools > Options > Environment > Default Actions allow you to specify defaults 
for what happens when attachments are double-clicked. You are also prompted to specify these 
options the first time you double-click attachments.
192   GroupWise 6.5 Installation Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
In SP1, GroupWise warns you if an attachment is larger than 1000 KB (1 MB). To eliminate the 
warning message, click Tools > Options > Environment > Default Actions, then deselect Warn If 
Larger Than. You can also adjust the attachment size at which the warning message is displayed

Mode Drop-Down List (v6.5)
The Mode drop-down list has been moved from the toolbar to the Folder List header. From this 
drop-down list, you can select the Online, Caching, and Remote modes. 

Also from this drop-down list, you can select your Archive mailbox, Backup mailbox, and Proxy.

From Drop-Down List in a Compose View (v6.5)
In an item you are composing, you can select a Proxy name or the account from which you want 
to send this item by clicking the From drop-down list.

Read Views (v6.5)
When you open an item you have sent or received, the item is displayed in a read view (“viewer”). 
This view is easier to read and distinguish from a compose view.

Toolbar Enhancements (v6.5)
The toolbar at the top of a folder or item is now context-sensitive; it changes to provide the options 
you need most in that location.

The toolbar icons have been updated with new images. You can now display text next to the icon.

Address Selector (v6.5)
When you are composing an item and click Address from an item view toolbar, a simple address 
book called the Address Selector dialog box is displayed. If you want to open the system address 
book, click Address Book in the Main Window toolbar.

Address Book Enhancements (v6.5)
The Address Book has been reorganized to display address books in an Address Book List in the 
left pane of the Address Book view. You can expand and collapse each address book by clicking 
+ and -. 

Groups display below each expanded address book. Contacts, resources, organizations, and groups 
display in the right pane of the Address Book view. 

S/MIME Secure Message Enhancements (v6.5)
User and recipient public certificates are accessible from the Address Book. The Certificate 
Management and S/MIME Warning dialog boxes have been updated.
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HTML Enhancement (v6.5 SP1)
By default, if you have Default Read View set to Plain Text, GroupWise still displays HTML-only 
messages automatically because no plain text version is available. In SP1, you can select Force so 
that a message informs you whenever an HTML-only message cannot be displayed. Then you can 
click View > HTML to view it.

POP3 and IMAP4 Account Passwords (v6.5 SP1)
Microsoft Secure Password Authentication is supported for accessing Exchange servers and MSN 
accounts.

GroupWise Internet Agent
The GroupWise Internet Agent includes the enhancements and new features listed below. Changes 
included in GroupWise 6.5 are indicated by (v6.5). Changes included in GroupWise 6.5 Support 
Pack 1 are indicated by (v6.5 SP1).

“Secure Connections via SSL (v6.5)” on page 194

“Forced SSL Option for POP and IMAP Clients (v6.5)” on page 194

“SMTP Host Authentication (v6.5)” on page 195

“Rerouting Relay Host Messages (v6.5)” on page 195

“Default Number of SMTP Send and Receive Threads (v6.5)” on page 195

“Real-Time Blacklists (v6.5)” on page 195

“Deferred Message Retry (v6.5)” on page 196

“Enhanced Verbose Logging (v6.5)” on page 196

“Blocked.txt File (v6.5)” on page 196

“Internet Agent Restart (v6.5)” on page 197

Secure Connections via SSL (v6.5)
You can use SSL to secure connections between the Internet Agent and Post Office Agents 
(POAs). SSL options are configured on the Internet Agent object’s Network Address page and 
SSL Settings page in ConsoleOne.

For more information, see “Securing Internet Agent Connections Via SSL” in “Internet Agent” in 
the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Forced SSL Option for POP and IMAP Clients (v6.5)
You can now disable, enable, or require (force) SSL connections for POP and IMAP clients. If SSL 
is enabled, the POP/IMAP client determines whether or not an SSL connection is used. If SSL is 
disabled, no SSL connections are used. If SSL is required, only SSL connections are allowed.

SSL options are configured on the Internet Agent object’s Network Address and SSL Settings 
pages in ConsoleOne. 

For more information, see “Securing Internet Agent Connections Via SSL” in “Internet Agent” in 
the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).
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SMTP Host Authentication (v6.5)
The Internet Agent supports SMTP host authentication for both outbound and inbound message 
traffic.

With outbound authentication, you can ensure that the Internet Agent is able to send messages to 
other SMTP hosts that require proper authentication credentials before they accept messages. In 
addition, you can limit the Internet Agent to sending messages only to hosts that require 
authentication.

With inbound authentication, you can require other SMTP hosts to supply proper authentication 
credentials (GroupWise username and password) before the Internet Agent accepts messages from 
them. This also applies to POP3/IMAP4 clients.

For more information about SMTP host authentication, see “Configuring SMTP Host 
Authentication” in “Internet Agent” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

Rerouting Relay Host Messages (v6.5)
If you use a relay host for outbound messages, you can use a route.cfg file to specify SMTP hosts 
that you want to directly send outbound messages to. Whenever a message is addressed to a user 
at a host that is included in the route.cfg file, the Internet Agent sends the message directly to the 
host rather than to the relay host.

The route.cfg file can also be used for other purposes, including:

Sending e-mail to hosts that are unknown to the Public Domain Name Servers. The route.cfg 
file acts much like a hosts file to enable the Internet Agent to resolve addresses not listed in 
DNS.

Routing messages destined for certain hosts through a separate SMTP host that checks for 
viruses or performs some other task on them before routing them to the destination host.

For more information about the route.cfg file, see “Enabling SMTP Relaying” in “Internet Agent” 
in the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Default Number of SMTP Send and Receive Threads (v6.5)
The default number of SMTP threads has been increased from 2 send threads and 4 receive threads 
to 8 send threads and 16 receive threads. This applies to any new Internet Agent installation. It also 
applies to updated Internet Agent installations if the /copyonly startup switch is not being used.

The send and receive thread settings are configured on the Internet Agent object’s SMTP/MIME 
Settings page in ConsoleOne.

For more information about the SMTP send and receive threads, see “Configuring SMTP/MIME 
Services” in “Internet Agent” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

Real-Time Blacklists (v6.5)
Many organizations, such as Mail Abuse Prevention System (MAPS), Open Relay DataBase 
(ORDB), and SpamCop, provide lists of IP addresses that are known to be open relay hosts or spam 
hosts. You can use the real-time blacklists provided by these sites to protect your users from 
offensive spam.
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You define blacklist sites through the Internet Agent object’s Access Control Blacklists page in 
ConsoleOne.

For more information about using real-time blacklists, see “Blocking Unwanted E-Mail” in 
“Internet Agent” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

Deferred Message Retry (v6.5)
You can specify the number of hours after which the Internet Agent stops trying to send deferred 
messages. A deferred message is any message that could not be sent because of a temporary 
problem (host down, MX record not found, and so forth).

For the first hour of the specified time, the Internet Agent tries resending the message every 20 
minutes. After the first hour, it tries resending the message every four hours. For example, if you 
specify 10 hours, the Internet Agent tries resending the message at 20 minutes, 40 minutes, 1 hour, 
5 hours, and 9 hours. After the 10 hours has expired, it returns an Undeliverable status to the 
sender.

You configure this option through the Internet Agent object’s SMTP/MIME Settings page in 
ConsoleOne.

For more information about the deferred message retry setting, see “Configuring SMTP/MIME 
Services” in “Internet Agent” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

Enhanced Verbose Logging (v6.5)
In Verbose logging mode, the Internet Agent logs more information, such as:

The filename, path, message ID, and size of the message file being processed

The IP address of any inbound SMTP connections

The Internet Agent-specific MSG number

SMTP connection messages such as “Connected to novell.com” and “Accepted connection 
from IP address novell.com”

Logging modes are configured on the Internet Agent object’s Log Settings page in ConsoleOne.

For more information about logging, see “Using Internet Agent Log Files” in “Internet Agent” in 
the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Blocked.txt File (v6.5)
ConsoleOne creates a blocked.txt file that includes all the hosts that have been added to the Prevent 
Messages From exceptions list (Default Class of Service > SMTP Incoming > Prevent Messages 
From). This list is used to define the hosts or domains you do not want to receive messages from.

You can manually edit the blocked.txt file to add or remove hosts. To maintain consistency for 
your system, you can also copy the list to other Internet Agent installations.

The blocked.txt file is created in the domain\wpgate\gwia directory.

For more information about the blocked.txt file, see “Configuring SMTP/MIME Services” in 
“Internet Agent” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).
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Internet Agent Restart (v6.5)
When the Internet Agent restarts, it rereads all of its configuration files. This includes gwia.cfg, 
blocked.txt, gwauth.cfg, and route.cfg. 

Changing Internet Agent information in ConsoleOne causes an automatic restart of the Internet 
Agent to ensure that it knows about the changed information. If you change the configuration files, 
you can use the new restart option (F6 - Restart) in the Internet Agent console to manually restart 
the Internet Agent so that it recognizes the changes.

For more information about the Internet Agent console, see “Monitoring Internet Agent 
Operations” in “Internet Agent” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

GroupWise WebAccess
GroupWise WebAccess includes the enhancements and new features listed below. Changes 
included in GroupWise 6.5 are indicated by (v6.5). Changes included in GroupWise 6.5 Support 
Pack 1 are indicated by (v6.5 SP1).

“Apache Web Server for NetWare Support (v6.5 / v6.5 SP1)” on page 197

“Tomcat Servlet Engine Support (v6.5 / v6.5 SP1)” on page 197

“Easier Creation of PQA Files (v6.5)” on page 198

“Secure Connections via SSL (v6.5)” on page 198

“Trusted Server (Single Sign-On) Support (v6.5)” on page 198

“Session Cookie Support (v6.5)” on page 198

“Proxy Server Data Caching (v6.5)” on page 198

“Document Viewing and Opening Options (v6.5)” on page 199

“Size Limitations for Document Viewing (v6.5 SP1)” on page 199

“Web Browser Data Caching (v6.5 SP1)” on page 200

“New WebAccess Client Features (v6.5 / v6.5 SP1)” on page 200

Apache Web Server for NetWare Support (v6.5 / v6.5 SP1)
GroupWise 6.5 WebAccess supports Apache Web Server on NetWare 6. Support Pack 1 includes 
support for Apache 2 Web Server on NetWare 6.5.

The Installation program recognizes the NetWare server’s version, installs to the appropriate 
location (apache directory or apache2 directory), and configures the appropriate files.

For information, see “WebAccess System Requirements” on page 96.

Tomcat Servlet Engine Support (v6.5 / v6.5 SP1)
GroupWise 6.5 WebAccess supports the Tomcat 3.3 servlet engine on NetWare 6. Support Pack 
1 includes support for the Tomcat 4 servlet engine on NetWare 6.5.

WebAccess does not include the Tomcat servlet engine, but can be installed to a NetWare 6.x 
server that is using it.

For information, see “WebAccess System Requirements” on page 96.
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Easier Creation of PQA Files (v6.5)
The Installation program includes a startup switch, -pqa or /pqa, that instructs the program to show 
only the screens required to create a PQA (Palm Query Application) file. The PQA file can be used 
on a Palm OS device to access GroupWise through the device.

For more information about the Internet Agent console, see “Creating a PQA File for the 
WebAccess Client” in “WebAccess” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

Secure Connections via SSL (v6.5)
The WebAccess Agent includes SSL support to provide secure connections to Post Office Agents 
(POAs) and the WebAccess Agent Web console. SSL options are configured on the WebAccess 
Agent object’s Network Address page and SSL Settings page in ConsoleOne.

For more information, see “Securing WebAccess Agent Connections Via SSL” in “WebAccess” 
in the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Trusted Server (Single Sign-On) Support (v6.5)
The GroupWise WebAccess Application can be configured to support single sign-on via trusted 
servers. When enabled, the WebAccess Application authenticates users to GroupWise using 
authentication header credentials generated by an authentication server (for example, a Novell 
iChain® Authentication Server).

For information about configuring the WebAccess Application to support single sign-on via 
trusted servers, see “Configuring the WebAccess Application” in “WebAccess” in the GroupWise 
6.5 Administration Guide (http://www.novell.com/documentation/gw65). 

Session Cookie Support (v6.5)
The GroupWise WebAccess Application can be configured to support secure sessions by using 
session cookies on a per-template-set basis. The session cookie, which is created when the user 
opens the session, ties the session to the browser and ensures that the WebAccess Application 
accepts session requests from that browser only. The session cookie is held in memory and exists 
only as long as the user is logged in.

Session cookie support is configured through the GroupWise WebAccess Application object’s 
Security page in ConsoleOne.

For more information, see “Configuring the WebAccess Application” in “WebAccess” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65). 

Proxy Server Data Caching (v6.5)
The GroupWise WebAccess Application can be configured to enable or disable caching of 
WebAccess data on proxy servers (or other caching devices) on a per-template-set basis. Proxy 
servers that cache files can pose an information security risk because any information that the 
WebAccess Application sends to users is cached. This includes sensitive mailbox information 
such as message text and passwords.

You can attempt to disable proxy server caching of GroupWise information. If you do so, the 
WebAccess Application includes a “disable proxy caching” request in the header of each file that 
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it sends. If the proxy server accepts the request, the file is not cached; if it does not accept the 
request, the file is cached, regardless of this setting.

Proxy server data caching is enabled/disabled through the GroupWise WebAccess Application 
object’s Template page (Define User Interfaces feature) in ConsoleOne.

For more information, see “Configuring the WebAccess Application” in “WebAccess” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65). 

Document Viewing and Opening Options (v6.5)
Previous versions of GroupWise WebAccess allowed users to view an attached document or 
library document in HTML format. If users wanted to open the document in its native application, 
they had to first save it to their local drives and then open it in the application.

You can now configure WebAccess to enable users to open a document in the document’s native 
application without first saving it to the local drive. This results in a document having two options: 
View (as HTML) and Open (in native format).

You can enable both options, the View option only, the Open option only, or neither option.You 
can also enable options for all documents, or you can determine available options based on the type 
of document. For example, you could force all Microsoft Word documents (.doc files) to use the 
Open option, while Microsoft Excel documents (.xls files) use the View option.

The Open option requires that 1) the Web browser knows the correct application or plug-in to 
associate with the document, according to its file extension or MIME type, and 2) the application 
or plug-in is available to the user. Otherwise, the user is prompted to save the file to disk or specify 
the application to open it.

The WebAccess viewing and opening options are configured through the GroupWise WebAccess 
Application object’s Setting page. For more information, see “Configuring the WebAccess 
Application” in “WebAccess” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

The WebPublisher viewing and opening options are configured through the GroupWise 
WebPublisher Application object’s Setting page. For more information, see “Configuring the 
WebPublisher Application” in “WebAccess” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).

Size Limitations for Document Viewing (v6.5 SP1)
With Support Pack 1, you can set a maximum size limit for viewing attachments and library 
documents in HTML format. If a file exceeds the size limit (1024 KB by default), the file is not 
rendered to HTML.

The WebAccess viewing options are configured through the GroupWise WebAccess Application 
object’s Setting page. For more information, see “Configuring the WebAccess Application” in 
“WebAccess” in the GroupWise 6.5 Administration Guide (http://www.novell.com/
documentation/gw65).

The WebPublisher viewing options are configured through the GroupWise WebPublisher 
Application object’s Setting page. For more information, see “Configuring the WebPublisher 
Application” in “WebAccess” in the GroupWise 6.5 Administration Guide (http://
www.novell.com/documentation/gw65).
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Web Browser Data Caching (v6.5 SP1)
GroupWise 6.5 supports disabling of proxy server data caching (see “Proxy Server Data Caching 
(v6.5)” on page 198). Support Pack 1 adds support for disabling Web browser data caching.

Both proxy server data caching and Web browser data caching are configured through the same 
option. Therefore, if you disable one, both are disabled.

The location where you enable or disable data caching has changed from the WebAccess 
Application object’s Template page to the Security page.

For more information, see “Configuring the WebAccess Application” in “WebAccess” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65). 

New WebAccess Client Features (v6.5 / v6.5 SP1)
The following features and enhancements have been made to the WebAccess client:

“Document Viewing and Open Options (v6.5)” on page 200

“Global Send Options (v6.5)” on page 200

“Item Send Options (v6.5)” on page 200

“Checklist Folder (v6.5)” on page 201

“Sent Items Folder (v6.5)” on page 201

“Find (v6.5)” on page 201

“Enhanced Item Properties (v6.5)” on page 201

“Setting the Default Number of Messages to Display (v6.5)” on page 201

“Printer-Friendly View (v 6.5 SP1)” on page 201

“Message Capture after Web Server Outage (v6.5 SP1)” on page 201

For additional information about WebAccess client features, refer to the WebAccess client Help.

Document Viewing and Open Options (v6.5)

Previous versions of GroupWise WebAccess and WebPublisher allowed users to view an attached 
document or library document in HTML format. If users wanted to open the document in its native 
application, they had to first save it to their local drives and then open it in the application.

WebAccess can now be enabled by the administrator to allow users to open a document in the 
document’s native application without first saving it to the local drive. This results in a document 
having two options: View (as HTML) and Open (in native format).

Global Send Options (v6.5)

WebAccess Client Options now include Send Options. Click the Options icon on the toolbar, then 
click Send Options. You can specify Classification, Priority, Reply Requested, and Return 
Notification options. These options apply to all items you send.

Item Send Options (v6.5)

In an item you are creating, click Send Options. You can specify Classification, Priority, Reply 
Requested, and Return Notification options. These options apply to the item you are creating.
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Checklist Folder (v6.5)

The Checklist folder is new in both the Windows and WebAccess versions of the GroupWise 
client.

You can move items to the Checklist folder, arrange items in the order you want, assign due dates 
to items, and mark them Complete.

The Checklist folder is a system folder. It replaces the Task List folder.

Sent Items Folder (v6.5)

The Sent Items folder displays all the items you have sent that you have not moved to other folders. 
Use this folder to find items you want to resend, reschedule, retract, and so forth.

The Sent Items folder is a system folder. The Sent Items folder in previous versions of GroupWise 
was a Find Results folder.

Find (v6.5)

Click the Find icon (a magnifying glass) on the left toolbar of the Main Window to search for 
items, including document references in your mailbox.

You can do a full-text search or search for text in the subject. You can search in the From or To/
CC fields. Select the item types you want to search, the Item Source, and the folders you want to 
search in, then click Find. The Find Results display, in date descending order, in the right pane of 
the browser window.

Enhanced Item Properties (v6.5)

To view basic properties about an item, open an item, then click Properties. To view more detailed 
properties, open an item, click Properties, then click Other Properties.

Setting the Default Number of Messages to Display (v6.5)

You can set the default number of messages to display in the Item List by clicking the Options icon 
on the toolbar, then clicking General. You can select from 5 to 200 messages to be displayed by 
default.

Printer-Friendly View (v 6.5 SP1)

If your browser’s Print feature prints a message in a format that loses information, click Print View 
in the Mail Message window to display a printer-friendly version of the message in a new browser 
window, then print the message from the new window.

Message Capture after Web Server Outage (v6.5 SP1)

If a Web server outage occurs while you are composing a message, your message is not lost when 
you click Send. It is captured and appears at the bottom of the WebAccess Login page so that you 
can retrieve it when your Web server comes back up and you log into WebAccess again.
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GroupWise Monitor
GroupWise Monitor includes the enhancements and new features listed below. Changes included 
in GroupWise 6.5 are indicated by (v6.5). Changes included in GroupWise 6.5 Support Pack 1 are 
indicated by (v6.5 SP1).

“Apache Web Server for NetWare Support (v6.5 / v6.5 SP1)” on page 202

“Tomcat Servlet Engine Support (v6.5 / v6.5 SP1)” on page 202

“Easier Creation of PQA Files (v6.5)” on page 202

“Agent Groups (v6.5)” on page 202

“Enhanced Monitor Agent Menus (v6.5)” on page 203

“Suspend/Resume Polling Capability (v6.5)” on page 203

“Custom States (v6.5)” on page 203

Apache Web Server for NetWare Support (v6.5 / v6.5 SP1)
GroupWise 6.5 Monitor supports Apache Web Server on NetWare 6. Support Pack 1 includes 
support for Apache 2 Web Server on NetWare 6.5.

The Installation program recognizes the NetWare server’s version, installs to the appropriate 
location (apache directory or apache2 directory), and configures the appropriate files.

For information, see “Monitor System Requirements” on page 129.

Tomcat Servlet Engine Support (v6.5 / v6.5 SP1)
GroupWise 6.5 Monitor supports the Tomcat 3.3 servlet engine on NetWare 6. Support Pack 1 
includes support for the Tomcat 4 servlet engine on NetWare 6.5.

Monitor does not include the Tomcat servlet engine, but can be installed to a NetWare 6.x server 
that is using it.

For information, see “Monitor System Requirements” on page 129.

Easier Creation of PQA Files (v6.5)
The Monitor Installation program includes a startup switch, -pqa or /pqa, that instructs the program 
to show only the screens required to create a PQA (Palm Query Application) file. The PQA file 
can be used on a Palm OS device to access the Monitor Web console through the device.

For information, see “Creating a PQA File for the Monitor Web Console” in “Monitor” in the 
GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Agent Groups (v6.5)
In GroupWise 6.5 Monitor, you can create groups of related agents to monitor together. All agents 
in the group share the same threshold, notification, and polling options, so that you can set these 
options once for the agent group, rather than for each agent individually. For example, you could 
create an agent group for each region or site in your organization. The groups can be nested 
hierarchically. 

For setup instructions, see “Creating and Managing Agent Groups” in “Monitor” in the GroupWise 
6.5 Administration Guide (http://www.novell.com/documentation/gw65).
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Enhanced Monitor Agent Menus (v6.5)
The menus of the Monitor Agent console have been reorganized to group features more 
conveniently.

Suspend/Resume Polling Capability (v6.5)
Polling of monitored agents can be suspended and resumed either indefinitely or for a specified 
period of time. You can control polling from the Monitor Agent console and from the Monitor 
Web console.

For more information, see “Polling the Agents for Updated Status Information” in “Monitor” in 
the GroupWise 6.5 Administration Guide (http://www.novell.com/documentation/gw65).

Custom States (v6.5)
You can now create your own custom states in the Monitor Web console as well as in the Monitor 
Agent console.
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12 Understanding the Update Process

You can update a Novell® GroupWise® 5.x or GroupWise 6.x system to GroupWise 6.5. To update 
a GroupWise 4.x system to GroupWise 6.5, you need to first update the system to GroupWise 5.x.

Before you begin updating your GroupWise system to GroupWise 6.5, you should review the 
following sections. These sections, which describe the process to follow when updating, help you 
plan and implement a successful update strategy:

“Understanding eDirectory Schema Extensions” on page 205

“Understanding GroupWise Software Updates” on page 205

“Understanding Domain and Post Office Database Updates” on page 206

“Understanding GroupWise Client Updates” on page 207

“Understanding Internet Agent Updates” on page 207

“Understanding WebAccess Updates” on page 208

“Understanding Monitor Updates” on page 208

“Understanding GroupWise Gateway Compatibility” on page 209

For a list of enhancements and new features in GroupWise 6.5, see Chapter 11, “What’s New in 
GroupWise 6.5,” on page 181.

In some cases, you might need to maintain a mixed-version environment as you roll out 
GroupWise 6.5. For a table showing which GroupWise 5.x and 6.x components can be used 
together, see Appendix A, “GroupWise Version Compatibility,” on page 239.

Understanding eDirectory Schema Extensions
GroupWise 6.5 includes new functionality that requires you to extend the schema of any Novell 
eDirectoryTM trees where you have GroupWise objects. The GroupWise Installation Advisor 
automatically extends the schema for any trees you select.

Understanding GroupWise Software Updates
The GroupWise 6.5 software requirements are different than previous GroupWise software 
requirements. To review the requirements, see “GroupWise System Requirements” on page 19.

Software Distribution Directory
The GroupWise Installation Advisor helps you copy the GroupWise 6.5 software (administration, 
agents, client, and so forth) to a GroupWise software distribution directory. This can be an existing 
software distribution directory or a new software distribution directory.
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How users run the GroupWise client is the main issue to consider when deciding whether to update 
an existing software distribution directory or create a new one. The GroupWise 6.5 client cannot 
run against old (pre-6.5) GroupWise post offices. When you update an existing software 
distribution directory, users running from the software distribution directory (a workstation 
installation) are automatically forced to update. If their post office is not yet updated, they are 
locked out until you update it.

Users running the GroupWise client from their local drives (a standard installation) can continue 
to run the local GroupWise client until you prompt them to update.

In general, you should update an existing software distribution directory only if 1) all users can run 
the GroupWise client from their local drives, or 2) you can update all users’ post offices within a 
reasonable time of updating the software distribution directory.

If this approach does not work for you, you should create a new GroupWise 6.5 software 
distribution directory. You can then use the new software distribution directory to update your 
domains and post offices to version 6.5 while users continue to run the older GroupWise client 
from the existing software distribution directory. After the users’ post offices have been updated, 
you can update their existing software distribution directory to version 6.5 to get them up and 
running on the GroupWise client.

ConsoleOne
GroupWise 6.5 is administered through ConsoleOne®, version 1.3.4 or higher. ConsoleOne 1.3.4 
is included on the GroupWise 6.5 Administrator CD. If necessary, you can install it at the same 
time as the other GroupWise software.

After you’ve installed GroupWise 6.5, we strongly recommend that you no longer use NetWare® 
Administrator to administer your GroupWise system. Doing so can cause problems such as 
overwriting of the GroupWise 6.5 database dictionary files by older dictionary files. In addition, 
some GroupWise 6.5 administration functionality, such as post office disk space management, is 
available only when using ConsoleOne.

You can also use ConsoleOne to administer pre-6.5 GroupWise components in your GroupWise 
system.

Administration Agent 
Beginning with GroupWise 5.5, the Administration Agent’s functionality was moved into the 
Message Transfer Agent (MTA) and the Post Office Agent (POA). If you are updating a 
GroupWise 5, 5.1, or 5.2 system, you need to make sure that you do not run the Administration 
Agent against the domain after you’ve started the GroupWise 6.5 MTA. Doing so can result in the 
loss of GroupWise 6.5 information. The Agent Installation program includes an option to help you 
remove the ADA.

Understanding Domain and Post Office Database Updates
Functionality enhancements in GroupWise 6.5 require the GroupWise domain and post office 
databases to be updated with new records and fields, similar to the schema extensions that are 
required for eDirectory.

You must update the primary domain first so that correct replication of GroupWise 6.5 information 
can take place as you update post offices and secondary domains. After you update the primary 
206   GroupWise 6.5 Installation Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
domain, you can update the primary domain’s post offices or you can update a secondary domain 
and its post offices. The following diagram illustrates this update sequence.

To update a domain database, you run the GroupWise 6.5 Message Transfer Agent (MTA) against 
it. The first time the GroupWise 6.5 MTA runs against a domain, it rebuilds the domain database 
(wpdomain.db) so the database includes the records required for new GroupWise 6.5 information. 
The MTA uses a new domain dictionary file (gwdom.dc) to rebuild the database.

Likewise, to update a post office database, you run the GroupWise 6.5 Post Office Agent (POA) 
against it. The first time the GroupWise 6.5 POA runs against the post office, it rebuilds the post 
office database (wphost.db) so the database includes the new records required for GroupWise 6.5 
information. The POA uses a new post office dictionary file (gwpo.dc), which it requests from the 
MTA, to rebuild the database. A user cannot run the GroupWise 6.5 client until his or her post 
office has been updated.
IMPORTANT: Before you update a secondary domain, you must wait until the update to the primary domain 
has run to completion. Before you update a post office, you must wait until the update to its domain has run to 
completion. Updating a large domain database can take 20 minutes or more. If you do not wait until the update 
runs to completion, you might encounter database versioning discrepancies. If such discrepancies occur, see 
“MTA Fails to Update the Domain Database Version” and “POA Fails to Update the Post Office Database 
Version” in “Strategies for Agent Problems” in GroupWise 6.5 Troubleshooting 2: Solutions to Common 
Problems.

Understanding GroupWise Client Updates
After a post office is updated to version 6.5, users can run the GroupWise 6.5 client on a Windows 
98 or Windows NT/2000/XP workstation. If necessary, they can also continue to run their older 
GroupWise client for Windows, but they will not have GroupWise 6.5 functionality.
IMPORTANT: Users who need to proxy users on a post office should not update to the GroupWise 6.5 client 
until the proxy users’ post office has been updated to version 6.5. If they do update to the GroupWise 6.5 client, 
they cannot access the proxy users’ mailboxes.

For a list of new features in the GroupWise 6.5 client, see Chapter 11, “What’s New in GroupWise 
6.5,” on page 181. 

Understanding Internet Agent Updates
The GroupWise 6.5 Internet Agent is fully functional only when running against GroupWise 6.x 
domains and post offices. If you run it against a GroupWise 5.x domain or post office, users on 
GroupWise 5.x post offices can send and receive Internet messages (SMTP support), but cannot 
use POP3 and IMAP4 clients to access their mailboxes.

Primary Domain Secondary Domain

Post
Office

Post
Office

Post
Office

Post
Office

Post
Office

1 2

2 3
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The GroupWise 5.x/6 Internet Agent can run against a GroupWise 6.5 domain and post office, 
which means that you can continue to use it until all domains and post offices are updated to 
version 6.5.

For a list of new features in GroupWise 6.5 Internet Agent, see Chapter 11, “What’s New in 
GroupWise 6.5,” on page 181.

Understanding WebAccess Updates
As you plan how to update GroupWise WebAccess, you need to consider both the WebAccess 
Agent and the WebAccess components on the Web server.

“WebAccess Agent” on page 208

“WebAccess Components on the Web Server” on page 208

WebAccess Agent
The GroupWise 6.5 WebAccess Agent cannot access older (pre-6.5) domains and post offices. In 
addition, WebAccess Agents older than version 5.5 EP SP3 cannot access GroupWise 6.5 domains 
and post offices. 

Therefore, to continue to provide WebAccess service to users while you are updating your system, 
you need to: 

Update the WebAccess Agent at the same time you update its domain and post offices. This 
keeps the WebAccess Agent version synchronized with the domain and post office version.

If you have multiple domains or post offices that will be updated over a long period of time, 
install the GroupWise 6.5 WebAccess Agent in a GroupWise 6.5 domain to service users on 
GroupWise 6.5 post offices. Keep your current WebAccess Agent, installed in a GroupWise 
domain that will support it, to service users on pre-6.5 post offices.

WebAccess Components on the Web Server
The GroupWise 6.5 WebAccess Agent can communicate with the GroupWise 5.5 or newer 
WebAccess applications/servlets (on the Web server). If you have GroupWise 5.5 or newer, you 
can update your WebAccess Agent independent of the WebAccess components on the Web server.

The GroupWise 6.5 WebAccess Agent cannot communicate with pre-5.5 Web server components. 
In this case, you need to update the WebAccess components on your Web server at the same time 
you update the WebAccess Agent.

For a list of changes and new features in GroupWise 6.5 WebAccess, see Chapter 11, “What’s 
New in GroupWise 6.5,” on page 181.

Understanding Monitor Updates
GroupWise Monitor is not dependent on any other GroupWise agents, so it can be updated at any 
time.

For a list of changes and new features in GroupWise 6.5 Monitor, see Chapter 11, “What’s New 
in GroupWise 6.5,” on page 181.

For Monitor update instructions, see “Preparing Your GroupWise System” on page 211.
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Understanding GroupWise Gateway Compatibility
There are no known issues with using GroupWise gateways with GroupWise 6.5. 
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13 Preparing Your GroupWise System

To prepare your Novell® GroupWise® system to be updated to version 6.5, complete the following 
tasks:

Validate your domain and post office databases to make sure that there are no physical 
inconsistencies with the database. If problems exist, you should recover or rebuild the 
database. For information about validating, recovering, or rebuilding a database, see the 
GroupWise documentation for your GroupWise version at the Novell Documentation Web 
site (http://www.novell.com/documentation).

Back up the domain or post office immediately before updating it. GroupWise provides a 
backup utility, gwbackup.exe, that you can use to back up and restore your databases. For 
information about using the backup utility, see the GroupWise documentation for your 
GroupWise version at the Novell Documentation Web site (http://www.novell.com/
documentation).
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14 Updating Your GroupWise 6.x System to 
Version 6.5

The following sections provides step-by-step instructions for updating your Novell® GroupWise® 
6.x system to GroupWise 6.5. Before beginning, make sure you have reviewed Chapter 12, 
“Understanding the Update Process,” on page 205 and Chapter 13, “Preparing Your GroupWise 
System,” on page 211.

“Installing the GroupWise 6.5 Software” on page 213

“Updating the Primary Domain” on page 217

“Updating Post Offices” on page 223

“Updating Users’ GroupWise Clients” on page 224

“Updating Secondary Domains” on page 227

“Updating the GroupWise Internet Agent” on page 227

“Updating GroupWise WebAccess” on page 227

“Updating GroupWise Monitor” on page 227

Installing the GroupWise 6.5 Software
To start the GroupWise Installation Advisor:

1 From a Windows workstation, log in as an Admin equivalent to the Novell eDirectoryTM tree 
where you are installing GroupWise.

2 Insert the GroupWise 6.5 Administrator CD into the workstation’s CD drive.

3 Click Start, click Run, then type d:setup.exe (where d is your CD drive). 
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4 Click Create or Update a GroupWise System, then click Yes to accept the license agreement 
and display the Welcome to GroupWise Install dialog box.

5 Click Next until you reach the Administration Options dialog box.
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6 Make sure that Create a New System or Update an Existing System is selected, then click Next 
to display the Select Tree dialog box.

7 In the Select Tree dialog box, select the trees whose schema you want to extend (you should 
extend the schema of all trees where GroupWise objects reside), click Next, then follow the 
prompts until you reach the Ready to Install dialog box.

8 Click Install, then follow the prompts until you reach the Determine Next Step dialog box.
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9 Click Updating an Existing GroupWise System, then click Next to display the Update 
GroupWise System dialog box.

10 Continue with the next section, Updating the Primary Domain.

Updating the Primary Domain
To update the primary domain, you need to install and start the GroupWise 6.5 MTA. The MTA 
uses the new domain dictionary file (gwdom.dc) to update the domain database to version 6.5.
IMPORTANT: The MTA cannot be running while you update the MTA files. If you are updating a GroupWise 
system that still uses the ADA (Administration Agent), the ADA cannot be running. In addition, after you've 
updated to the GroupWise 6.5 MTA, do not run the ADA again. The ADA became obsolete with GroupWise 
5.5. Running the ADA in combination with a GroupWise 6.5 MTA results in the loss of GroupWise 6.5 
information.

To install and start the GroupWise 6.5 MTA:

1 To install the MTA to a NetWare® server, make sure the workstation has access to both the 
primary domain directory and the NetWare server where you want to install the MTA, enter 
the path to the primary domain directory, then click Update to launch the Agent Installation 
program.

or
216   GroupWise 6.5 Installation Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
To install the MTA to a Windows server, click Finish, go to the Windows server, ensure that 
you have access to the primary domain directory, then start the Agent Installation program 
(install.exe). The Agent Installation program is located in the \agents directory in the 
GroupWise 6.5 software distribution directory or on the GroupWise 6.5 Administrator CD.

2 Click Yes to accept the license agreement and display the Overview dialog box.

3 Click Next to display the Install/Uninstall dialog box. 

4 Make sure Install is selected, then click Next to display the Select Platform dialog box. 
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5 In the Select Platform dialog box, select NetWare or Windows, then click Next to display the 
Installation Path dialog box.

The default NetWare installation directory is sys:\system and the default Windows directory 
is c:\grpwise. You can, however, install the agent files to any directory. On NetWare, if you 
don’t install to the sys:\system directory, you must define the agent directory in the server’s 
search path. For example, you could add SEARCH ADD sys:\system\agent_directory to the 
autoexec.ncf file, where agent_directory is the actual name of the installation directory.

If you are installing to Windows, the dialog box displays the following options:

Install GroupWise Agent Software: This option must be selected to install the agent files. 
You would only want to deselect it if you previously installed the GroupWise 6.5 MTA 
without configuring it for SNMP or as a Windows service and now want to perform those 
configuration tasks.

Install and Configure SNMP for GroupWise Agents: Select this option to enable the MTA 
to be monitored through an SNMP management program. This option is available only if the 
SNMP service is enabled on the Windows server.

Install as Windows Services: Select this option to install the MTA as a Windows service.

6 Select the directory where you want to install the agent files, then click Next to display the 
Language dialog box. 
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If multiple languages are displayed, you can install one or more of the languages. By default, 
the MTA starts in the language selected for the domain. If that language has not been installed, 
the MTA starts in the language used by the operating system. If that language has not been 
installed, the MTA starts in English.

7 Select the languages you want to install, then click Next to display the Domains / Post Offices 
dialog box.

To simplify the process of loading the MTA, the Agent Installation program uses the domain 
information you enter in the Domains / Post Offices dialog box to create an MTA startup file. 
The startup file includes a required switch (/home-path) that points to the domain directory. 
The Agent Installation program also creates a grpwise.ncf file on NetWare or a Startup menu 
shortcut on Windows. The .ncf file or shortcut includes the command to load the MTA using 
the MTA startup file.

8 To specify the location of your domain, click Add, enter the domain name, enter the path to 
the domain directory, then click OK to add the domain to the list.

In addition to the MTA, the POA is automatically installed to the installation directory. If you 
plan to run the POA on the same server as the MTA, specify the location of the post office (or 
post offices) the POA will service. The Agent Installation program creates a POA startup file 
with a /home switch that points to the post office directory. It then includes the command to 
load the POA in the grpwise.ncf file on NetWare or in a Startup menu shortcut on Windows.
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9 Click Next. If you are installing the NetWare MTA or the Windows MTA (as a regular 
Windows application, not as a Windows service), the Summary dialog box is displayed. Skip 
to Step 11.

or

If you are installing the MTA as a Windows service, the Windows Service Information dialog 
box is displayed.

The MTA requires a user account that provides access to the domain directory.

If the domain directory is on the Windows server, you can use the local system user 
account to provide the access; the Use Local System Account option is available only if 
the domain directory is on the local server.

If the domain directory is on another Windows server, you need to specify a Windows 
user account that provides access to that server.

If the domain directory is on a NetWare server, you need to specify a username and 
password that is valid as both a Windows user account and an eDirectory user account.

If you are also planning to run the POA on this server, the user account you specify must also 
provide access to the post office directory.

10 Provide the appropriate user account information, then click Next to display the Summary 
dialog box.
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11 Click Install to install the agent files.

After the files are installed, the Agent Installation program creates the MTA startup file and 
the grpwise.ncf file (NetWare) or Startup menu shortcut (Windows).

MTA Startup File: If an MTA startup file already exists, the Agent Installation program 
renames the existing file with a .mt1 extension. For example, an existing provo.mta file would 
be renamed to provo.mt1 before the new provo.mta file is created. If you’ve made 
modifications to the existing MTA startup file, you might want to use it instead of the new 
MTA file. The same is true for the POA (if you defined a post office in the Domains / Post 
Office dialog box).

grpwise.ncf File (NetWare only): If a grpwise.ncf file already exists, the Agent Installation 
program gives you the option of 1) overwriting the existing grpwise.ncf file, 2) appending the 
new MTA load commands to the existing grpwise.ncf file, or 3) creating a new file named 
grpwis1.ncf. If you have modified the existing grpwise.ncf file and want to save the 
modifications, you should append to the existing file or create a new grpwis1.ncf file. If you 
append to the file, make sure you review it later to ensure that it includes only the commands 
you want.

Shortcut: If a shortcut already exists on the Start menu (Start > Programs > GroupWise 
Agents), the Agent Installation program replaces the shortcut with the new shortcut.

After the startup file and grpwise.ncf file or Windows shortcut have been created, the 
Installation Complete dialog box is displayed.

12 Select from the following options:

Update AUTOEXEC File: This option applies only to the NetWare agents. Select this option 
to reference the grpwise.ncf file from the NetWare server’s autoexec.ncf file so that the MTA 
loads automatically whenever the server starts. If you specified a post office in the Domains 
/ Post Offices dialog box (Step 8), the POA is also loaded.

Delete Obsolete Administration Agent (ADA) Files and References to ADA: The 
Administration Agent (ADA) is no longer necessary and should not be used with the 
GroupWise 6.5 MTA. Select this option to delete the ADA program and startup files.

Launch GroupWise Agents Now: Select this option to start the MTA. After you start the 
MTA, it updates the domain database to version 6.5. You can verify that the database version 
has been updated by viewing the Domain object’s Identification page in ConsoleOne®. If you 
specified a post office in the Domains / Post Offices dialog box (Step 8), the POA is also 
started. After the domain database is updated, the POA updates the post office database. You 
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can view the Post Office object’s Identification page in ConsoleOne to verify that the database 
version has been updated. If for some reason it has not been updated, restart the POA. 
IMPORTANT: If you specified a post office in the Domains / Post Offices page (Step 8) so that the POA 
will be running on the same server as the MTA, do not select this option. Start the MTA manually and wait 
until it has updated the domain database. For a large domain database, you might need to wait 20 
minutes or more. When the Domain object’s Identification page in ConsoleOne shows that the database 
version has been updated to 6.5, then start the POA to update the post office database. You can check 
the Post Office object’s Identification page in ConsoleOne to verify that the database version has been 
updated to 6.5. If for some reason it has not been updated, see “POA Fails to Update the Post Office 
Database Version” in “Strategies for Agent Problems” in GroupWise 6.5 Troubleshooting 2: Solutions to 
Common Problems.

If you’ve installed the NetWare MTA and want it to run in protected mode on the NetWare 
server, select the Launch in Protected Mode option.

13 Click Finish to perform the selected options.

14 To update post offices in the domain, continue with the next section, Updating Post Offices.

or

To update other domains, skip to “Updating Secondary Domains” on page 227.

Updating Post Offices
To update a post office, you need to install the GroupWise 6.5 POA and run it against the post 
office. The POA uses a new 6.5 version of the post office dictionary file (gwpo.dc) to update the 
post office database to version 6.5.

After you’ve installed the POA, you might also need to copy the new GroupWise client views from 
the software distribution directory to the post office directory.

“Installing and Starting the POA” on page 223

“Copying the GroupWise Views to the Post Office Directory” on page 224

Installing and Starting the POA
The POA cannot be running while you update it. Users who connect to the post office via client/
server (TCP/IP) cannot access the post office while the POA is shut down. However, users who 
connect to the post office via direct access (mapped drive or UNC path) can continue to access the 
post office.
IMPORTANT:  The MTA for the domain that the post office belongs to should be updated and running before 
you install and start the POA.

To install and start the POA:

1 To install the POA to a NetWare server, start the GroupWise Agent Installation program 
(install.exe) from a Windows 98/NT/2000/XP workstation that has access to the server.

or

To install the POA to a Windows server, start the GroupWise Agent Installation program 
(install.exe) from that server.

The install.exe program is located in the \agents directory in the GroupWise 6.5 software 
distribution directory or on the GroupWise 6.5 Administrator CD.
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To streamline the update process on NetWare and Windows, you can run the Agent 
Installation program (agents\install.exe) with the /copyonly startup switch, which copies the 
updated agent software files but does not perform any other agent configuration. On Linux, 
the Installation program offers separate file copy and configuration options to streamline the 
update process.

2 Click Yes to accept the license agreement and display the Overview dialog box.

3 Follow the prompts to complete the installation and start the POA.

The process for installing the POA is identical to installing the MTA. If you need information 
about any of the Installation Agent dialog boxes, refer to “Updating the Primary Domain” on 
page 217.

4 Continue with the next section, Copying the GroupWise Views to the Post Office Directory.

Copying the GroupWise Views to the Post Office Directory
GroupWise 6.5 includes new views for the GroupWise client. When the POA starts, it updates the 
post office database and also attempts to update the client views in the post office directory. To do 
so, it requires access to the software distribution directory. If it doesn’t have access, you must 
manually copy the views.

You can check whether or not the POA was able to update the views by verifying the existence of 
the us02*.vew files in the x:\post_office\ofviews\win directory, where x:\po is the path to the post 
office directory.

If the us02*.vew files do not exist, copy all files from

z:\software\client\ofviews\win

to

x:\po\ofviews\win

where z:\software is the path to the software distribution directory and x:\po is the path to the post 
office directory.
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Updating Users’ GroupWise Clients
After a post office is updated to version 6.5, users who have accounts on that post office can start 
using the GroupWise 6.5 client. The tasks you need to complete to update users depend on whether 
or not the users’ software distribution directory has been updated to GroupWise 6.5.

“Users’ Software Distribution Directory Already Updated” on page 225

“Users’ Software Distribution Directory Requires Updating” on page 225

Users’ Software Distribution Directory Already Updated
If you updated the users’ software distribution directory to version 6.5 during installation, the 
following occurs the next time users start the GroupWise client:

Users who run the GroupWise client from the software distribution directory (a workstation 
installation) are updated to version 6.5.

Users who run the GroupWise client from their local drives (a standard installation) are not 
updated automatically. You need to use the Software Directory Management feature in 
ConsoleOne to force Standard Install users to update. Follow the instructions under “Users’ 
Software Distribution Directory Requires Updating” on page 225, choosing the Force Auto-
Update Check by GroupWise Component option when instructed.

Users’ Software Distribution Directory Requires Updating
If the users’ software distribution directory has not been updated, you need to use the new software 
distribution directory (or the GroupWise 6.5 Administrators CD) to update the users’ old software 
distribution directory. Users are then updated.
IMPORTANT: Before you update a software distribution directory, make sure all post offices that use the 
software distribution directory have been updated. The GroupWise 6.5 client cannot access a pre-6.5 post 
office. Users who update to the GroupWise 6.5 client before their post office has been updated are locked out 
of the post office.

Users cannot be running the GroupWise client from the software distribution directory while you 
are updating the software in it. Open files are not updated.

To update a GroupWise software distribution directory to GroupWise 6.5:

1 Make sure you have Read, Write, Create, Erase, Modify, and File Scan rights (or equivalent 
rights) in an existing GroupWise 6.5 software distribution directory and in the software 
distribution directory you are updating to version 6.5.

or

If you still have access to the GroupWise 6.5 Administrator CD, you can use it instead of an 
existing GroupWise 6.5 software distribution directory.

2 In ConsoleOne, click Tools > GroupWise System Operations > Software Directory 
Management.
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3 Select the software distribution directory you want to update, then click Update to display the 
Update Software Distribution Directory dialog box.

4 Click Update by Copying From.

5 Click Software Distribution Directory, then select the GroupWise 6.5 software distribution 
directory.

or

If the GroupWise 6.5 software distribution directory is not listed, click Path, then enter the 
path to the directory. You can also use this option to update the software directly from the 
GroupWise 6.5 Administrator CD.

The Force Auto-Update Check by GroupWise Components option is automatically selected. 
This causes the GroupWise client to check for a new version; if a new version is found, the 
client then prompts users to update the next time they start the client.
IMPORTANT: If the software distribution directory is already updated to version 6.5 and you are now 
trying to force Standard Install users to update to the GroupWise 6.5 client, you should select only the 
Force Auto-Update Check by GroupWise Components option.

6 Click OK to copy the files.
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IMPORTANT: When you turn on auto-update (the Force Auto-Update Check by GroupWise 
Components option), a flag is set in each post office database. This flag instructs the GroupWise client 
to check for updated software. GroupWise clients using direct access mode (mapped or UNC path) read 
this new setting in the post office database and automatically check for updated software. However, 
GroupWise clients running in client/server mode do not access the post office database directly; instead, 
the Post Office Agent accesses the post office database for them. For the Post Office Agent to read the 
new auto-update setting, you need to restart the Post Office Agent. Only after the POA restarts will 
GroupWise clients running in client/server mode check for updated software. 

Updating Secondary Domains
After you have updated the primary domain, you can update any secondary domains in your 
system. To do so, follow the same process you used to update the primary domain, its post offices, 
and users.

To streamline the update process on NetWare and Windows, you can run the Agent Installation 
program (agents\install.exe) with the /copyonly startup switch, which copies the updated agent 
software files but does not perform any other agent configuration. On Linux, the Installation 
program offers separate file copy and configuration options to streamline the update process.
IMPORTANT: The MTA for the domain that the secondary domain links to should be updated and running 
before you update the secondary domain.

Updating the GroupWise Internet Agent
After you’ve updated your domains and post offices, you can update the Internet Agent. For 
information about update issues you should consider, see “Understanding Internet Agent Updates” 
on page 207.

To streamline the update process on NetWare and Windows, you can run the Internet Agent 
Installation program (internet\gwia\install.exe) with the /copyonly startup switch, which copies 
the updated Internet Agent software files but does not perform any other Internet Agent 
configuration. On Linux, the Installation program offers separate file copy and configuration 
options to streamline the update process.

For complete information about installing GroupWise 6.5 Internet Agent, see Chapter 4, 
“Installing the GroupWise Internet Agent,” on page 73.

Updating GroupWise WebAccess
After you’ve updated your domains and post offices, you can update GroupWise WebAccess. For 
information about update issues you should consider, see “Understanding WebAccess Updates” 
on page 208.

For information about installing GroupWise 6.5 WebAccess, see Chapter 5, “Installing 
GroupWise WebAccess,” on page 93.

Updating GroupWise Monitor
You can update GroupWise Monitor at any time. For information about installing GroupWise 7 
Monitor, see Chapter 6, “Installing GroupWise Monitor,” on page 127.
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15 Updating Your GroupWise 5.x System to 
Version 6.5

The process and procedures for updating a Novell® GroupWise® 5.x system to version 6.5 are the 
same as when updating a GroupWise 6.x system to version 6.5. Refer to the following sections for 
instructions:

Chapter 12, “Understanding the Update Process,” on page 205

Chapter 13, “Preparing Your GroupWise System,” on page 211

Chapter 14, “Updating Your GroupWise 6.x System to Version 6.5,” on page 213

What’s New Since Your GroupWise 5.x Version

The GroupWise features and functionality that are new to you depend on the version of GroupWise 
5 that you are updating from (5, 5.1, 5.2, 5.5, 5.5 Enhancement Pack). For example, if you are 
updating from GroupWise 5.2, the new features and functionality added in versions 5.5, 5.5 
Enhancement Pack, 6, and 6.5 are all new. If you are updating from GroupWise 5.5 Enhancement 
Pack, only the version 6 and 6.5 features are new.

Chapter 11, “What’s New in GroupWise 6.5,” on page 181 includes only the changes made since 
version 6. For changes made in previous versions, refer to the following:

Version 5.2 to 5.5: What’s New in GroupWise 5.5 (http://www.novell.com/documentation/
lg/gw55/gw55updt/data/a4dx2i3.html)

Version 5.5 to 5.5 Enhancement Pack: GroupWise 5.5 Enhancement Pack Getting Started 
(http://www.novell.com/documentation/lg/gw55ep/pdfdoc/gw55ep.pdf)

Version 5.5 EP to 6: What’s New in GroupWise 6 (http://www.novell.com/documentation/
gw6/gw6_install/data/aady5l3.html)

GroupWise 5.2 Administration Agent 
WARNING: Beginning with GroupWise 5.5, the Administration Agent’s functionality was moved into the 
Message Transfer Agent (MTA) and the Post Office Agent (POA). If you are updating a GroupWise 5, 5.1, or 
5.2 system, you need to make sure that you do not run the Administration Agent against the domain after 
you’ve started the GroupWise 6.5 MTA. Doing so can result in the loss of GroupWise 6.5 information.
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16 Updating an Evaluation GroupWise System to a 
Fully Licensed System

An evaluation GroupWise® system, available from the Novell® Product Downloads page (http://
download.novell.com/pages/PublicSearch.jsp), can consist of one domain, two post offices, and as 
many as five users on each post office. When you purchase the full GroupWise product, install the 
GroupWise Administrator snap-ins to ConsoleOne®. When you begin to administer your 
evaluation system with the licensed snap-ins, your evaluation system is converted into a fully 
licensed system, in which you can create any number of domains and post offices, along with the 
number of users for which you are licensed. 
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17 Moving Your Existing GroupWise System to 
Linux

This section is designed for those who are moving existing GroupWise® 6.5 users, post offices, 
and domains to Linux. If you have GroupWise 6.0 or 5.x, review Chapter 14, “Updating Your 
GroupWise 6.x System to Version 6.5,” on page 213 and Chapter 15, “Updating Your GroupWise 
5.x System to Version 6.5,” on page 229 to acquaint yourself with the issues involved in updating 
from one version of GroupWise to another. Because GroupWise 6.5 for Linux is functionally 
equivalent to GroupWise 6.5 Support Pack 1, there are no update issues involved in moving to 
Linux if you are already running GroupWise 6.5.

“Moving Windows Users to Linux or Macintosh” on page 233

“Moving a Post Office to Linux” on page 233

“Moving a Domain to Linux” on page 236

Moving Windows Users to Linux or Macintosh
If users want to move from Windows workstations to Linux or Macintosh, they first need to install 
the Cross-Platform client, as described in “Setting Up the GroupWise Cross-Platform Client” on 
page 173. They can then immediately use the Cross-Platform client to connect to their GroupWise 
mailboxes, regardless of whether the mailboxes reside on Linux, NetWare®, or Windows servers.

If users have Caching mailboxes or archives on their Windows workstations, they can simply copy 
them to an appropriate location on their Linux or Macintosh workstations, and then, in the Cross-
Platform client, update the file location information accordingly (Tools > Options > Archive 
Directory and Caching Mailbox Directory). Remote mode is not currently supported in the Cross-
Platform client, so Remote users should not copy their Remote mailboxes to Linux or Macintosh.

Moving a Post Office to Linux
1 If you are moving a post office that has a library with a remote document storage area, follow 

the steps in Handling Remote Document Storage Areas, then return to this point.

2 On the Linux server, become root in a terminal window.

3 Mount the NetWare or Windows server where the post office is located to the Linux file 
system, using commands similar to the following examples:

NetWare Server:
mount -t ncpfs //NetWare_server_name /mountpoint_directory -o user=username 

-o ipserver=server_IP_address -o server=server_hostname

or

mount -t cifs //NetWare_server_name/volume -o user=username /mountpoint_directory
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The NetWare_server_name should be specified as its full DNS name (for example, 
lnxsvr3.provo.novell.com). The username should be specified as a fully qualified name (for 
example, admin.users.corporate).

Windows Server:
mount -t smbfs //Windows_server_name/sharename /mountpoint_directory -o 
username=username

4 Create a new directory for your GroupWise system into which the post office directory will 
be copied. For example:

mkdir /gwsystem

If you want to use an existing directory, make sure that it is empty.

5 Use DBCopy to copy the post office directory from the NetWare or Windows server to the 
new directory on the Linux server.

./dbcopy -M /post_office_directory /destination_directory

DBCopy is typically used for backing up your GroupWise system, but when you use the -M 
switch to move a post office, it changes directory names to lowercase as required on Linux 
and copies the message queue directories as well as the GroupWise databases in the post 
office. For instructions on installing and running DBCopy, see “GroupWise Database Copy 
Utility” in “Databases” in the GroupWise 6.5 Administration Guide.

At this point, it is acceptable for users to still be running GroupWise. For a large post office, 
it might take one to two hours to copy the post office. You will run DBCopy again in a later 
step, after you have configured the post office for its new location, in order to pick up new and 
modified files. At that point, all users need to be out of GroupWise for a short time.

If you are copying a large post office, you might want to skip to Step 11 to install the POA 
software while the post office is being copied, to further minimize down time for users. You 
should then return to Step 6 when the copying is completed.

6 In ConsoleOne® on Windows, update the location information for the post office:

6a Display the Identification property page of the Post Office object.

6b In the UNC Path field, change the path to the location on the Linux server where you 
copied the post office. For example:

\\linuxsvr3\gwsystem\research

For a Linux server, ConsoleOne interprets the UNC path as a Linux path. Do not put a 
Linux path in the UNC Path field.

6c Display the Identification property page of the POA object for the post office.

6d In the Platform field, make sure that Linux is selected.

6e Display the Network Address property page of the POA object for the post office.

6f In the Network Address field, specify the IP address of the Linux server.

6g Click OK to save the new path and IP address information for the post office.

7 Notify users that they must exit GroupWise unless they are running in Caching mode.

Users in Caching mode do not need access to the post office in order to continue using 
GroupWise.

8 On the NetWare or Windows server, stop the POA for the post office.

GroupWise users can no longer access the post office.
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9 On the Linux server, run DBCopy again.

./dbcopy -M -I mm-dd-yyyy /post_office_directory /destination_directory

When you run DBCopy the second time and include the -I switch with today’s date, it copies 
only files that have been modified today, like an incremental backup. The second DBCopy 
process should be substantially shorter than the first one.

10 Run the standalone GroupWise Check utility (GWCheck) with the storelowercase support 
option to convert the filenames and directory names stored inside GroupWise databases in the 
post office to lowercase:

10a See “Starting GWCheck on a Linux Workstation” in “Databases” in the GroupWise 6.5 
Administration Guide for instructions on installing and starting GWCheck.

10b In the Database Type box, select Post Office.

10c Browse to and select the post office database in its new location, then specify the post 
office name.

10d In the Object Type box, select Post Office.

10e In the Support Options field on the Misc tab, specify storelowercase.

10f Click Run to run GWCheck.

11 Run the GroupWise Installation program to install the Linux POA for the post office, as 
described in “Installing the GroupWise Agents on Linux” on page 157.

12 Start the Linux POA using the --show startup switch, as described in “Starting the Linux 
Agents with a User Interface” on page 159.

13 If your system includes an Internet Agent that is used for POP and IMAP e-mail clients, check 
the link between the Internet Agent and the post office:

13a In ConsoleOne on Windows, right-click the Internet Agent object, then click Properties.

13b Click Post Office Links.

13c Make sure that the link shows the correct IP address where the Linux POA for the moved 
post office is now running.

14 If your system includes the WebAccess Agent, check the link between the WebAccess Agent 
and the moved post office:

14a In ConsoleOne on Windows, right-click the WebAccess Agent object, then click 
Properties.

14b Click Post Office Links.

14c Make sure that the link shows the correct IP address where the Linux POA for the moved 
post office is now running.

15 Provide GroupWise users with the new IP address where the Linux POA is now running so 
that they can start GroupWise again and access their mailboxes on the Linux server.

If you are running a GroupWise name server, as described in “Simplifying Client/Server 
Access with a GroupWise Name Server” in “Post Office Agent” in the GroupWise 6.5 
Administration Guide, users are automatically redirected to the new IP address when they start 
GroupWise.

16 When the Linux POA is running smoothly for the new post office location, delete the old post 
office directory structure on the NetWare or Windows server.
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17 Set up a backup procedure for the post office in it new location, as described in “GroupWise 
Database Copy Utility” in “Databases” in the GroupWise 6.5 Administration Guide.

Handling Remote Document Storage Areas
If the post office that you are moving to Linux has a library with a remote document storage area 
that is still located on NetWare or Windows, you have two alternatives for accessing the document 
storage area:

Mount the storage area: You can leave the document storage area on the NetWare or 
Windows servers. To provide access, you mount the storage area to the Linux server where 
the post office is located, using the command provided in Step 3 in “Moving a Post Office to 
Linux” on page 233. 

Move the storage area: If you want to eliminate the NetWare or Windows server, you can 
move the document storage area to a convenient location on the Linux server. This also 
eliminates the need for mounting file systems.

In either case, before the Linux POA can successfully access the document storage area, you must 
make sure that all directory names and file names are in lowercase.

In addition, you must update the document storage area location in ConsoleOne:

1 Browse to and right-click the Library object, then click Properties.

2 Click GroupWise > Storage Areas.

3 Select the storage area that you have moved, then click Edit.

4 In the Linux Path field, provide the full path to the storage area from the point of view of the 
POA running on the Linux server.

5 Click OK twice to save the storage area information.

6 Return to Step 2 in “Moving a Post Office to Linux” on page 233.

Moving a Domain to Linux
1 On the Linux server, become root in a terminal window.

2 Mount the NetWare or Windows server where the domain is located as a Linux file system, 
using commands similar to the following examples:

NetWare Server:
mount -t ncpfs //NetWare_server_name /mountpoint_directory -o user=username

-o ipserver=server_IP_address -o server=server_hostname

or

mount -t cifs //NetWare_server_name/volume -o user=username /mountpoint_directory

The NetWare_server_name should be specified as its full DNS name (for example, 
lnxsvr3.provo.novell.com). The username should be specified as a fully qualified name (for 
example, cn=admin.users.corporate).

Windows Server:
mount -t smbfs //Windows_server/sharename /mountpoint_directory -o username=username

3 If you have not already done so, create a new directory for your GroupWise system into which 
the domain directory will be copied. For example:
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mkdir /gwsystem

If you want to use an existing directory, make sure that it is empty.

4 On the NetWare or Windows server, stop the MTA for the domain.

5 If the domain has gateways, stop the gateways.

6 Use DBCopy to copy the domain directory from the NetWare or Windows server to the new 
directory on the Linux server.

./dbcopy -M /domain directory /destination_directory

DBCopy is typically used for backing up your GroupWise system, but when you use the -M 
switch to move a domain, it changes directory names to lowercase as required on Linux and 
copies the message queue directories as well as well as the GroupWise databases in the 
domain. For instructions on installing and running DBCopy, see “GroupWise Database Copy 
Utility” in “Databases” in the GroupWise 6.5 Administration Guide.

7 In ConsoleOne on Windows, update the location information for the domain:

7a Display the Identification property page of the Domain object.

7b In the UNC Path field, change the path to the location on the Linux server where you 
moved the domain. For example:

\\linuxsvr3\gwsystem\provo3

For a Linux server, ConsoleOne interprets the UNC path as a Linux path. Do not put a 
Linux path in the UNC Path field.

7c Display the Identification property page of the MTA object for the domain.

7d In the Platform field, make sure that Linux is selected.

7e Display the Network Address property page of the MTA object for the domain.

7f In the Network Address field, specify the IP address of the Linux server.

7g Click OK to save the new directory and IP address information for the domain.

8 If you are using the /work startup switch to place the MTA working directory (mslocal) 
outside the domain directory structure:

8a Copy the mslocal directory to the Linux server so that no messages en route between 
users are lost.

8b In the mslocal directory structure, rename files and directories that contain uppercase 
letters to all lowercase.

9 Run the GroupWise Installation program to install the MTA for the new domain location, as 
described in “Installing the GroupWise Agents on Linux” on page 157.

10 If the domain has gateways, follow the instructions in “Handling Gateways” on page 238 
before you proceed with Step 11.

11 Start the Linux MTA using the --show startup switch, as described in “Starting the Linux 
Agents with a User Interface” on page 159.

12 At the MTA agent console, check to see if all links between the new Linux MTA and other 
domains and post offices are open.

If you have closed links, see “MTA Status Box Shows a Closed Location” in “Strategies for 
Agent Problems” in GroupWise 6.5 Troubleshooting 2: Solutions to Common Problems.

13 If the domain has gateways, start each gateway.
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14 When the Linux MTA is running smoothly for the domain new location, delete the old domain 
directory structure (and if applicable, the mslocal directory structure) on the NetWare or 
Windows server.

Handling Gateways
If the domain that you moved to Linux has gateways associated with it, you must reselect each 
gateway directory in ConsoleOne:

1 Browse to and select the Domain object for the domain you just moved to Linux.

2 Right-click a Gateway object, then click Properties.

3 Click GroupWise > Identification.

4 In the Subdirectory field, reselect the gateway directory.

If you do not have any gateway subdirectories to choose from, you have not successfully 
completed Step 7 in “Moving a Domain to Linux” on page 236.

5 Click OK to save the gateway directory information.

6 Repeat Step 2 through Step 5 for each gateway that belongs to the domain.

7 Return to Step 11 on page 237 to start the Linux MTA for the domain.
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III Appendixes

Appendix A, “GroupWise Version Compatibility,” on page 239
Appendix B, “Third-Party Materials,” on page 247
Appendix C, “Documentation Updates,” on page 257
Appendixes 237



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
238   GroupWise 6.5 Installation Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
A GroupWise Version Compatibility

Use the tables in this section to determine compatibility among the following Novell® 
GroupWise® versions:

“GroupWise 6.5 for Linux” on page 239

“GroupWise 6.5” on page 243

“GroupWise 6” on page 246
IMPORTANT: GroupWise 5.x versions have entered the end-of-life phase and are no longer supported. For 
update instructions, see Chapter 15, “Updating Your GroupWise 5.x System to Version 6.5,” on page 227. The 
GroupWise 5.x administration tool, NetWare® Administrator with GroupWise snap-ins, cannot be used to 
administer GroupWise 6.x systems.

For each GroupWise version, the tables indicate compatibility for:

Administrative components: Domain and post office database platforms and versions, 
eDirectoryTM platforms, and GroupWise snap-in to ConsoleOne® platforms and versions

Agents: Domain and post office database platforms and versions, agent platforms and 
versions

Clients: Post office directory platforms and access, POA platforms and versions, client modes

In the compatibility tables, cells that combinations that are not applicable are marked N/A. For 
example, the POA never needs to communicates with the Internet Agent, so that table cell is N/A.

For information about what operating system versions are supported for GroupWise 6.5 on 
NetWare, Linux, and Windows, refer to “GroupWise System Requirements” on page 19. For 
information about what operating system versions are supported for GroupWise 6, refer to the 
GroupWise 6 Installation Guide (http://www.novell.com/documentation/gw6).

 GroupWise 6.5 for Linux
In the compatibility tables, GroupWise 6.5 for Linux is represented by GW 6.5L where space is 
limited.

“Compatibility with GroupWise 6.5” on page 240

“Compatibility with GroupWise 6” on page 241
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Compatibility with GroupWise 6.5

GroupWise 6.5 Administrative Components with GroupWise 6.5 for Linux

Table Summary: On both Linux and Windows, ConsoleOne with the GroupWise snap-ins can be 
used to access GroupWise databases for domains and post offices and GroupWise objects in 
eDirectory located on NetWare, Linux, or Windows. When using Linux ConsoleOne to administer 
domains and post offices on NetWare or Windows, you must mount the NetWare or Windows 
server to your Linux machine. When using Windows ConsoleOne to administer domains and post 
offices on Linux, you can use a Samba share to access the Linux server from your Windows 
machine.

GroupWise 6.5 Agents with GroupWise 6.5 for Linux

GroupWise 6.5 for Linux 
Components

GroupWise 6.5
Domain and Post Office 
Databases on NetWare 
or Windows

GW 6.5 Objects in 
eDirectory on NetWare 
or Windows

Windows ConsoleOne 
+ GW 6.5 Snap-Ins

GW 6.5L Domain and 
Post Office Databases 
on Linux

N/A N/A Supported

GW 6.5L Objects in 
eDirectory on Linux

N/A N/A Supported

Linux ConsoleOne + 
GW 6.5L snap-ins

Supported Supported N/A

GroupWise 6.5
for Linux 
Agents

GroupWise 6.5
Domain or 
Post Office 
Databases on 
NetWare or 
Windows

GW 6.5
MTA on
NetWare or 
Windows 

GW 6.5
POA on
NetWare or 
Windows 

GW 6.5
GWIA on
NetWare or 
Windows 

GW 6.5
WebAccess
on NetWare 
or Windows 

GW 6.5
Monitor on
Windows 

GW 6.5L Domain 
and Post Office 
Databases
on Linux

N/A Supported Supported Supported Supported Supported

GW 6.5L MTA
on Linux

Supported Supported Supported Supported N/A Supported

GW 6.5L POA
on Linux

Supported Supported N/A N/A Supported Supported

GW 6.5L GWIA
on Linux

Supported Supported N/A Supported N/A Supported

GW 6.5L 
WebAccess
on Linux

Supported N/A Supported N/A N/A Supported

GW 6.5L Monitor
on Linux

Supported Supported Supported Supported Supported N/A
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Table Summary: Domains and post offices can be located on NetWare, Linux, or Windows. We 
do not recommended that you run the Linux agents for domains and post offices located on 
NetWare and Windows. However, existing GroupWise 6.5 domains and post offices can be moved 
onto Linux servers so that the Linux agents can update them to GroupWise 6.5 for Linux. All the 
Linux agents can communicate as usual with the NetWare and Windows agents.

GroupWise 6.5 Mailbox Access with the GroupWise 6.5 Cross-Platform Client

Table Summary: The GroupWise 6.5 for Linux Cross-Platform client can communicate in client/
server mode with the GroupWise 6.5 POA on NetWare or Windows. The Cross-Platform client 
cannot access the post office directly, nor can it communicate with the GroupWise 6.5 POA across 
a dial-up connection over a modem. Remote mode is not supported in the Cross-Platform client.

Compatibility with GroupWise 6

GroupWise 6 Administrative Components with GroupWise 6.5 for Linux

Table Summary: On Linux, ConsoleOne with the GroupWise snap-ins can be used to access 
GroupWise databases for domains and post offices and GroupWise objects in eDirectory on 
NetWare, Linux, and Windows. On Windows, ConsoleOne with the GroupWise 6 snap-ins cannot 
be used to access GroupWise 6.5 for Linux domains and post offices on Linux. The general rule 
is that later GroupWise snap-ins can administer earlier GroupWise system components, but earlier 
GroupWise snap-ins cannot administer later GroupWise system components.

GroupWise 6.5
for Linux 
Client

GroupWise 6.5
Post Office 
Direct Access

GW 6.5 POA 
Client/Server Access
Online Mode

GW 6.5 POA
Client/Server Access
Caching Mode

GW 6.5 POA
Dial-Up Access
Remote Mode

Cross-Platform 
client on Linux

Not supported Supported Supported Not supported

GroupWise 6.5 for Linux 
Components

GroupWise 6
Domain and Post Office 
Databases on NetWare 
or Windows 

GW 6 Objects in 
eDirectory on NetWare 
or Windows

Windows ConsoleOne 
+ GW 6 snap-ins

GW 6.5L Domain and Post 
Office Databases on Linux

N/A N/A Not Supported

GW 6.5L Objects in 
eDirectory on Linux

N/A N/A Not Supported

Linux ConsoleOne + 
GW 6.5L snap-ins

Supported Supported N/A
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GroupWise 6 Agents with GroupWise 6.5 for Linux

Table Summary: Domains and post offices can be located on NetWare, Linux, or Windows. We 
do not recommended that you run the Linux agents for domains and post offices located on 
NetWare and Windows. However, existing GroupWise 6 domains and post offices can be moved 
onto Linux servers so that the Linux agents can update them to GroupWise 6.5 for Linux. Although 
most GW 6.5L/GW 6 agent combinations are supported, note that two combinations are not 
supported.

GroupWise 6 Mailbox Access with the GroupWise 6.5 Cross-Platform Client

Table Summary: The GroupWise 6.5 for Linux Cross-Platform client cannot access a GroupWise 
6 post office in any way. The general rule is that earlier POAs cannot communicate with later 
GroupWise clients, but later GroupWise POAs can always communicate with earlier GroupWise 
clients.

GroupWise 6.5 
for Linux 
Agents

GroupWise 6
Domain and 
Post Office 
Databases on 
NetWare or 
Windows

GW 6 MTA 
on NetWare 
or Windows 

GW 6 POA 
on NetWare 
or Windows 

GW 6 GWIA
on NetWare or 
Windows 

GW 6 
WebAccess
on NetWare 
or Windows 

GW 6 Monitor
on Windows 

GW 6.5L 
Domain and 
Post Office 
Databases
on Linux

N/A Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

GW 6.5L MTA
on Linux

Supported Supported Supported Supported N/A Supported

GW 6.5L POA
on Linux

Supported Supported N/A N/A Supported Supported

GW 6.5L 
GWIA 
on Linux

Supported Supported N/A Not 
Supported

N/A Supported

GW 6.5L 
WebAccess
on Linux

Supported N/A Not 
Supported

N/A N/A Supported

GW 6.5L 
Monitor
on Linux

Supported Supported Supported Supported Supported N/A

GroupWise 6.5
for Linux 
Client

GroupWise 6
Post Office 
Direct Access

GW 6 POA 
Client/Server Access
Online Mode

GW 6 POA
Client/Server Access
Caching Mode

GW 6 POA
Dial-Up Access
Remote Mode

Cross-Platform 
client on Linux

Not supported Not supported Not supported Not supported
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GroupWise 6.5
Select the GroupWise version that you want to determine GroupWise 6.5 compatibility with:

“Compatibility with GroupWise 6” on page 243

“Compatibility with GroupWise 5.x” on page 244

Compatibility with GroupWise 6

GroupWise 6 Administrative Components with GroupWise 6.5

Table Summary: ConsoleOne with the GroupWise 6.5 snap-ins can be used to access GroupWise 
6 databases for domains and post office and GroupWise 6 eDirectory objects. However, 
ConsoleOne with the GroupWise 6 snap-ins cannot be used to access GroupWise 6.5 databases 
and GroupWise 6 eDirectory objects. The general rule is that later GroupWise snap-ins can 
administer earlier GroupWise system components, but earlier GroupWise snap-ins cannot 
administer later GroupWise system components.

GroupWise 6 Agents with GroupWise 6.5

GroupWise 6.5
Components

GroupWise 6 
Domain and Post Office 
Databases

GW 6 Objects in 
eDirectory

ConsoleOne + 
GW 6 Snap-Ins

GW 6.5 Domain and Post 
Office Databases

N/A N/A Not Supported

GW 6.5 Objects in 
eDirectory

N/A N/A Not Supported

ConsoleOne + 
GW 6.5 snap-ins

Supported Supported N/A

GroupWise 6.5
Agents

GroupWise 6 
Domain and 
Post Office 
Databases

GW 6 MTA GW 6 POA GW 6 GWIA GW 6 
WebAccess

GW 6 
Monitor

GW 6.5 Domain 
and Post Office 
Databases

N/A Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

GW 6.5 MTA Supported Supported Supported Supported N/A Supported

GW 6.5 POA Supported Supported N/A N/A Supported Supported

GW 6.5 GWIA Supported Supported N/A Not 
Supported

N/A Supported

GW 6.5 
WebAccess

Supported N/A Not 
Supported

N/A N/A Supported

GW 6.5 Monitor Supported Supported Supported Supported Supported N/A
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Table Summary: GroupWise 6 agents cannot access domain and post office databases that have 
been updated to GroupWise 6.5. When a GroupWise 6.5 MTA or POA accesses a GroupWise 6 
database, it automatically updates the database to GroupWise 6.5. Although most GroupWise 6.5/
GroupWise 6 agent combinations are supported, note that two combinations are not supported.

GroupWise 6 Mailbox Access with the GroupWise 6.5 Windows Client

Table Summary: The GroupWise 6.5 Windows client cannot communicate with the GroupWise 
6 POA, nor can it access a GroupWise 6 post office directly. The general rule is that earlier POAs 
cannot communicate with later GroupWise clients, but later POAs can always communicate with 
earlier GroupWise clients.

GroupWise 6.5 Mailbox Access with the GroupWise 6 Windows Client

Table Summary: The GroupWise 6 Windows client can communicate with the GroupWise 6.5 
POA, but it cannot access a GroupWise 6.5 post office directly. The general rule is that later POAs 
can always communicate with earlier GroupWise clients, but earlier POAs cannot communicate 
with later GroupWise clients.

Compatibility with GroupWise 5.x

GroupWise 5.x Administrative Components with GroupWise 6

Table Summary: NetWare Administrator cannot be used to administer GroupWise 6 systems. 
ConsoleOne with the GroupWise 6 snap-ins can be used to administer GroupWise 5.x systems. 
The general rule is that later GroupWise snap-ins can administer earlier GroupWise system 
components, but earlier GroupWise snap-ins cannot administer later GroupWise system 
components.

GroupWise 6.5
Windows Client

GroupWise 6
Post Office
Direct Access

GW 6 POA
Client/Server Access 
Online Mode

GW 6 POA
Client/Server Access 
Caching Mode

GW 6 POA
Dial-Up Access
Remote Mode

Windows 
client

Not Supported Not Supported Not Supported Not Supported

GroupWise 6
Windows Client

GroupWise 6.5
Post Office
Direct Access

GW 6.5 POA
Client/Server Access 
Online Mode

GW 6.5 POA
Client/Server Access 
Caching Mode

GW 6.5 POA
Dial-Up Access
Remote Mode

Windows 
client

Not Supported Supported Supported Supported

GroupWise 6
Components

GroupWise 5.x 
Domain and Post Office 
Databases

GW 5.x Objects in 
eDirectory

NetWare Administrator
+ GW 5.x Snap-Ins

GW 6 Domain and Post 
Office Databases

N/A N/A Not Supported

GW 6 Objects in 
eDirectory

N/A N/A Not Supported

ConsoleOne + 
GW 6 snap-ins

Supported Supported N/A
244   GroupWise 6.5 Installation Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
GroupWise 5.x Agents with GroupWise 6

Table Summary: GroupWise 5.x agents cannot access domain and post office databases that have 
been updated to GroupWise 6. When the GroupWise 6 MTA or POA accesses a GroupWise 5.x 
database, it automatically updates the database to GroupWise 6. Although most GroupWise 6/
GroupWise 5.x agent combinations are supported, note that two combinations are not supported.

GroupWise 5.x Mailbox Access with the GroupWise 6 Windows Client

Table Summary: The GroupWise 6 Windows client cannot communicate with the GroupWise 5.x 
POA, nor can it access a GroupWise 5.x post office directly. The general rule is that later 
GroupWise clients cannot communicate with earlier POAs.

GroupWise 6 Mailbox Access with the GroupWise 5.x Windows Client

Table Summary: The GroupWise 5.x Windows client can communicate with the GroupWise 6 
POA, but it cannot access a GroupWise 6 post office directly. The general rule is that later POAs 
can always communicate with earlier GroupWise clients, but earlier POAs cannot communicate 
with later GroupWise clients.

GroupWise 6
Agents

GroupWise 5.x 
Domain and 
Post Office 
Databases

GW 5.x MTA GW 5.x POA GW 5.x GWIA GW 5.x 
WebAccess

GW 5.x 
Monitor

GW 6 Domain and 
Post Office 
Databases

N/A Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

Not 
Supported

GW 6 MTA Supported Supported Supported Supported N/A Supported

GW 6 POA Supported Supported N/A N/A Supported Supported

GW 6 GWIA Supported Supported N/A Not 
Supported

N/A Supported

GW 6 WebAccess Supported N/A Not 
Supported

N/A N/A Supported

 GW 6 Monitor Supported Supported Supported Supported Supported N/A

GroupWise 6
Client

GroupWise 5.x
Post Office
Direct Access

GW 5.x POA 
Client/Server Access 
Online Mode

GW 5.x POA
Client/Server Access 
Caching Mode

GW 5.x POA
Dial-Up Access
Remote Mode

Windows 
client

Not supported Not Supported Not Supported Not Supported

GroupWise 5.x
Client

GroupWise 6
Post Office
Direct Access

GW 6 POA 
Client/Server Access 
Online Mode

GW 6 POA
Client/Server Access 
Caching Mode

GW 6 POA
Dial-Up Access
Remote Mode

Windows 
client

Not supported Supported Supported Supported
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GroupWise 6
See the following sections:

GroupWise 6.5 for Linux: “Compatibility with GroupWise 6” on page 241

GroupWise 6.5: “Compatibility with GroupWise 6” on page 243
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B Third-Party Materials

The following third-party software is included in Novell® GroupWise® 6.5 for Linux:

“Apache Server 2 / Tomcat 4.1” on page 247

“OpenSSL” on page 248

“OpenLDAP” on page 250

“NET-SNMP Open Source Package” on page 250

“ODMA 2.0” on page 253

“Python 2.2” on page 254

“getopt.h” on page 254

“JRE” on page 255

Apache Server 2 / Tomcat 4.1
The Apache Software License, Version 1.1
Copyright (c) 2000 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the 
following acknowledgment:

"This product includes software developed by the Apache Software Foundation (http://
www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such 
third-party acknowledgments normally appear.

4. The names "Apache" and "Apache Software Foundation" must not be used to endorse or 
promote products derived from this software without prior written permission. For written 
permission, please contact apache@apache.org.

5. Products derived from this software may not be called "Apache", nor may "Apache" appear 
in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
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MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the 
Apache Software Foundation. For more information on the Apache Software Foundation, please 
see <http://www.apache.org/>.

Portions of this software are based upon public domain software originally written at the National 
Center for Supercomputing Applications, University of Illinois, Urbana-Champaign.

OpenSSL
OpenSSL License
Copyright (c) 1998-2002 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1 Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

3 All advertising materials mentioning features or use of this software must display the 
following acknowledgment:

 "This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit. (http://www.openssl.org/)"

4 The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or 
promote products derived from this software without prior written permission. For written 
permission, please contact openssl-core@openssl.org.

5 Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" 
appear in their names without prior written permission of the OpenSSL Project.

6 Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
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OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This 
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The 
implementation was written so as to conform with Netscape’s SSL.

This library is free for commercial and non-commercial use as long as the following conditions are 
adhered to. The following conditions apply to all code found in this distribution, be it the RC4, 
RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson 
(tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be 
removed. If this package is used in a product, Eric Young should be given attribution as the author 
of the parts of the library used. This can be in the form of a textual message at program startup or 
in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1 Redistributions of source code must retain the copyright notice, this list of conditions and the 
following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

3 All advertising materials mentioning features or use of this software must display the 
following acknowledgement: 

"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" 

The word “cryptographic” can be left out if the routines from the library being used are not 
cryptographic related :-).

4 If you include any Windows specific code (or a derivative thereof) from the apps directory 
(application code) you must include an acknowledgement: 

"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
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NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publicly available version or derivative of this code 
cannot be changed; i.e. this code cannot simply be copied and put under another distribution 
licence [including the GNU Public Licence.]

OpenLDAP
The OpenLDAP Public License
Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or 
without modification, are permitted provided that the following conditions are met:

1 Redistributions in source form must retain copyright statements and notices,

2 Redistributions in binary form must reproduce applicable copyright statements and notices, 
this list of conditions, and the following disclaimer in the documentation and/or other 
materials provided with the distribution, and

3 Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time. Each revision is 
distinguished by a version number. You may use this Software under terms of this license revision 
or under the terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS 
CONTRIBUTORS ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS 
CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to 
promote the sale, use or other dealing in this Software without specific, written prior permission. 
Title to copyright in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All Rights 
Reserved. Permission to copy and distribute verbatim copies of this document is granted.

NET-SNMP Open Source Package
Various copyrights apply to this package, listed in 4 separate parts below. Please make sure that 
you read all the parts. Up until 2001, the project was based at UC Davis, and the first part covers 
all code written during this time. From 2001 onwards, the project has been based at SourceForge, 
and Networks Associates Technology, Inc hold the copyright on behalf of the wider Net-SNMP 
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community, covering all derivative work done since then. An additional copyright section has 
been added as Part 3 below also under a BSD license for the work contributed by Cambridge 
Broadband Ltd. to the project since 2001. An additional copyright section has been added as Part 
4 below also under a BSD license for the work contributed by Sun Microsystems, Inc. to the 
project since 2003.

---- Part 1: CMU/UCD copyright notice: (BSD like) -----
Copyright 1989, 1991, 1992 by Carnegie Mellon University
Derivative Work - 1996, 1998-2000
Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose 
and without fee is hereby granted, provided that the above copyright notice appears in all copies 
and that both that copyright notice and this permission notice appear in supporting documentation, 
and that the name of CMU and The Regents of the University of California not be used in 
advertising or publicity pertaining to distribution of the software without specific written 
permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL 
WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR 
THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION 
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN 
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution. 

Neither the name of the Networks Associates Technology, Inc nor the names of its 
contributors may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
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SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING 
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution. 

The name of Cambridge Broadband Ltd. may not be used to endorse or promote products 
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----
Copyright © 2003 Sun Microsystems, Inc., 
4150 Network Circle, Santa Clara, California 95054, U.S.A. 
All rights reserved.

Use is subject to license terms below.

This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.
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Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used 
to endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING 
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

ODMA 2.0
OPEN DOCUMENT MANAGEMENT API LICENSE 1.0
ODMA 2.0 SPECIFICATIONS AND SOFTWARE 
Copyright © 1994-1998 AIIM International

LICENSE:

Redistribution and use in source and binary forms, with or without modifications, are permitted 
provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

Neither the name of AIIM International nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.

DISCLAIMER:

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
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THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

ADDITIONAL INFORMATION:

ODMA reference materials, software, and status: 
<http://ODMA.info>

Information about this ODMA License and its application: 
<http://DMare.info/license/>

Open Source Definition 1.9 and the BSD License 
(the model for this ODMA license): 
<http://opensource.org>

HTML (ISO 8859-1) version of this license: 
<http://Dmware.info/license/P040801F.htm>

Python 2.2
Copyright (c) 1991 - 1995, Stichting Mathematisch Centrum Amsterdam, The Netherlands. All 
rights reserved.

Permission to use, copy, modify, and distribute this software and its documentation for any 
purpose and without fee is hereby granted, provided that the above copyright notice appear in all 
copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Stichting Mathematisch Centrum or CWI not be used in 
advertising or publicity pertaining to distribution of the software without specific, written prior 
permission.

STICHTING MATHEMATISCH CENTRUM DISCLAIMS ALL WARRANTIES WITH 
REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL STICHTING 
MATHEMATISCH CENTRUM BE LIABLE FOR ANY SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM 
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, 
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION 
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

getopt.h
Copyright (c) 2000 The NetBSD Foundation, Inc.
All rights reserved.

This code is derived from software contributed to The NetBSD Foundation by Dieter Baron and 
Thomas Klausner.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.
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3. All advertising materials mentioning features or use of this software must display the 
following acknowledgement:

This product includes software developed by the NetBSD Foundation, Inc. and its 
contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used 
to endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

JRE
JRE Note

This product includes code licensed from RSA Security, Inc. Some portions licensed from IBM 
are available at http://oss.software.ibm.com/icu4j/.
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C Documentation Updates

This section lists updates to the Installation Guide that have been made since the initial release of 
Novell® GroupWise® 6.5. The information helps you to keep current on documentation updates 
and, in some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the Installation Guide was republished. 
Within each dated section, the updates are listed by the section title.

The GroupWise 6.5 Installation Guide has been updated on the following dates:

“February 6, 2006 (GroupWise 6.5 SP6)” on page 257

“October 31, 2005” on page 258

“September 19, 2005 (GroupWise 6.5 SP5)” on page 258

“February 28, 2005 (GroupWise 6.5 SP4)” on page 259

“November 30, 2004 (GroupWise 6.5 SP3)” on page 259

“September 30, 2004” on page 260

“June 25, 2004 (GroupWise 6.5 SP2 and GroupWise 6.5 for Linux SP2)” on page 260

“May 3, 2004 (GroupWise 6.5 for Linux)” on page 260

“October 31, 2003” on page 262

“July 16, 2003 (SP1)” on page 263

February 6, 2006 (GroupWise 6.5 SP6)

Location Change

Install

“GroupWise System 
Requirements” on page 19

Removed Konqueror from the lists of supported Web browsers.

Update

“Moving a Post Office to 
Linux” on page 231

Added a second sample mount command.

“Moving a Domain to Linux” 
on page 234

Added a second sample mount command.
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October 31, 2005

September 19, 2005 (GroupWise 6.5 SP5)

Location Change

Update

“Updating Post Offices” on 
page 222

Included information about the /copyonly startup switch for the Agent 
Installation program.

“Updating Secondary 
Domains” on page 226

Included information about the /copyonly startup switch for the Agent 
Installation program.

“Updating the GroupWise 
Internet Agent” on page 226

Included information about the /copyonly startup switch for the Internet 
Agent Installation program.

Location Change

Installation

Chapter 2, “GroupWise 
System Requirements,” on 
page 19

Increased the visibility of GroupWise system requirements.

“Selecting the Internet 
Agent Installation Directory” 
on page 78

Clarified that it’s best to install the Internet Agent on the same server 
where the domain directory is located.

“Starting the Internet Agent 
on NetWare” on page 86

Added instructions for stopping the Internet Agent on NetWare®.

“Starting the Internet Agent 
on Windows” on page 89

Added instructions for stopping the Internet Agent on Windows.

“Starting GroupWise 
WebAccess” on page 110

Added instructions for stopping the WebAccess Agent on NetWare and 
Windows.

“Monitor Agent Console on a 
Windows Server” on 
page 142

Added instructions for stopping the Monitor Agent on Windows.

“Installing the NetWare 
Agent Software” on 
page 155

Added instructions for stopping the agents on NetWare.

“Installing the Windows 
Agent Software” on 
page 164

Added instructions for stopping the agents on Windows.

Update

“Understanding Monitor 
Updates” on page 208

Added planning considerations for updating GroupWise Monitor.
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February 28, 2005 (GroupWise 6.5 SP4)

November 30, 2004 (GroupWise 6.5 SP3)

“Updating GroupWise 
Monitor” on page 226

Added installation instructions for updating GroupWise Monitor.

Chapter 15, “Updating Your 
GroupWise 5.x System to 
Version 6.5,” on page 227

Added a warning about the GroupWise 5.x Administration Agent.

Appendix

“Compatibility with 
GroupWise 6” on page 243

Added a table showing that the GroupWise 6 Windows client is 
supported when accessing a post office where a GroupWise 6.5 POA 
is running.

“Compatibility with 
GroupWise 5.x” on 
page 244

Added a table showing that the GroupWise 5.x Windows client is 
supported when accessing a post office where a GroupWise 6 POA is 
running.

Location Change

Installation

“GroupWise System 
Requirements” on page 19

Clarified that it is the 32-bit versions of the listed operating systems that 
are supported.

“Selecting a Linux Mount 
Directory” on page 60

Added examples of mount directories for Linux, NetWare, and 
Windows servers.

Appendix

“GroupWise Version 
Compatibility” on page 239

Added a link from the GroupWise Version Compatibility chart to the list 
of supported operating systems for GroupWise 6.5 and GroupWise 6.

Location Change

Installation

“GroupWise System 
Requirements” on page 19

Added SUSE Linux Enterprise Server 9 and Windows 2003 Server to 
the list of supported operating systems.

“Planning Your Basic 
GroupWise System” on 
page 24

Added a link to the GroupWise 6.5 Best Practices Guide.

“GroupWise Internet Agent 
Overview” on page 73

Added that the Linux version of the Internet Agent is SNMP compliant.

“Using SNMP Traps to 
Monitor the Windows 
Internet Agent” on page 81

Clarified that the NetWare and Linux Internet Agents do not require a 
separate installation option in order to have SNMP functionality.

Location Change
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September 30, 2004

June 25, 2004 (GroupWise 6.5 SP2 and GroupWise 6.5 for Linux 
SP2)

May 3, 2004 (GroupWise 6.5 for Linux)

“WebAccess System 
Requirements” on page 96

Added a link to information about using WebAccess with unsupported 
Web servers.

“Windows Options” on 
page 101

Clarified that the NetWare and Linux WebAccess Agents do not require 
a separate installation option in order to have SNMP functionality.

“Using SNMP Traps to 
Monitor the Windows 
Agents” on page 153

Clarified that the NetWare and Linux WebAccess POA and MTA do not 
require a separate installation option in order to have SNMP 
functionality.

Update

“Moving a Post Office to 
Linux” on page 231 and 
“Moving a Domain to Linux” 
on page 234

Clarified that the destination directory when moving a domain or post 
office to Linux must be empty.

Location Change

Update

“Moving a Post Office to 
Linux” on page 231

Updated the instructions for migrating a post office to Linux based on 
the new GroupWise Check functionality

Location Change

Install

“Installing GroupWise 
Messenger” on page 175

Clarified that a Messenger system is completely independent from a 
GroupWise system.

Update

Chapter 17, “Moving Your 
Existing GroupWise System 
to Linux,” on page 231

Updated the instructions for migrating your GroupWise system to Linux 
servers based on the new DBCopy functionality

Location Change

Install

Location Change
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“GroupWise System 
Requirements” on page 19

Consolidated GroupWise system requirements, including Linux 
requirements

“System and Domain 
Names” on page 28

Clarified that system and domain names cannot contain asterisks (*)

“Linux Server” on page 40 Added a system diagram of a GroupWise system on a Linux server

“Setting Up a Basic 
GroupWise System on 
Linux” on page 57

Added instructions for setting up a basic GroupWise system on a Linux 
server

“Internet Agent System 
Requirements” on page 76

Added Linux to the GroupWise Internet Agent system requirements

“Installing the Internet Agent 
Software on Linux” on 
page 84

and

“Starting the Internet Agent 
on Linux” on page 86

Added instructions for setting up the Internet Agent on a Linux server

“WebAccess System 
Requirements” on page 96

Added Linux to the GroupWise WebAccess system requirements

“Setting Up GroupWise 
WebAccess on Linux” on 
page 111

Added instructions for setting up GroupWise WebAccess on Linux

“Monitor System 
Requirements” on page 129

Added Linux to the GroupWise Monitor system requirements

“Setting Up GroupWise 
Monitor on Linux” on 
page 135

Added instructions for setting up GroupWise Monitor on a Linux server

“GroupWise Agent 
Overview” on page 147

Added an overview of the GroupWise agents

“Agent System 
Requirements” on page 148

Added Linux to the GroupWise agent system requirements

“Setting Up the GroupWise 
Agents on Linux” on 
page 157

Added instructions for setting up the GroupWise agents

“GroupWise Client 
Workstation Requirements” 
on page 169

Added system requirements for the GroupWise Cross-Platform client

“Setting Up the GroupWise 
Cross-Platform Client” on 
page 173

Added instructions for installing and starting the GroupWise Cross-
Platform client

Update

Location Change
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October 31, 2003

Chapter 10, “What’s New in 
GroupWise 6.5 for Linux,” 
on page 179

Provided a brief overview of GroupWise 6.5 for Linux

Chapter 17, “Moving Your 
Existing GroupWise System 
to Linux,” on page 231

Explained how to migrate your GroupWise system to Linux servers

Appendixes

Appendix A, “GroupWise 
Version Compatibility,” on 
page 239

Reworked the GroupWise version compatibility matrix to include the 
LInux components provided by GroupWise 6.5 for Linux

Appendix B, “Third-Party 
Materials,” on page 247

Added third-party materials required by some open-source 
components included in GroupWise 6.5 for Linux

Location Change

Update

“Updating Post Offices” on 
page 222

Clarified that the MTA for the domain must be updated and running 
before you update the POA for the post office

“Updating Secondary 
Domains” on page 226

Clarified that the MTA for the domain that the secondary domain links 
to must be updated and running before you update the secondary 
domain

Chapter 16, “Updating an 
Evaluation GroupWise 
System to a Fully Licensed 
System,” on page 229

Described the process for updating from an evaluation system to a 
licensed system.

“GroupWise System 
Requirements” on page 19

Removed references to Windows 95.

“Starting the GroupWise 
Installation Advisor on 
Windows” on page 43

Removed references to Windows 95.

“Deciding Where to Install 
the GroupWise Monitor 
Components” on page 131

Removed references to Windows 95.

“Monitor System 
Requirements” on page 129

Removed references to Windows 95.

“Understanding GroupWise 
Client Updates” on 
page 207

Removed references to Windows 95.

“Installing and Starting the 
POA” on page 222

Removed references to Windows 95.

Location Change
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July 16, 2003 (SP1)

“Disk Space Required for 
the Software” on page 26

Added information about the setupip folder being on the Client CD.

Appendixes

Appendix A, “GroupWise 
Version Compatibility,” on 
page 239

Clarified that GroupWise 5.x is in the end-of-life phase and updates to 
5.x versions are no longer being made.

Location Change

“Starting the GroupWise 
Installation Advisor on 
Windows” on page 43

and

“Installing the Internet Agent 
Software on NetWare or 
Windows” on page 83

and

“Setting Up GroupWise 
WebAccess on NetWare or 
Windows” on page 105

and

“Setting Up GroupWise 
Monitor on Windows” on 
page 140

Each of the following GroupWise installation programs requires the 
Novell ClientTM on the installation machine in order to create objects in 
Novell eDirectoryTM:

GroupWise Installation/Setup Advisor (main installation program)

Internet Agent Installation program

WebAccess Installation program

Monitor Installation program

Added this requirement to each installation section.

“WebAccess System 
Requirements” on page 96

Added information about GroupWise WebAccess support for Apache 
2 Web Server and Tomcat 4 on NetWare 6.5.

“Monitor System 
Requirements” on page 129

Added information about GroupWise Monitor support for Apache 2 
Web Server and Tomcat 4 on NetWare 6.5.

Chapter 12, “Understanding 
the Update Process,” on 
page 205

The description of the update process emphasizes the need to wait 
between updating the primary domain and updating a secondary 
domain, and between updating any domain and updating a post office 
located on the same machine with the domain.

Chapter 14, “Updating Your 
GroupWise 6.x System to 
Version 6.5,” on page 213

The steps for updating a domain include the need to wait between 
updating the primary domain and updating a secondary domain, and 
between updating any domain and updating a post office located on 
the same machine with the domain.

Chapter 15, “Updating Your 
GroupWise 5.x System to 
Version 6.5,” on page 227

Added information about updating from a GroupWise 5.x system.

Location Change
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